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What is RiskyProject? 

RiskyProject is advanced project risk management software with integrated risk analysis. Most 

projects contain many uncertain parameters: task duration, start and finish times, uncertainties in 

costs and resources, uncertainties in quality, safety, technology, and others. RiskyProject analyzes 

project schedules with risks and uncertainties, calculates the chance that projects will be 

completed within a given period of time and budget, ranks risks, and presents the results in 

formats that are easy to read and understand.  

RiskyProject also helps you to perform project risk management: 

• identify project risks  

• rank risks 

• identify mitigation and response plans 

• manage risk properties, including descriptions, probabilities and impacts, costs associated 

with risks, mitigation strategies, and all other information about risks 

• facilitate risk reviews, opening and closing risks, conversion of risks to issues and lessons 

learned 

• provide comprehensive risk reporting, save risk history 

RiskyProject performs both qualitative and quantitative risk analysis. If both the risk register and 

project schedule are populated, RiskyProject performs quantitative risk analysis. If there is no 

project data (cost or schedule), RiskyProject performs qualitative risks analysis.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

RiskyProject seamlessly integrates with Microsoft Project or can run as a standalone application. 

RiskyProject integrates with other project management software such as Oracle Primavera. 

RiskyProject employs Event Chain Methodology to analyze project uncertainties defined by 

multiple risks (events). An example of an event would be a task delay due to the changes in 

requirements. In many cases, one event can cause another event or multiple events, which can 

Project Schedule Risk Register 

RiskyProject 

Microsoft Project, Oracle 
Primavera, and other Project 
Management software 

 

Monte Carlo 
Simulations 

Risk Adjusted Project 
Schedule 

Ranked Risk and Evaluated 
Mitigation/Response Plans 

Qualitative risk 
analysis 

Quantitative risk 
analysis 
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significantly affect the project schedule. RiskyProject recalculates the project schedule multiple 

times to compute the distribution of possible outcomes and probabilities of meeting specific 

objectives.  
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Who should use RiskyProject? 

RiskyProject performs two major functions: 

• Risk Management: identification, recording, ranking, and reviewing risks, mitigation and 

response plans, and all associated risk information. 

• Risk Analysis: determining how risks might affect your project. 

RiskyProject is beneficial for managers who want to perform risk analysis on their projects 

without specialist expertise or training in risk analysis. RiskyProject allows managers to quickly 

analyze a complex project schedule and associated costs, with multiple tasks and dependencies. It 

is a user-friendly system with an intuitive interface, which hides its advanced mathematical 

calculations and helps managers make informed decisions.  

RiskyProject is useful for managers of research and development projects, including software 

projects, who run projects with multiple uncertainties using an iterative development process. It is 

a widely accepted fact that project management best practices and processes emphasize the 

importance of iterative development and risk tracking, which represents the cornerstone of the 

RiskyProject workflow. 

RiskyProject is used in many industries, including aerospace and defense, IT, engineering and 

construction, manufacturing, agriculture, pharmaceutical, energy, and mining. 
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New Features of RiskyProject 7.2 

RiskyProject 7.2 is a major software release. It includes multiple improvements for both its 
project risk management and risk analysis capabilities. The following features are implemented 
in both desktop version of RiskyProject Professional and Enterprise version:  

1. New Risk Dashboard: present hundreds of different key performance indicators (KPIs) and 
charts related to your risks  with a fully customizable Risk Dashboard. Dashboards can 
present data in a variety of ways including charts - line, area, pie, scatter, bar (including 
frequency histogram), meters, and risk matrixes. You can place them in different areas on 
the dashboard, and adjust their size, colors, and other properties. Dashboards can be 
annotated using  text, lines, and images. Dashboards can be printed or exported. 

2. Re-Designed Project Dashboard: The Project Dashboard is a now a customizable view and 
includes information about projects including results of Monte Carlo simulation, multiple 
KPIs and charts. 

3. Risk Form: a fully customizable form to enter risk properties, as well risk probabilities and 
impacts. You can create any risk properties or select them from the list of predefined 
properties. Then you can drop them on the form. The form can be annotated with lines and 
text. Once you design a form it can be used for all future projects. 

4. Inserting Subprojects with Results of Simulations: you can now create a Summary or 
Master project schedule using the simulation results of subprojects. In these summary 
projects, the results of one or more subprojects (statistical results of a Monte Carlo 
simulation) are inserted as a task(s). This process allows you to analyze the results of 
projects and also use these analyses, as part of a larger summary project. This significantly 
reduces the calculation time and helps to simplify the management of large projects or 
programs. 

5. Using Empirical Data: if you have empirical data for task duration and cost in Excel or text 
format, you can use it to generate a custom statistical distribution. You can import results of 
analysis, performed by other software or use project control data from similar projects or 
activities. 

6. Risk Mitigation Workflow Improvements:  

A. Mitigation plans can now be linked to tasks or a group of tasks within a project 
schedule. This linking will read the schedule data into the mitigation plan to 
calculate costs and planned finish and actuals. You can now manage groups of tasks 
as mitigation activities. Also, mitigation plans can now have multiple custom fields, 
which you can use as mitigation plan properties. 

B. Mitigation burndown structure. New Mitigation Assignment View helps define and 
edit mitigation plan assignment to different risks in one view. It shows how risk 
probability and impact will reduce over time due to mitigation efforts. Mitigation 
plan assignment now includes information of risk probabilities and impacts for 
individual categories, such as schedule, cost, technology, etc. In Mitigation Plan 
Assignment View you can view and modify dates, description, and probabilities and 
impacts associated with different mitigation steps for all risks.  
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C. Import of risk mitigation data from Excel: in addition to importing Risks Register 
from Excel, you can now import mitigation plans and as well regular mitigation 
status update information from Excel. Mapping to Excel fields and RiskyProject 
properties can be saved for importing of different Excel file with similar structure. 

7. Most Likely Duration and Fixed Cost: define most likely values for duration and fixed cost. 
While base duration and fixed cost are deterministic values from original project schedule, 
most likely duration and fixed cost are distribution parameters. Most likely values are now 
used in uncertainty bands. 

8. Low and High Cost Results Charts: present low and high results in the Cost Analysis chart. 

9. Schedule Data Import and Filtering: filter list of tasks or resources based on certain 
condition. It helps in managing large schedule. Also you can import more data fields from 
Microsoft Project and Primavera.  

10. Multiple Risk Response Plans: define any number of risk response plans assigned to one 
risk. 

11. Improved Beta Pert Distribution: The new algorithm better represents uncertainties in the 
low and high boundaries of the distribution.  

12. Improved User Interface: Usability has undergone multiple improvements, including 
introduction of new RiskyProject workflow bar. A number of dialog boxes that have been re-
designed for better usability. This also includes a new  Risk Trend view and improvements to 
other views.  

13. Improved Calculation and Data Presentation Performance: Monte Carlo simulation 
performance and refresh rate of views, charts, and diagrams has been enhanced.  

Exclusive Features for RiskyProject Enterprise 

14. Organizational Units: Define multiple organizational units, subunits, and security groups. 
The user can be assigned to different organizational units or security groups. Assign and 
restrict risks to specific organizational units. Organizational units are properties of risks. It is 
now possible to filter risk register and any risk reports including risk matrix and risk trend 
charts based on organizational units.  

15. Integration with Active Directory: RiskyProject Enterprise can now access Active Directory 
for information about organizational units, security groups and user and authenticate user 
based on Active Directory.  

16. Multiple Risk Matrixes: RiskyProject Enterprise can now allow you to define different risk 
matrixes for projects and organizational units. Each risk matrix has its own unique name.  

17. Risk Mitigation Projects: Designate a project within your portfolio as risk mitigation project 
for specific risk. Such project may also have its own risks and uncertainties. It helps to 
choose most cost-effective risk mitigation strategy and manage risk mitigation activities for 
complete portfolio. 

For more information about new RiskyProject Enterprise feature, please see the RiskyProject 
Enterprise User Guide. 
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Qualitative vs. Quantitative Risk Analysis  

RiskyProject performs both qualitative and quantitative risk analysis.  

A typical qualitative risk analysis workflow is used to: 

1. Identify risks and add risks to the risk register. 

2. Define risk properties, probabilities, and outcomes. 

3. Analyze risks and prioritize risks. 

4. Assign mitigation and/or response plans. 

5. Update risk properties, probabilities, outcomes as necessary. 

6. Review status and properties of the risk and report information about risks. 

A typical quantitative risk analysis workflow is used to: 

1. Create a project schedule. 

2. Add risks, uncertainties, and other risk-related information.  

3. Run a simulation, perform an analysis and generate a report of the results.  

4. Update risks and uncertainties as necessary. 

5. During project execution, perform project tracking with risks and uncertainties at key phases 

or milestones to update forecasts. 

6. Report results 

If you do not have a schedule for your project, RiskyProject will only perform qualitative risk 

analysis. However, if you add a schedule by either adding activities or importing a schedule, 

RiskyProject automatically switches to quantitative analysis. You may switch between qualitative 

and quantitative analysis by adding or removing a project schedule. 

 

 

 

 

Due to the nature of qualitative and quantitative analysis the results can be different even with the 

same risks, particularly for schedule-related risks affecting project duration and cost. 

 

Qualitative risk 

analysis 

Quantitative risk 

analysis 

Adding or removing 

project schedule 
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RiskyProject Interface 

RiskyProject workflow includes five steps:  

1. Schedule: Enter or import Schedule, Resources, Cost and Income, and Work 

2. Risks: includes a Risk Register and Risk Dashboard, Assign risks to tasks and resources, 

Mitigation/Response plan depository; Risk Matrix and Risk Trend charts 

3. Analysis: includes a Risk-Adjusted Schedule, Summary of risk analysis results, Cost and 

Cash flow analysis results, Risk Chart, Success rate and Crucial Tasks 

4. Tracking: includes a Tracking Gantt Chart and linear Tracking Chart 

5. Reporting: includes various hard-coded and customizable Risk Reports 

Each step has multiple views which are used to enter data or to present the result of analysis. The 

views are shown in two places: in the ribbon the top and in the workflow bar on the left.  

You can open and close multiple project schedules during one session in RiskyProject.  

 

 

 

Application Look 

You may change the color and style of title bars, toolbars, and status bars, as well as change the 

theme for the datasheets. The theme is used for any grid including grids inside dialog boxes. 

Before changing the application look, close all active projects. After you have changed the 

application look, restart RiskyProject to enable the changes. 

Click on each arrow to 
expand or collapse the group 
customize workflow bar 

Workflow bar: presents 
RiskyProject views. 

Five ribbon tabs associated with steps 
of RiskyProject Workflow plus Tools tab 

File tab 

RiskyProject data sheet 
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To change the application look  

1. Click the Tools tab.  

2. In the Resources and Settings group, click Application Look. 

Customizing Workflow Bar 

You may enable and disable views from the Workflow bar. By default some views, including 

Assign Mitigation and Risk Status are disabled.  

To customize Workflow Bar: 

1. Click the Tools tab.  

2. In the Resources and Settings group, click Customize Workflow. 

3. In Enable/Disable Views from Workflow Bar dialog select views phases you wish to 

Enable or Disable. 

You can also right click on Workflow bar to be presented with the same dialog. 

 

RiskyProject Data Sheets 

All RiskyProject views, except for the Project Summary view and Risk and Project Dashboards 

contain data sheets. Data sheets are used to enter and present data in a grid format. Grids are also 

used in some dialog boxes. All data sheets have similar features.  

Data sheets are used to display task information, resources, risks, and results of sensitivity 

analysis. Data sheets are composed of columns and rows. Each column has specific properties, 

which represent a specific data type. For example, resource name, resource type, etc. You can 

customize data sheets to display the columns in any order and any with a title in the column 

header. See the appendix for a full description of each field. 

Modifying data sheets 

You can modify all the RiskyProject views by inserting, modifying, or hiding columns depending 

on the type of information you want to view. 

1. Open a view and right-click on a column header.  

2. From the shortcut menu, choose how you want to modify the column: 

• Hide 

• Insert Column Before or After 

• Modify: Change field type, Title, Title and Data alignment, Width 

• Save Column Layout: current column layout will be saved in the registry for all new 

projects 

• Restore Default Column Layout: restore column layout predefined in RiskyProject 

 

• This modification is saved in the RiskyProject data file associated with the particular project. 

Therefore, the next time you open the project, you will see your column modifications. This 

way you can create a customized data sheet for each view. 

• Modifications to data sheets are specific to each view. For example, if you insert a column 

into the Project View, it will not be reflected in Result Gantt View. 
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• You cannot hide or modify IDs. 

• In the Risk Register view, you can extend the height of rows, add headers that span multiple 

columns above regular columns and adjust the width of columns based on maximum width of 

information contained. 
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Copying, cutting and pasting selected rows 

You can copy, cut, and paste selected items in each data sheet except for the results of sensitivity 

analysis.  

1. Select one or multiple rows in a data sheet.  

2. Click the Schedule tab. In the Clipboard group, click Cut or Copy. 

3. Open the data sheet in which you want to paste the data. 

4. Select the row in which you want to paste the data. 

5. Right-click and click Paste. 

 

• The maximum number of rows in RiskyProject is 20,000. You cannot paste items beyond this 

limit. However, if you import a project from other project management software, the 

maximum number of tasks will be increased so it can accommodate all tasks in the original 

project schedule. 

• You can paste data only to compatible data sheets (e.g. tasks can be pasted to the data 

sheets containing tasks, and risks can be pasted to data sheets containing risks). 

• You cannot paste data copied or cut from another document with the exception of risks. 

 

Inserting and deleting items 

You can delete and insert items from, or to, any data sheet except for the results of sensitivity 

analysis.  The quickest way to insert or delete items is to use the Insert and Delete buttons located 

on the Format toolbar. 

To insert items: 

1. Select an item or multiple items. New items will be inserted above the uppermost selected 

item. The number of items to be inserted equals the number items you have selected.  

2. Click the Schedule tab. In the Format group, click the Insert Item  button. 

You can also use right-click on the left column in each data sheet that displays IDs, and use the 

dropdown menu to insert and delete selected items. 

Saving column layout 

After you modify a column layout, you can save it in the system registry for all new projects 

created on your computer. You save a column layout by following these steps: 

1. Go to Schedule and Click on Project Options in Settings and Options Group 

2. Go to View tab 

3. Click on Set Default Column Layout 

4. You can restore the predefined layout of columns for all views by clicking on Restore 

Default Column Layout 

Alternatively, you can right-click on any column in each view and click Save Column Layout or 

Restore Default Column Layout from the drop-down menu. 
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Chapter 2: Qualitative Risk Analysis 
and Management 
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Risks in RiskyProject 

Risk Register 

The Risk Register is a set of all the project risks. You can enter risks in either the Risk Register 

view: 

 

 

 

Use the Risk Register to: 

1. View risks with their attributes such as probabilities, impacts, scores, and properties. 

2. Create a risk register hierarchy based on: 

• Risk categories 

• Open/Closed risks 

• Risk/Issues/Lessons Learned 

• Risks assigned to managers 

• Risks assigned to owners 

• Threat mitigation or opportunity mitigation strategies 

• Assigned/Unassigned Risks (active or inactive) 

• Hidden and Visible risks (available in RiskyProject Enterprise only, see RiskyProject 

Enterprise User Guide) 

3. Rank risks based on risk score. 

4. Sort risks alphabetically or using risk IDs. 

View risks hierarchy based on 
the different parameters, 
categories, owner, manager, 
open/closed, etc. 

Click Risk Register 
to view risk register 

Click Risk Register 
to view risk register 

 

By default, risks are ranked based 
on their scores. You can rank 
risks based on content of each 
column 

 

Filter risks based 
on their properties 

Sort risks 
alphabetically or on 
risk ID 

Each tab presents 
different views of Risk 
register 

You can create 
multiple tabs (views) 
for Risk Register  
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5. Filter risks based on risk properties: Open, Closed, Risk, Issue, or Lessons Learned. 

Data for the Risk Register can be subdivided into three categories: risk registry, risk 

mitigation/response plans, and settings: 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Defining columns for Risk Register 

You can modify the Risk Register by inserting, modifying or hiding columns depending on the 

type of information you would like to view. The Risk Register view allows you to define the 

Risk Register 

Risk 1 with attributes: 

General 

Information  

Risk cost Probabilities 

and impacts 

Mitigation / 

response plan 

assignments 

Risk history Risk reviews Custom 

properties 

Risk 2 with attributes 

Risk 3 with attributes 

………………… 

Mitigation or response plans  

Plan 1 with attributes 

Plan 2 with attributes 

…….. 

Risk Register Settings  

Risk Categories 

and Outcomes 

Default Risk 

Properties 

Risk Matrix 

settings 

Risk ID 

generation rules 



RiskyProject Professional User Guide 

24 

 

upper header for the group of columns. The upper header can have two rows of text and a tooltip. 

It can have different background colors, outline colors and text colors. There are two pre-defined 

upper headers: Pre-mitigation and Post-mitigation. 

1. Open the Risk Register and right-click on a column header.  

2. From the shortcut menu, choose how you want to modify the column: 

• Hide 

• Insert Column Before or After  

• Modify: field type, field title, title and data alignment, width, upper and lower headers 

text and color, and number of columns in the group with the same upper header. 

 

 
 

Adding risks to the Risk Register 

1. Click the Risks tab. On the Risk Views group, click the Risk Register.  

2. On the Risk Register, click an empty row. 

3. Enter a unique name for the risk. The risk is now added to the register.  

Deleting risks from the Risk Register 

1. Click the Risks tab. On the Schedule Views group, click the Risk Register. 

2. Select the risk you want to delete. You can select a single risk or multiple risks. 

3. Right-click on the Risk ID and choose Delete Risk from the shortcut menu.  

Updating risk properties for individual risks 

To modify the risk properties using the Risk Register: 

1. Open the Risk Register. 

2. Click on the risk properties and make desired changes. 

Updating risk properties for a group of risks 

You can define the same risk properties for a group of risks at the same time. 

In the Risk Register, you can define 
the upper header for the group of 
columns. 

The upper header is defined by 
modifying the left columns in the 
group of columns. 

An example of how the upper header 
will be displayed. 

Lower column header 
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1. Open the Risk Register. 

2. Select the risks to which you would like to add properties. 

3. Right-click on the risk ID and select Risk Properties. 

4. For each property, add a value as required. If properties are different for the selected risks, 

you will be shown with *******. 

 

Filtering and sorting risks using the Risk Register 

The Risk Register offers powerful tools for filtering and sorting risks: 

• Filter and sort the Risk Register based on the content of each column. To filter or sort, 

click on the box with the arrow to the right of the column name. The Sort dialog box 

opens. You can sort the alphabetically or select risks with certain property values, e.g. 

show only open or closed risks.  

 

 

 
 

• Find a risk based on the actual value of a risk property using the Find Risk dialog (Filter 

button) at the bottom of the Risk Register. You may combine different risk properties 

using AND or OR. 

• Sort the risk register alphabetically using  and  buttons or based on pre-mitigation 

risk score using the  button. You may also sort the Risk Register based on Risk ID. 

You can filter risks that affect different risk categories. Risks can affect: 

• duration 

• finish time 

• cost 

• success rate 

• non-schedule risk categories.  

RiskyProject calculates the combined impact of risk on all risk categories. Pre-mitigation and 

post-mitigation risk impact, probability and score are displayed for selected risk categories. 

This icon shows that Risk Register is 
sorted based on content of this 
column.  Click here to sort Risk Register based on content of this 

column. You can select risks with certain property values 
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Use tabs to create multiple views of Risk Register 

You can create multiple tabs to create different views of the Risk Register. These tabs are shown 

at the bottom of risk register. Each view may have different set of columns, different headers, or 

different sorting and filtering settings. For example, in one tab you can show risk names and 

description sorted alphabetically. In another tab, you can show risk probabilities, impacts, and 

scored sorted based on risk score. This way you can easily switch between different views of the 

risk properties.  In addition, these views can be used to generate multiple risk register reports.  

 

 

 

The Risk Register tab settings are saved for each project. You can also save the current tab 

settings as the default for all new projects: 

• Right-click on any header 

• Click on Save Column Layout 

 

• With the Risk Register views you can rename risks and copy risk information to the clipboard. 

You may also copy and paste risks inside the Risk Register.  

• You can export the complete risk register or selected risks to Excel by click on File > Export > 

Microsoft Excel 

 

About Risk Categories, Probabilities and Impacts 

Risk Categories 

Risk Categories are a group of risk outcomes. RiskyProject calculates risk probabilities, impacts 

and scores for each category. The default risk categories are: 

• Duration 

• Cost 

• Safety 

• Environment 

• Legal 

• Performance 

• Technology 

RiskyProject calculates the score and rank for all risks in each risk category. You can view risk 

scores and rankings for each risk category or for all categories. 

 

 

Right click on the tab to Delete, Rename, Copy, Move, or  
change color or the Tab 

Create new 
tab 
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You can customize the risk categories in the Risk Categories dialog box. For more information 

about customizing risk categories, read “Managing Risk Categories and Outcomes”. 

Risk Outcome Types 

A Risk Outcome Type is the result if a risk occurs. While every risk category must have a least 

one outcome, they can have several. For example, one of the default risk categories is Legal. You 

may want to further define the outcome types as Litigation Risk, International Legal Risk, etc.  

You can customize the set of outcome types using the Risk Categories dialog box.  

 

The set of risk outcome types are different for qualitative and quantitative risk analysis. For 

quantitative risk analysis, RiskyProject automatically adds a number of schedule-specific risk 

outcomes, such as restart task, fixed cost increase, etc. 

 

Risk Probability and Chance 

Risk Probability is the calculated chance that an event will occur. You can view risk probability 

in the Risk Matrix, Risk Register, and other views and dialog boxes. Risk Chance is the input 

parameter for risk probability. Risk chance (input parameter) and risk probability (calculated 

attribute) can be different; particularly when a risk has multiple mutually exclusive alternatives as 

risk, chance is an input parameter for each alternative. In these cases, Risk probability is 

calculated based on the risk chance for each mutually exclusive alternative. 

Risk Outcome 

Risk Outcomes indicate the severity of a risk event for the specific risk category. You need to 

enter risk outcomes when you define risk chance and outcome type. For example, here are the 

default risk outcomes for the risk category Schedule: 

 

Outcome types can be a label (e.g. Critical > 1 year delay) or a percentage (e.g. 5%), or a 

combination of both. You can set how you want to enter and view risk outcomes in the Format 

Default list of risk outcomes can be customized in 
Format Risk Matrix dialog. 

In the Risk Register, Risk Matrix, and Risk Report you can view 
risks associated with a specific risk category 
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Risk Matrix dialog box. Each label is associated with percentage, which is the midpoint of the 

interval for each label: 

Label Interval Midpoint 

Negligible: < 1 month delay From 0% to 20% 10% 

Minor: 1-3 month delay From 20% to 40% 30% 

Moderate: 3-6 months delay From 40% to 60% 50% 

Serious: 6-12 months delay From 60% to 80% 70% 

Critical: > 1 year delay From 80% to 100% 90% 

When you define outcome types as a percentage, you can enter it as any number from 0% to 

100%. In this scenario, it will be associated with a label based on the interval to which this 

percentage belongs. For example, 76%, corresponds with the “Serious: 6-12 months delay” 

outcome type. 

 

In RiskyProject, risk outcome types can be probabilistic. You can define a statistical distribution for 

outcome types and perform Monte Carlo simulation even it is part of qualitative risk analysis. For more 

information about probabilistic risk outcome types, read “Uncertainties in Risk Outcomes”. 

 

The diagram below shows the relationship between risk categories, risk outcome types, and risk 

outcomes. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Mutually exclusive alternatives 

Mutually exclusive alternatives are used to calculate alternate outcome types for the same risk 

event that cannot occur at the same time. An alternative risk is similar to using a Boolean “OR” 

statement. Only one risk alternative can occur at the same time. For example, if you have a fire 

risk, the fire could be minor or major each with different outcomes. They are the same risk, but 

unlike other risk events, these alternatives cannot occur at the same time. 

Risk Category 

Duration 

Cost 

Legal 

….. 

Risk Outcome Type 

Litigation Risk 

International Legal 

Risk 

….. 

Risk Outcome 

Very low 

Low 

Medium 

High 

Expressed as labels 

 

Expressed as a 

Percent 

  

75 % 
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In this example, the risk Fire has two alternatives: 

Chance  Outcome Type Outcome 

10% Relative delay Negligible: < 1 month  

2%  Relative delay  Low: < 1-3 months 

When the simulations are run, there is a 12% chance that the risk Fire will occur. 10% of the time 

the outcome of the minor fire will be calculated, while 2% of the time the outcome of a major fire 

is calculated, but they are never calculated during the same simulation.  

Mutually exclusive alternatives must: 

• have the same name, 

• not be separated by empty rows, and 

• belong to the same category. For example, if you have the same risk “Change in 

requirements” with outcomes Reduce Quality and Fixed Delay, these outcomes will not 

be mutually exclusive alternatives as they are different risk categories that have different 

impacts. 

The diagram below illustrates how mutually exclusive alternatives are assigned:  

 

Threats and Opportunities 

Risks can be threats, opportunities or both. Threats and opportunities are defined for risk 

assignment depending on results of the risk outcome. Negative risk outcomes mean opportunities. 

Example 1: 

risk: Change Requirements 

Outcome: Fixed Delay 

Result: 2 days 

This is a threat 

Example 2: 

risk: Change of technology 

Outcome: Delay in technology introduction 
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Result: -10% Low 

This is an opportunity: a negative number indicates that this is acceleration rather than a 

delay of the technology introduction 

Example 3: 

risk: Chance of supplier 

Outcome: fixed cost increase 

Result for mutually exclusive alternative 1: $30,000 

Result for mutually exclusive alternative 2: -$20,000 

This is both a threat and an opportunity depending upon the supplier. 

You can have different sets of labels for threats and opportunities for a risk category. For 

example, for the risk category Schedule, a threat outcome type can be “Critical > 1 year delay”, 

for an opportunity it can be “Critical > 1 year acceleration”. If you want to enter opportunities, 

you need to enter a negative percentage (e.g. -25%) as the outcome type. 

Risk Impact 

Risk impact is the calculated result of the risk event. Risk outcome (input parameter) and risk 

impact (calculated attribute) can be different, particularly when a risk has multiple mutually 

exclusive alternatives, in which case the risk outcome is a parameter of each alternative. Risk 

impact is calculated based on the risk chance for each alternative. 

The diagram below shows the difference between risk chances and outcomes (input parameters) 

and risk probabilities and impacts (output parameters):  

 

 

 

 

 

 

 

Risk Score 

Risk score is a calculated parameter that equals probability multiplied by impact. Risk score is 

calculated for each risk category as well as all risk categories. 

Original, Pre-, and Post-Mitigation Probabilities, Impacts and Scores 

RiskyProject calculates three sets of probabilities, impacts and scores for each risk category as 

well as combined for all categories. You can view these sets in the Risk Register, Mitigation 

Assignment View, and Mitigation tab of Risk Information Dialog. 

1. Original: when risk chance and outcome are defined. This information can be entered in the 

list of risk mitigation plans in Mitigation tab of Risk Information Dialog. Original chance, 

outcome and scores can be shown in the Risk Register as read-only. RiskyProject can only 

save one set of original chance, impact, and score per risk. 

 

Risk 1 has multiple outcomes: for different categories and different mutually exclusive alternatives 

Safety – 70%  

Schedule – 50%  

Cost – 50% 

Outcome 

Safety – 30%  

Schedule – 30%  

Cost – 30% 

Chance 

Impact - 70% Probability – 30% 

Integrated probability and impact for 

all parameters 
Calcu

lation 
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2. Current: reflects most recent changes to probability and impact for each category. If you use 

qualitative analysis, current chances and impacts are editable in Risk Register. You can also 

edit them in the Risk Form or the Probabilities and Outcomes tab of the Risk Information 

dialog box. For quantitative analysis (with project schedule) current set of probability, 

impact, and scores is calculated based on risk assignment to task or resources. Current set of 

probability, impact, and score is shown as a first line on Mitigation Tab on Risk Information 

dialog box. 

 

Risk Register 

Add Column for Original 
Chance, Impact or Score. 
They will be Read Only 
in Risk Register. These 
columns are hidden by 
default. 

Right click on column’s 
header to insert new or 
modify existing column. 

You can designate any 
set of chance, impact and 
score as Original. 

Mitigation Tab of Risk 
Information dialog 

Enter risk chance, 
impacts, and scores for 
Original set here. 
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3. Post-Mitigation: Post-mitigation probability, impact and score reflect changes to risks due to  

mitigation plans There can be many  mitigation plans assigned to one risk. They are editable 

in the Assign Mitigation view and in Mitigation tab of the Risk Information dialog box. In 

the Risk Register you can show the latest read-only probability, impact and score, which 

corresponds to the last line in Mitigation tab. In the Assign Mitigation view, in addition to 

editing the post-mitigation probabilities, impacts and scores for all categories, you can also 

edit values for individual categories, such as cost, duration, quality, technology, etc. 

Probabilities, impacts and scores for individual categories are not used to calculate combined 

probabilities, impacts and scores, which should be entered independently. Post-mitigation 

probabilities, impacts and scores are not affected by quantitative analysis. Also in the  Assign 

Mitigation you can enter both predicted and actual probabilities, impacts and scores.  

 

 

 

Risk Properties 

Risk Properties are other risk attributes, which include: 

• Risk Name, ID, description, statement, objectives, assumption, cause and trigger 

• Open/close risk  

• Risk life cycle status: Risks, issues, lesson learned 

• Risk ownership 

• Risk mitigation strategy 

• Risk costs 

• Risk start and end date  

• Other information about risk 

Some risk properties are predefined as General Information about risk and Risk Costs. However, 

you may define any other risk properties.  

Current any set of 
probability, impact and 
score is always shown on 
first line. 

Read only 

Mitigation Tab of Risk 
Information dialog 

Mitigation Tab of Risk 
Information dialog 

Insert new mitigation plan 
and edit sets of 
probabilities, impacts, 
and scores here 

Probability, impact and 
score for the latest 
mitigation plan will be 
shown in Risk Register. 
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Risk Mitigation and Response Plans 

You can model risk mitigation or response efforts in RiskyProject using the Mitigation or 

Response View. Response plans are activities that are executed when a risk occurs and are used 

for quantitative risk analysis. Mitigation plans are actions that are performed to minimize risk 

probability and/or impact and can be visualized using the Risk Mitigation Waterfall diagram. 

A mitigation or/and response plan must be assigned to a particular risk. Please read “Assigning 

Risk Response Plans” and “Assigning Mitigation Plans” for more information. 

Creating a mitigation or risk response plan 

1. Click the Risks tab. In the Risk Views group, click Mitigation/ Response Plans.  

2. Enter the mitigation or response plan name. Summary entries will help you to organize 

information, but they are not considered a mitigation plan. 

3. Select either Mitigation or Response plan 

4. For Response plans, enter an Outcome Type and Outcome of the response. The outcome 

types are automatically populated based on the list of outcome types.  

5. Enter the Cost of the mitigation or response plan 

6. For Mitigation plans, enter the default reduction of probability and impact if the mitigation 

plan is assigned to the risk.  

For example, a mitigation plan reduces probability on 5% and impact on 10%. If a mitigation 

plan is assigned to the risk that has 45% probability and 30% impact before mitigation, the 

risk will have 40% probability and 20% impact after mitigation. 

7. Enter the mitigation or response plan description. If you double-click on a 

mitigation/response plan ID, the Mitigation or Response Plan Description dialog box will 

open. 

 

A mitigation or response plan can be assigned to multiple risks. The cost of mitigation or response 

plans will be included with each risk.  

You can use multiple text and number properties in  mitigation and response plans to enter additional 

information. These fields can be accessed by inserting column Text1, Text2, Text3, …. and Number1, 

Number2, Number 3, … to the Mitigation and Reponse View. 

 

Creating Summary and Sub-plans 

Mitigation plans can be composed of Summary plans with associated sub-plans. This can be very 

useful if your mitigation plans have several activities or steps that have distinct costs and 

outcomes that you want to monitor items separately. 

Summary plans have names only and do not have Plan Type, Outcome Type etc. Summary and 

sub-plans are defined using the Indent and Outdent commands similar to Summary and Subtasks 

on the Gantt Chart. 

To create a sub-plan: 

1. Enter a name for the Summary plan. 
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2. Click the row below the plan  

3. Enter a name for the plan. 

4. Right-click on the plan and on the shortcut menu click Indent. The plan now becomes a sub-

plan of the mitigation plan.  

5. Enter information for the sub-plan. 

Assign Tasks to Mitigation or Response Plan 

As part of mitigation planning, tasks that represent mitigation activities with planned finish times 

and costs are added to a plan. You assign these activities, including summary tasks, to a 

mitigation or response plan. In this case cost, actual cost and percent completed of the plan will 

be calculated based on costs and percent completed of the task. If Monte Carlo simulations are 

conducted, the cost of a mitigation plan will equal the mean of the task cost. If simulations are not 

conducted, the cost of a plan equals the  original (deterministic) task cost. 

The dates of mitigation plan execution shown in Mitigation tab of task information dialog are not 

associated with the task and should be defined by user. The task associated with mitigation plans 

will be shown in the risk report. If the plan is associated with a task cost, actual cost, and percent 

completed of the plan is read only. 

To assign a task to a mitigation or response plan: 

1. Double click on the Mitigation or Response plan id; the Mitigation or Response Plan dialog 

box opens.  

2. From the list of tasks, select the task that you want to link to the plan. Only one task can be 

selected. 

3. To reset selection of the task, click Clear task selection. 

 

 

Enter description of the mitigation or 
response plan 

Select task associated with mitigation or 
response plan from the list 
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Risk Attributes 

About Risks 

Each risk in RiskyProject can have a number of properties. Common  properties are predefined 

and are found in the Risk Form or Custom Properties tabs of the Risk Information dialog box. 

The Risk Form is fully customizable: you can define a set of mandatory and optional attributes, 

which need to be entered as part of your risk management process. 

Risk properties include: 

• Risk Name: the risk name for each risk must be unique. Names are case-sensitive.  

• Open/closed risk: open risks are active risks that may occur. Closed risks are those risks 

that are no longer active because of risk response or other factors or measures taken. 

Closed risks may contain important information and should not be deleted from the risk 

register. 

• Risks, issues, lessons learned: risks are events that may or may not occur and have a 

probability between 0 – 100%. Issues are events that have already occurred and require a 

response. Lessons learned are events that occurred in the past and have a history 

associated with them. When you add a new record to the risk register, by default it is a 

risk.  

• Risk statement, objectives, assumption, cause and trigger: contain textual information 

about risks. 

• Risk ownership: includes risk manager and risk owner. You may define other custom 

fields for risk reviewer, recorder, and other participants in the risk management process. 

• Risk mitigation strategy: you can enter mitigation strategies for threats and/or 

opportunities. Status of threats and/or opportunities are automatically calculated when 

you enter risk probabilities and impacts. If the risk is only a threat, you will only be able 

to enter strategies for threats and vice versa. For more information about threats and 

opportunities, read “Risk Probabilities and Impacts”. 

• Risk start and end date (risk sunrise and sunset): dates between which a particular 

risk is active.  

• Risk ID: Risk ID can be automatically generated when you create a new risk. You may 

sort the Risk Register based on Risk IDs. You can overwrite the automatically generated 

risk ID. Rules for risk ID generation are defined in Risk Options. To view Risk Options, 

click the Schedule tab. In the Settings group, click Options. 

 

• You can create any other risk properties using Default Risk Properties dialog box (Risk tab 

of the ribbon, Settings pane). In this dialog you can also define the default risk mitigation 

strategy and default time between risk sunrise and sunset. 

• In the case of quantitative risk analysis, changing a risk from Open to Closed, from Risk to 

Issue or Lesson Learned will affect risk probability and impact. For more information about 

this please read “Assigning Risks to Task and Resources”. 
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Risk Probabilities and Impacts 

There are two ways probabilities and impacts can be defined in RiskyProject: 

• You can define chance and outcome for each risk in the Probabilities and Outcomes tab 

of the Risk Information dialog box.  

• You can also define risk chance and outcome directly in the Risk Register grid. However, 

in this case, risk cannot be assigned to any tasks or resources. If risk is already assigned 

to at least one task or resource, you will not be able to modify chance and outcome using 

the grid and the Risk Information dialog box will appear. This method is preferable for 

qualitative risk analysis and risk management. 

Defining risk chances and outcomes in the Risk Information dialog box 

You must enter the risk chance, outcome type, and outcome for each risk. You may only define 

one alternative. Please remember that risk chance and outcome may not be equal to calculated 

risk probabilities and impacts in the following cases: 

• For risks with multiple mutually exclusive alternatives  

• If you define uncertainties in risk outcome 

• In case of quantitative risk analysis (with project schedule) 

To define risk chances and outcomes in the Risk Information dialog: 

1. Click the Risk tab. In the Risk Views group, click Risk Register.  

2. Double- click on a risk ID to open the Risk information dialog box. 

3. Click the Probabilities and Outcome tab. 

4. Enter Chance that will be used to calculate probability. 

5. Select Outcome Type from dropdown list. 

6. Select Outcome label from dropdown list or enter percent. 

7. Threat/Opportunity are calculated automatically if you enter a negative outcome. 

8. If required, repeat steps 5 -7 for each mutually exclusive alternative. 

 

Use the Format Risk Matrix dialog box to toggle between entering risk outcomes as labels, 

percentages, or both. 

 

Defining risk chances and outcomes in the Risk Register grid 

By default, the Risk Register’s columns do not allow you to enter risk chance and outcome 

directly. You need to define appropriate columns first: 

1. Within Risk, Register view, right-click on the header of the column next to which you want 

to define that column in order to enter chances and outcomes. 

2. Click on Insert Column Before or Insert Column After. 

3. Select field from the Field Type dropdown list. Here is the list of columns which can be 

presented in the Risk Register: 
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Field Description Read Only or Editable in Risk 
Register View 

Impact Original Impact of risk designated by user as Original Read Only, defined in Mitigation Tab of 
Risk Information Dialog 

Impact Current (Pre-
mitigation) 

Calculated risk impact for all categories based on 
impact of individual risk categories 

Read Only, defined in Risk Form or 
Probabilities and Impacts tab of Risk 
Information Dialog for individual categories 
or calculated as a result of quantitative 
analysis 

Impact Post-mitigation Last line in  Mitigation Tab of Risk Information 
Dialog or in Assign Mitigation view for individual 
risk 

Read Only, defined in Mitigation Tab of 
Risk Information Dialog or in Assign 
Mitigation view 

Impact: Cost Current Impact: Cost Category  Editable. Defined in Risk Register or in 
Risk Information Dialog 

Impact: Cost, Post-
mitigation 

Last line in  Mitigation Tab of Risk Information 
Dialog or in Assign Mitigation view for individual 
risk related to cost category 

Read Only, defined in Mitigation Tab of 
Risk Information Dialog or in Assign 
Mitigation view 

Impact: Environment Current Impact: Environment Category Defined in Risk Register or in Risk 
Information Dialog 

Impact: Environment, 
Post-mitigation 

Last line in Mitigation Tab of Risk Information 
Dialog or in Assign Mitigation view for individual 
risk related to Environment category 

Read Only, defined in Mitigation Tab of 
Risk Information Dialog or in Assign 
Mitigation view 

Impact: …. Current and post mitigation impacts for other risk 
categories 

Defined in Risk Register or in Risk 
Information Dialog 

Columns for Chance (Probability) and Score are defined the same way. After you define 

appropriate columns, they can then be used to enter the risk chance and outcome for each 

category.  

 

 

Selecting probability/impact/score columns for Risk Register 

Impact (Original): First impact value, which was entered for 
this risk - Read only 

Impact (Post-Mitigation and Pre-Mitigation): Calculated 
Impact for all categories  - Read only 

Impact (for each category): Current Impact 
value for individual category: Editable – pre-
mitigation, read-only for post mitigation 
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Uncertainties in Risk Outcomes 

You can define risk outcome as a range defined by a statistical distribution: 

 

 

 

After you enter probabilistic risk outcomes and click OK, RiskyProject will perform Monte Carlo 

simulations and calculate the risk impact based on the mean of the statistical results. 

To enable probabilistic risk outcomes: 

1. Click the Schedule tab. In the Settings group, click Options. 

2. Click the Risk tab. 

3. Select the Enable statistical distribution for risk outcome checkbox.  

Once enabled, this setting is the default for all RiskyProject files on your computer. 

To define statistical distribution for risk outcomes: 

1. Click the Risks tab. In the Risk Views group, click Risk Register.  

2. Open the Risk Information dialog box.  

3. Click the Probabilities and Outcomes tab for qualitative risk analysis (if you don’t have 

project schedule) or Assign to tasks or resources for quantitative analysis 

4. Right-click on risk alternative ID and select Distribution of risk outcomes 

5. Select the distribution from the Distribution list.  If you select Undefined, the base value 

will be used for all iterations. 

6. Define the distribution parameters. The Probability Density chart is automatically updated. 

You can adjust distribution parameters using the sliders. 

7. If you use a custom or discrete distribution, a grid opens. The grid will allow you to define 

points (or intervals for discrete distributions) and associated with each point (interval) 

8. If you select Normal or Lognormal, you must select the Low and High probability range 

(P1 and P99, P5 and P95 or P10 and P90). These are “cut-off” parameters; meaning that 

duration, cost, or start time cannot go beyond these values.  

 

If you perform qualitative risk analysis in Risk Register you can view: 

a). Impact (pre-mitigation or post-mitigation) for all categories: it is calculated as mean value of you 

have for probabilistic risk outcome. 

Probabilistic 

risk outcomes 

Select statistical distribution for risk outcomes. 



RiskyProject Professional User Guide 

 

39 

b). Impact for individual categories (e.g. Impact: Cost or Impact: Schedule): it is input base value of 

Outome

 

 

Risk Form: Defining Information About Risks 

The Risk Form is part of the  Risk Information dialog and is used to define risk attributes. You 

can customize the Risk Form to create any set to risk attributes which can be entered or edited.  

Risk Form has two modes: 

1. Editing Mode: you can drag and drop different controls to Risk Form and assign properties 

to them. Controls such as edit boxes, drop down list, frames or static text can be selected 

from the left side of the Risk Form dialog box and dropped on the form. After this you need 

to select risk attributes associated with the control from the list of available attributes. For a 

Static Text box you the enter text to be displayed, there are no risk attributes associated with 

the frame. 

2. Published Mode: when you complete design of Risk Form, click “Publish Risk Form 

Layout” to switch to Published Mode. In Published Mode you can no longer edit Risk Form 

layout, but you can enter risk attributes data. List of controls will be hidden. 

To edit the Risk Form (Editing Mode): 

1. Click the Risk tab. In the Risk Views group, click Risk Register  

2. Double- click on risk ID to open the Risk information dialog box 

3. Go to Risk Form tab; default Risk Form will be presented in Published Mode 

4. Go to Editing mode by clicking on Edit Risk Form Layout 

5. Clear controls if required by clicking on Clear All button 

6. Select control using button on the right side.  

7. Click on Risk Form to select the position of the control 

8. From the dropdown list above Risk Form select the property associated with selected control 

9. Adjust size of the control by dragging its corners 

10. Right click outside the control: shortcut menu will come up. You can Delete, Copy, or Paste 

control, as well as make the property Mandatory.  Once in Published Mode, all mandatory 

fields must be filled to save data.  

• Click Save as Default to save newly designed Risk Form for all your new projects 

• Click Standard Form to restore standard if required 

• Click Publish Risk Form Layout to convert to Published Mode 

To use Risk Form (Published Mode): 

1. Click the Risk tab. In the Risk Views group, click Risk Register.  

2. Double- click on risk ID to open the Risk information dialog box. 

3. Enter risk attributes to the Risk Form  
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• You can create any other risk properties using the Default Risk Properties dialog box (Risk tab of 

the ribbon, Settings pane) and include them to the Risk Form 

• Some properties, such as Expected Loss are calculated and will be read only 

• Risk Form allows you enter probability and impact of the risk. However you cannot use Risk Form 

to define probability and impact for risk assigned to tasks and resources and risks with multually 

exclusive alternatives. Therefore it is recommended to use Risk Form to enter probability and 

impact for qualitative risk analysis only (when there is no schedule). 

 

 

 

The Risk form has the following fields: 

• Number –real numbers, integer numbers, or cost properties 

• Edit Box –string (text) properties and organizational units 

• Dropdown List –picklist and Yes/No Properties 

• Dropdown Edit Box –risk, resources, and response plans 

• Date –date properties 

• Frame –frame or line separator; it is used to create visual separation between group of 

control 

• Static Text –read only text used for prompts and annotations 

Click here to toggle between Published 
Mode and Editing Mode. 

After you inserted the control, 
select risk attribute from here  

Click on button associated with control 
from here and then click on Risk Form to 
choose a location of this control. 

Click outside the control to 
select it and modify or  
resize/move the field. 

Right-click outside the 
control: a popup menu will 
appear. You can Delete, 
Copy, or Paste a field, or 
make it mandatory. 
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• Probability –risk probabilities belonging to different categories 

• Impact –risk impacts belonging to different categories 

• Threat/Opport. –selection of threats and opportunities 

About Cost of Risk Calculations 

The Cost Risk calculation calculates the total cost of a risk and takes into account the risk 

mitigation plans linked to the risk. The Risk cost calculation is performed in the Risk Form tab 

of the Risk Information dialog box. The Cost of Residual Risk and Potential Loss are the only 

values that you can manually enter in the Risk Form. All other cost parameters are calculated. 

You can modify Risk Form to show or hide different fields. 

 

 

 

Risk cost calculation  

Cost Before Mitigation 

1. Potential Loss (property “Cost before mitigation”): the loss in monetary terms if the risk 

occurs. This value can be entered manually if you select No for “Auto calculation of expected 

loss (from Monte Carlo)” or if you don’t open a schedule.  

For example, for the risk “low quality component”, the potential loss is $50,000. You 

would incur this cost if a low quality component were supplied. 

2. If you don’t open a schedule, the Probability Before Mitigation value is based on the risk 

values entered in the Probabilities and Outcome tab of Risk Information dialog box. See 

Risk Probabilities and Impacts for more information. If you have a schedule Probability 

Before Mitigation comes from results of Monte Carlo simulations.  

3. Expected Loss (property “Pre-Mitigation Expected Loss”) takes into account risk 

probability. It is an indicator that helps you to compare the costs of different risks. Expected 

loss can be calculated manually or automatically depending on selection “Auto calculation of 

expected loss (from Monte Carlo)”. 

a. Manual calculation of Expected Loss: You can manually calculate the expected loss 

for individual risks by running two simulations: one with the risk open and the other 

with the risk closed. The difference in the total project costs is the expected cost of 

the risk. 

Expected loss = Potential Loss * Probability (pre-mitigation) 

For example, probability of risk “low quality component” equals 50%. Potential loss 

equals $50,000. Expected loss will be $25,000 = $50,000 * 50%.  

b. Automatic calculation of Expected Loss is done based on results of Monte Carlo 

simulations of project schedule: 
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Expected loss = (Project Cost with Risks – Project Cost Original) * 

Correlation Coefficient  

The correlation coefficient is calculated using project cost and cost increases due to a 

specific risk occurring. For example, the project cost with risks and uncertainties is 

$100,000. Project cost without risks and uncertainties is $90,000. In addition, the 

correlation coefficient for the specific risk is 0.8. Expected loss will be ($100,000 - 

$90,000)*0.8 = $8,000.  

In RiskyProject minimum correlation coefficient between project cost and duration and 

instance of risk occurring in defined in Options -> Calculation -> Minimum Sensitivity 

Coefficient (see Setting up calculation options). If calculated correlation coefficient is 

less than this minimum value, it will be equal to zero. Default value of minimum 

sensitivity coefficient is 0.16. As a result, Expected Loss can be equal to zero even there 

is a cost outcome for the specific risk. It may occur if there is a weak correlation between 

project cost and cost increases due to a specific risk occurring. If you have many risks 

with low cost impact, it is recommended to reduce Minimum Sensitivity Coefficient. 

Cost Of Mitigation 

 

1. Cost of Mitigation is taken from Mitigation tab of Risk Information dialog box. It is the 

cost associated with efforts to reduce the probability and impact of the risk.  

For example, mitigation plans will include “Additional QA procedure” and “QA audit of 

supplier’s operation”, which would cost $10,000 in total. 

Cost After Mitigation 

 

1. Cost of Response Plan. Even if a mitigation plan is executed as planned, there will still be a 

cost associated with a risk, as it is possible to reduce risk, but not to eliminate it (an exception 

is when you are able to avoid the risk). The response plan may be executed if the risk occurs 

and will be calculated using the cost entered for the response plan associated with this risk. 

This cost is entered Mitigation and Response view.  

For example, if the risk “low quality component” occurs, this component needs to be 

replaced with a new one, which would cost $20,000. 

2. Residual risk may still exist after the risk response and is cost is calculated as the Cost of 

Residual Risk.  

For example, the new component installed as a risk response can still be defective. The 

residual cost of the risk will be $10,000.  

3. Probability After Mitigation comes from Mitigation tab of Risk Information dialog box. 

See “Risk Mitigation and Response Plans” for more information. 

For example: Risk Probability after mitigation equals 25% because of the execution of 

the mitigation plan “additional QA procedure”, probability of risk “Low quality 

component” is reduced two times. 

4. Expected Loss After Mitigation (property “Post-mitigation Expected Loss”) takes in to 

account the fact that risk may not occur.  

Expected Loss After Mitigation = (Cost of Response Plan + Cost of Residual Risk) * 

Probability After Mitigation 
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For example, probability of risk “low quality component” after mitigation equals 25%. 

Expected loss after mitigation will be $7,500 = ($20,000 + $10,000) * 25%. 

Other Cost Indicators (Properties) 

 

1. Cost After Mitigation = Expected Loss After Mitigation + Cost of Mitigation 

For example: Total cost after mitigation of risk “low quality component” will be $17,500 

= $7,500 + $10,000 

2. Saving from Mitigation/Enhancement is the difference between costs with and without 

mitigation. If this number is negative mitigation efforts will not lead to cost saving. 

Saving from Mitigation = Expected Loss – Total Risk Cost after Mitigation 

For example, total cost after mitigation of risk “low quality component” will be $17,500. 

Expected loss $25,000. Saving from Mitigation is $7.500. Because this number is 

positive, it makes sense to perform mitigation efforts. 

Custom Risk Properties 

All risks properties including pre-defined risk properties and custom properties can be viewed 

and edited using the Custom Properties tab of Risk Information dialog box. 

1. Click the Risks tab. In the Risk View group, click Risk Register. 

2. Double- click on risk ID to open the Risk information dialog box.  

3. Use Custom Properties tab to enter general information about risk. Enter or update values of 

properties. You can assign a set of custom risk properties using the Default Risk Properties 

dialog. 

Risk Reviews 

RiskyProject helps you to facilitate regular risk reviews. You can define the risk review 

periodicity (weekly, monthly, and quarterly). RiskyProject will notify you before review is 

scheduled. During the risk review, you may analyze all risk attributes, make necessary changes, 

and write notes. Risk reviews are important components of the risk management monitoring and 

control process as the status of risks and their attributes, such as probabilities and impacts, are in 

constant flux during the course of a project. 

Risk review due date 

Each risk review can have a scheduled due date. The risk should be reviewed on or before a due 

date. A few days before due date RiskyProject will notify you regarding the scheduled review. 

The notification will be presented as a change in color of the Next Review property if it is 

inserted in Risk Register:  

 

 
Warning: due date is 
approaching 

Risk review is overdue 

Risk was reviewed. Due date is set some time in the future. 



RiskyProject Professional User Guide 

44 

 

You can also view the Next Review date in the Risk Review tab of the Risk Information dialog 

box. You  can insert a Next Review column in the Risk Register view. 

 

The default risk review frequency and number of days before incoming risk review is defined in 

Default Risk Properties dialog (Risk tab of the ribbon, Settings pane). 

 

Entering and viewing risk reviews 

You may enter information regarding risk review using Risk Review tab of the Risk Information 

dialog box. The Risk Review tab offers greater flexibility to view all risk reviews for the project, 

as well as allowing you to modify or delete risk reviews. 

To enter a risk review: 

1. On the ribbon, click Risk > Risk Register. 

2. Double-click on risk ID to open the Risk information dialog box. 

3. In Risk Review dialog box enter who submitted review, review notes, and click OK. 

4. If necessary, update due date for the next review using Next Review field or update 

frequency of review for this risk using Review Frequency dropdown list. 

Assigning Risk Response Plans 

Response plans defined in the Mitigation and Response view can be assigned to risks.  

Assigning Response Plan: 

1. Click the Risks tab. In the Risks View group, click Risk Register. 

2. Double- click on risk ID to open the Risk information dialog box. 

3. Click the Risk Form tab 

4. In the default Risk Form select a response plan from Response Plan dropdown list. These 

response plans are defined in Mitigation/Response view.  

5. If you are not using the default Risk Form, you can add the response plan dropdown list using 

Dropdown Edit button in Editing Mode of Risk Form. See Risk Form for more information. 

6. If you don’t see your response plan in the dropdown list, it means that the response plan is not 

defined in the Mitigation/Response view. You still can enter Response plan name in 

RiskyProject, but it will not be used for risk cost calculation. 

Assign Mitigation Plans Using the Mitigation Tab 

You can assign mitigation plans defined in the Mitigation and Response view to your risks. One 

risk may have multiple sequential mitigation plans. They can be shown as a Waterfall diagram. 

Waterfall diagrams can be used to visualize the timing of mitigation efforts over the course of the 

project.  
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• Pre-mitigation probability and impact are the results of calculation. Therefore, they cannot 

be updated in the waterfall tab.  

• Probability, impact, and score for the last mitigation effort are converted into the post-

mitigation probability, impact, and score and will be shown in the Risk Register. 

• You can view Planned and Actual risk mitigation efforts. Actual mitigation efforts are shown 

based on actual dates entered the table above. 

 

Viewing and editing waterfall diagrams: 

1. Open the Risk Register view. 

2. Double-click on Risk ID. The Risk Information dialog box opens.  

3. Click the Mitigation (Waterfall diagram) tab. 

4. Enable or disable Actual and Planned mitigation lines using check boxes on the left 

bottom corner. 

5. Double click on Mitigation Plan ID;  the Mitigation Plan Properties dialog box opens. 

6. Enter a mitigation description. 

Select a mitigation plan from the drop-down list. 
You can also enter a mitigation plan here and it 
will be automatically added to the Mitigation and 
Response view. 

Enter the date, 
when mitigation 
efforts are expected 
to start. 

Colors for the waterfall diagrams are defined 
by the risk tolerance (see Format Risk 
Matrix). 

Enter probability and impact 
on each mitigation phase. 
The score will be calculated 
automatically. 

Mitigation cost. If 
mitigation plan is linked 
to a task, % 
completed, cost and 
actual will be taken 
from task information. 

Probability and 
Impact of risk 
before and after 
mitigation are 
shown here. 

Planned mitigation 

Actual mitigation 
based on Actual 
Dates 

Enter the date, 
when mitigation 
efforts actually 
started 

Mitigation plan can be 
assigned to a resource. It 
is defined in the 
Mitigation/Response view 

Mitigation plans 
can be linked 
to a task. 
Double click on 
task ID to 
define this task. 
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7. Select the task or summary task to assign it the mitigation plan. If mitigation plan is 

linked to the task, cost, actual cost, and percent completed of the mitigation plan will 

taken from task. 

8. To delete the task assignment, click Clear task selection. 

Assign Mitigation View 

You can use Assign Mitigation view to assign sequential mitigation plans to the risks. It allows to 

see all plans assigned to all Risk in one place. Alternatively, you can see mitigation plans 

assigned to individual risks in the Mitigation Tab of the  Risk Information dialog box. 

 

To assign a mitigation plan to a risk: 

1. On the Workflow bar, click Assign Mitigation view 

2. Add columns for probabilities, impacts and scores for individual as required. By default, only 

the columns for probabilities, impacts and scores for all categories are shown.  Assign 

Mitigation view also include columns for other risk mitigation properties, as well as five text 

and five numerical fields that can be used to enter additional information. 

3. Right click on the plan ID and from the shortcut menu, click New Plan to insert a mitigation 

plan assignment. 

4. Select a mitigation plan from dropdown list. The dropdown list is populated with mitigation 

plans from the Mitigation View. 

5. Enter probabilities and impacts, as well as other properties of the mitigation assignment; 

scores are calculated as Probability * Impact. 

6. To delete plan right click on the ID and from the shortcut menu click Delete Plan. 

 

Predicted risk probabilities, 
impacts, and scores 

Actual risk probabilities, 
impacts and scores 

Actual impacts for 
individual categories 

Predicted impacts for 
individual categories 

Right click on ID to insert or 
delete Mitigation Assignment 
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• You cannot use this view to modify risks or insert more risks 

• Assign Mitigation view does not show original and current sets of probabilities, impacts, and 

scores, only post-mitigation probabilities, impacts, and scores 

• Probabilities, impacts and scores for individual categories are not used to calculate post-

mitigation probabilities, impacts and scores for all categories, which need to entered 

separatelly 

• If you want probabilities for all categories be the same, enter probability in “Probability: All 

Categories” or “Probability Actual: All Categories” columns 

• You can import data from Excel to Assign Mitigation view using File -> Import -> Import Risks 

from Excel 

 

Risk Status View 

You can use Risk Status View as a depository of changes to risk probability and impact. It is 

similar to Risk History, but contains more information, while can be edited, printed and exported 

to Excel. Each time risk probability and impact are changed, the record will be added to the Risk 

Status view. The main purpose of this view is to show how probability, impact, and changing 

over time for all risks. The record includes: 

1. Risk name and Risk Unique ID, associated with the record 

2. Date of the change 

3. Description of the change 

4. Pre-mitigation probability, impact, and score for all categories. It can be used as predicted 

probability, impact, and score. They are generated automatically based on what is defined in 

Risk Register view, but can be modified by the user 

5. Actual probability, impact, and score for all categories. They are user defined in Risk Status 

view 

6. Pre-mitigation and actual probability, impact, and scores for individual categories. They are 

user defined in Risk Status view for each status record and may not correspond with 

probability, impact, and scores for individual categories in Risk Register view. Columns for 

this data are hidden by default. 

7. Additional information, which can be recorded in five custom text fields and five custom 

number fields for each record. Columns for additional information are hidden by default. 

To enabled automatic saving of changes in risk probability and impact as Risk Status 

record: 

1. On Schedule tab click on Project Options in Settings in Options group 

2. Go to Risk tab 

3. Select Update Risk Status when risk probability/impact are changed 

 

• You can modify, delete, or insert Risk Status records. To delete and insert record right click 

on Risk Status record ID and select Delete Risk Status or New Risk Status from drop down 

menu. 
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• You can import data from Excel to Risk Status view using File -> Import -> Import Risks from 

Excel 

• You cannot use this view to modify risks or insert more risks 

• Probabilities, impacts and scores for individual categories are not used to calculate pre-

mitigation and actual probabilities, impacts and scores for all categories, which need to 

entered separatelly 

 

Risk History 

The Risk History records any changes made to the risk over time. Risk history is automatically 

updated when you save the project. 

View a risk history: 

1. Click the Risks tab. In the Risk Views group, click Risk Register. 

2. Double- click on a risk ID to open the Risk information dialog box. 

3. Click the History tab to view risk history 

4. To copy a risk history record to the clipboard, Right-click on a record ID and select Copy 

Data. 

5. To delete record, Right-click on record ID and select Delete Item. 

 

• You can modify the date of the history record. Other fields are read-only, so you cannot 

modify them, but you can delete the risk history record. 

• Risk history is used to present the history on the Risk Matrix, as well as to determine the 

Original risk probability and impact. 
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Risk Matrix and Risk Trend Chart 

Risk Matrix and Risk Trend views allow you to determine the severity of a risk and analyze how 

risks are changing over time: 

• The Risk Matrix is a tool that allows you to determine the severity of a risk. The Risk 

Matrix view shows this using the risk probability (y-axis) vs. calculated risk impact (x-

axis) of the project risks. The Risk Matrix view is divided into two sections: a table with 

a list of risks with their actual calculated values for probability, impact, and score. When 

you select these risks, they are shown visually on a matrix, which provides a visual 

comparison of this data put as well as putting each risk into the context of your 

organization’s risk tolerance. Changes in probability and impact due to mitigation plans 

added to a risk’s mitigation waterfall chart will automatically be displayed in the Risk 

Matrix. 

• The Risk History shows how the probability and impact of an individual risk has 

changed over time. 

• The Risk Monitor shows the number of risks per cell in the risk matrix. 

• The Risk Trend shows how project risk change over time. The Risk Trend can be 

presented as bar chart or in table format (Total Risks). 

Viewing the Risk Matrix  

1. Click the Risks tab. In the Risk Views group, click Risk Matrix. 

2. Select type of chart you want to view at the bottom of risk matrix. 

3. Select the Threats or Opportunities option at the top of the matrix. You cannot view Threats 

and Opportunities at the same time 

4. Risk scores can be shown on the Risk Matrix based on overall score (No Hierarchy) or a 

selected risk category which are shown in the Hierarchy based on dropdown list. Lists of all 

risks associated with the selection are shown in the table. Select No Hierarchy to view the 

overall risk score (sum of all risk categories) for selected risks.  

5. Select the check boxes beside the risk names to view the risks on the Risk Matrix. To hide a 

risk, clear the check box. By default, risks with zero impact cannot be selected. Use the filter 

at the bottom of the list (“Hide a risk if Score is < “ or “Show risks with severity level…”) to 

show/hide risks below the entered threshold. Severity level is defined in Risk Trend Chart 

Settings dialog. Essentially in the color of risk matrix. 

To format the Risk Matrix, right-click on the matrix and choose Format Risk Matrix. For more 

information about formatting the Risk Matrix, read, “Format the Risk Matrix and Risk Trend 

Chart”. 
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Viewing the Risk Trend Chart 

Risk Trend shows how many risks belonging to different severity levels (colors) existed in a 

certain time period. To view Risk Trend Chart: 

1. Click the Risks tab. In the Risk Views group, click Risk Trend. 

2. Select a chart type from the tabs at the bottom of the of chart. 

3. Select the Threats or Opportunities option at the top of the chart. You cannot view Threats 

and Opportunities at the same time 

4. Select a No Hierarchy or a specific risk category from the Hierarchy based on dropdown 

list. Lists of all risks associated with the selection are shown in the table. No Hierarchy 

shows the calculated overall risk score (sum of all risk categories) for selected risks.  

To format the Risk Trend chart, right-click on the chart and choose Format Trend Chart. For 

more information about formatting the Risk Trend Chart, read, “Format the Risk Matrix and Risk 

Trend Chart”.  

Select risk to display it 
on the Risk Matrix 

Select risk category to 
view the risks 

Threats and opportunities are 
viewed separately 

Number of risks 
for each cell 

How probabilities and impacts 
of risks are changing over time 

Filter: show risk based 
on severity level 

Arrows show changes in the 
probability and impact of risks due to 
mitigation plans 



RiskyProject Professional User Guide 

 

51 

 

Copy the risk matrix and risk trend chart to the clipboard or save as a JPEG 
file 

1. Right-click on the Risk Matrix or Risk Trend 

2. Choose Copy to Clipboard or Copy Chart to File (JPEG, PNG, GIF…). 

3. If you chose to create a file, you will be prompted to select file format and save it to a 

directory. 

In this time interval it was: 

• 8 very low impact risks 

• 3 medium risks 

• 1 critical risks 
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Risk Report 

The Risk Report is a view the includes the selected attributes of selected risks. The report for one 

risk may contain one or many pages. The total number of pages per report equals the number of 

selected risks multiplied by the number of pages per risk. The Risk Report includes seven 

sections: 

1. General Properties 

2. Pre- and post- mitigation probabilities, impact and score 

3. Cost of Risk  

4. Custom Properties 

5. Waterfall Chart 

6. Mitigation Plans 

7. Risk Reviews 

Each page of the risk report contains a header and footer. The header and footer may include up 

to three lines of text and a logo located on the left or right side. 

Customize the Risk Report 

You can customize the Risk Report in the following ways: 

• Select the order and turn on and off any section of the report 

• Customize any particular section by enabling or disabling any attribute and customizing 

labels of the attribute. For example, by default the label for risk detailed description is 

called “Description”. Instead, you may use “Information about risk”. 

• Customize headers and footers. Specifically, you can select a logo (company) that can be 

placed in the header and/or footer. 

• Modify attribute values or labels. 

To customize the risk report 

1. On the Risks tab, click Risk Report. 

2. At the bottom of the view, click Customize Risk Report. 

3. Enable/disable attributes, customize attribute’s label, make label or value of the attribute 

bold 

4. In the Order of Data Tables, select the data tables you want to include in the report and 

use the Move Up and Move Down buttons to change the order of the sections 

5. For “Pre- and post- mitigation probabilities, impact and score” of the report enable or 

disable pre and post mitigation matrixes. 

6. Click OK. The report will be regenerated to reflect the changes.  
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Customize Header 

Customize Footer Select logo as a bitmap 

Customize Pre- and 
post- mitigation section 

Enable/disable 
attribute, customize 
attribute’s label, make 
label or value of the 
attribute bold 

Select section of the 
risk report and change 
the order of the 
sections 
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Risk Dashboard 

The fully customizable Risk Dashboard allows you to present hundreds of different KPIs and 

charts related to your risks. You can create any number of dashboards with different information, 

which are shown as different tabs within Risk Dashboard View. You can select from 7 types of 

charts: line, area, pie, scatter, bar (including frequency histogram), different types of meters, and 

risk matrixes. You can place them in different areas on the dashboard, adjust their size, colors, 

and other properties. You can also annotate your dashboard with text, lines, and images.  

When you modify your risk data, the charts and KPIs are automatically updated. This date 

includes risk properties, mitigation and response plans, and project schedules. Annotation is not 

updated when we update risk data.  

 

To add a chart, KPI, or annotation to the Risk Dashboard: 

1. Select the type of chart or KPI from the toolbar on the right side. 

2. Click on the dashboard and drag the line or rectangle to select the position of the chart, KPI, 

or Properties annotation. 

3. Right click on chart, KPI, or annotation. 

4. Select Properties from shortcut menu; Properties dialog opens. 

5. Enter properties of the chart, KPI, or annotation; it includes type of chart or what type of data 

this chart, KPI or annotation will represent as well as graphic properties. 

6. Click Close to close the Properties dialog box.  

To modify a chart, KPI, or annotation  

1. Click on the  chart, KPI, or annotation; chart, KPI, or annotation you want to modify. 

You can create multiple 
tabs (views) for Risk 
Dashboard 

KPI 

Bar Chart 

Line Chart 

Area Chart 

Meter 

Risk Matrix 

Pie Chart 

Scatter Plot 

Annotation: Line 

Annotation: Image 

Annotation: 
Rectangle with text 
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2. Move or expand the area to adjust size or position of the chart, KPI, or annotation  

3. Right click on chart, KPI, or annotation and click Properties from shortcut menu; Properties 

dialog opens. 

4. Modify properties of the chart, KPI, or annotation; it includes type of chart or what type of 

data this chart, KPI or annotation will represent as well as graphic properties. 

5. Click Close to close the Properties dialog box. 

6. To enter text or update font and alignment, right click on KPI and Annotation rectangle and 

select Edit or Format Text within a shortcut menu. 

To export dashboard 

1.  Right click in any place of dashboard,  and from the shortcut menu click Copy Dashboard 

to Clipboard or Copy Dashboard to File. 

2. In you export dashboard to file, you can select file format: JPEG, PNG, GIF, BMP, or TIFF 

 

• Many KPIs and charts are based on results of Monte Carlo simulations. Therefore you need to 

perform calculation to see results of analysis on the dashboard. 

• RiskyProject comes with default dashboard. To Generate default dashboard right click in any 

place of dashboard and select Create Standard Dashboard from shortcut menu. 

• To completely clear dashboard click in any place and select Clear Dashboard from shortcut 

menu 

• You can save dashboard in system registry for all new project. To do then click in any place 

and select Save Dashboard as Default from shortcut menu 

• You can modify background color of dashboard by clicking in any place and selecting 

Dashboard Setting from shortcut menu 

• You can copy and paste selected chart, KPI, or annotation. To do that right click on any 

selected chart, KPI or annonation, and select Copy from shortcut menu. Then right click on 

any area of dashboard where you want to paste it and select Paste from shortcut menu. 

• Risk Dashboard can be printed. To Print dashnoard click on File > Print 

 

 



RiskyProject Professional User Guide 

56 

 

Setting up Defaults for Qualitative Risk Analysis 

Risk ID Settings 

You can generate Risk IDs automatically. Alternatively, you can enter the Risk IDs manually, in 

the same manner as you enter any other risk property. If a Risk ID is generated automatically, you 

can overwrite it manually. Risk IDs will be incremented each time you enter new risk. 

Risk IDs may include four components 

1. Prefix – any symbols (optional) 

2. Number – from 4 to 16 digits (optional)  

3. Suffix – any symbols (optional) 

4. Date – date format can be defined (optional) 

Risk ID can be unique for all projects on your computer or unique only for a particular schedule. 

For example, if Risk ID is unique for all projects on your computer: 

• Project A will have risks R0001, R0002, R0003, R0004 

• Project B will have risks R0005, R0006, R0007 

If Risk ID unique only for the particular schedule: 

• Project A will have risks R0001, R0002, R0003, R0004 

• Project B will have risks R0001, R0002, R0003 

You can always reset the starting number. The starting number only affects new risks and does 

not affect risks, which had been previously entered. However, if you update the starting number 

the Risk ID may not be unique. In addition, the Risk ID may be not unique if you manually 

overwrite automatically generated risk ID. 

To enable automatic generation of Risk ID and define format of Risk ID: 

1. Click the Schedule tab. In the Settings group, click Options. 

2. Click the Risk tab. 

3. Select the Generate Risk ID automatically check box. 

4. Click on Risk ID Format to define rule of Risk ID automatic generation; Risk ID Format 

dialog box opens. 

5. In the Risk ID Format dialog, select how Risk ID will be generated: for particular project or 

for all projects on your computer. 

6. Define the Risk ID prefix and suffix. 

7. Define the number of digits for Risk ID generation. 

8. Enable / disable date as part of the Risk ID format. 

9. If date is enabled, define the date format and position. 

10. Define the starting number for generating Risk IDs. 
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Managing Risk Categories and Outcome Types 

RiskyProject has a default list of risk categories and outcome types. You may customize risk 

categories and outcome types: add new outcomes or delete existing categories or outcome types.  

For example, you add the category Security, which is not in the list of predefined categories: 

Category:   Security 

Outcome Type 1:  Trespassing 

Outcome Type 2:  Information Security Failure 

Categories are shown at the top of Risk Register, Risk Matrix, and Risk Report views. You are 

able to filter risks based on category. Outcome types are filtered based on the risk probabilities 

and outcomes. For example, you enter the risk “Failure of security procedure.” It will have 

probability 60%, outcome type “Information Security Failure” and outcome “Low.” 

Risk categories related to project duration are referred to as “Schedule and Scope.” This category 

is shown Risk Register as the “Duration” category. Risk categories related to project cost are 

referred to as “Cost and income” and are shown in the risk register as the “Cost” category. Under 

both these categories, you will find a number of outcome types. Most of these outcome types are 

reserved for quantitative risk analysis (read “Quantitative Risk Analysis” for more information). 

For qualitative risk analysis only two outcome types are available: “Relative Delay” for 

“Schedule and Scope” and “Relative Cost Increase” for “Cost and income category.”  

Prefix Number Suffix Date 

Risk ID may be the same for risks 
for different project files 

Risk ID can be unique for all risks on 
this computer 

You may reset starting number of the risks. 
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• One risk may have different outcomes type and categories. For example, “Low quality 

supplies” can affect quality and safety. RiskyProject will calculate the impact of this risk on 

safety and quality separately, and the combined impact on all risk categories. 

• You can enable/disable risk outcomes. Once disabled, risk outcomes will no longer be available 

on the Probabilities and Outcome tab of Risk Information dialog box.  

• You may save a customized set of risk categories and outcome types to the system registry 

for all future projects on your computer by clicking the Set as Default button. This new 

default set of risk categories and outcome types will not affect existing projects. You may 

also restore a pre-defined set of categories and outcome types by clicking the Restore 

Defaults button.  

• You may copy the risk category and outcome type data to the clipboard. To do this, select a 

row under which you want to add a copy risk outcome, right-click on the row number and 

choose Copy Data  

 

Adding risk categories  

1. Click the Risks tab. In the Settings group, click Categories and Outcomes. 

2. Click the Outcomes tab. 

3. Select a row above where you want to add a new risk category. 

4. Right-click on the row number and choose New Item. 

5. Provide a name. 

First level: 
risk 
categories 

Second 
level: risk 
outcome 
types 

Relative importance of the 
risk category is calculated 
automatically based on 
weights. 

Right- click to add and 
delete categories and 
outcome types. 
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6. Click the Outdent arrow. By default, all new rows are considered risk outcomes, by moving 

the outcome to the left the outcome is converted into a risk category. This is indicated when 

the name is bolded, and the Task and Resource check boxes disappear. 

Risk Weighting  

Risk Weighting is a method of assigning the relative importance of a particular risk category to an 

organization and is important when dealing with multi-criteria decision-making. RiskyProject 

uses a form of the Analytical Hierarchy Process (AHP) to weigh the relative importance of one 

risk category over another. By default, weights for all risk categories are equal. 

AHP is a two-step process: 

1. Develop a list of your risk categories and criteria. 

2. Perform a pair-wise comparison to establish consistent ranking or priorities for each risk 

category.  

For example, after determining your organization’s risk preferences, you determine that Safety 

risk is twice as important as Environment; you would enter a 2 into the cell where the 

Environment category row intersects the Safety column. 

 

Notice that the relative importance of the Safety Category has increased to 13.8 while the rest of 

the categories have decreased. 

These weights will be used in the calculation of the risk impact on all categories.  

Weighting risk categories 

Before you can add risk weights, you should perform a risk weighting analysis to determine the 

relative importance of each risk category to your organization.  

1. Click Risks tab. In the Settings group, click Categories and Outcomes. 

2. Click the Weights tab. 

3. Select the risk category to which you want to add the weighting factors. 

4. Enter the risk-weighting factor for each risk category (column). 

5. Repeat Steps 3 and 4 for each risk category. 
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Managing Default Risk Properties 

Risk Properties 

Each risk may have risk properties. These properties are useful for storing any information about 

the risk. You can use risk properties to search and filter the Risk Register. Risk properties can be 

different types: 

• String – text information 

• Integer number  

• Real number 

• Resource – can be taken from list of resources 

• Date 

• Picklist: dropdown list with values 

• Mitigation Action: used to import data from Excel, see “Importing Risk Register from 

Microsoft Excel” 

• Threats or Opportunities: used to import data from Excel, see “Importing Risk Register 

from Microsoft Excel” 

• Response Plan: by using this property type you can define multiple response plans 

• Yes/No 

Integer numbers and real numbers have maximum and minimum values. 

The list of risk properties is hierarchical; the risk properties are subdivided into separate groups.  

Editing the default risk properties 

1. Click the Risks tab. In the Settings group, click Default Properties. 

2. Select a row under which you want to add a new risk outcome. 

3. Right-click on the row number and choose New Property Item 

4. Type in the name. 

5. Select type, maximum and minimum values for the new property.  

6. Use the Indent and Outdent arrows  to create groups of risk properties. 

7. If you have Picklist type risk property double-click on risk property ID; Picklist dialog box 

will open where you can enter the list of values. 

Default risk properties are automatically saved in the system registry and can be used for all 

projects. You may use the Restore Default button to overwrite changes in default risk properties 

you made with standard set of risk properties. 

Format the Risk Matrix and Risk Trend Chart 

You can modify the Risk Matrix to define the risk matrix’s number of row and columns, define 

labels and the risk tolerance display. These settings will be used in Risk Matrix view.  

Risk Tolerance 

The level of risk tolerance is displayed using color-coding (for threats: green: low risk, yellow: 

medium risk, red: high risk). A high number of green cells on the chart indicates a high-risk 

tolerance. A high number of red cells on the chart indicates a low risk tolerance. Color-coding for 

opportunities is the opposite.  
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Number of Rows and Columns, Labels for Probabilities and Impacts 

In the Format Risk Matrix dialog box, the number of rows in the Probability table corresponds 

with number of rows of the risk matrix, and the number of rows in the Impact table corresponds 

with the number of columns in the risk matrix. Therefore, to add or remove a row or column in 

the risk matrix, simply add or remove the label in the probability or impact table. 

You may define probability and impact for different labels for each risk category. In addition, you 

may define different labels for threats and opportunities.  

For example, if, in the Duration category, the impact label for “Threats” is “Low: 1 month delay”, 

the impact label for the opportunity in the same category is “Low: 1 month acceleration”. If you 

do not define labels for a risk category, the default set of labels will be used. You may modify the 

default set of labels by selecting “Default” from the dropdown list and then editing as required. 

Probability labels are used only in the Risk Matrix; impact labels used appear in the Risk Matrix 

as well as to define outcomes of each risk in the Probabilities and outcomes tab of the Risk 

Information dialog box.  

For example, an impact label “Low: 1 month delay” will be shown on the horizontal axis of the 

Risk Matrix. In addition, when you define the impact of a risk, which has an outcome type 

“Relative delay”, you will be able to select the outcome “Low: 1 month delay”. 
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In Risk Information dialog box: 

 

 

Define Custom risk scores 

Risk scores are usually calculated as Probability * Outcome. However, if you have risk 

probabilities  and outcomes expresses as index  (1,2,3,4….) index and label (2: “Low Impact”) in 

the drop down list you may define custom nonlinear scores. These scores are shown in Risk 

Matrix in Format Risk Matrix dialog as number from 1 to 99 on each cell.  For example,  

• index of low probability is 2 -  second row from the bottom of risk matrix 

• index of critical outcome is  5 -  last columns of risk matrix 

• score based on these indexes equal 2*5 = 10 

• it is possible to assign a number to this cell different than 10. To do just click on number 

and enter different number, for example 11. 

Select risk category from 
the dropdown list 

Enter probability labels and ranges for 
threats and opportunities 

Probability 
labels are 
shown here 

Enter impact labels and ranges for 
threats and opportunities 

Impact labels are 
shown here and here 

Use slider to define risk 
tolerance 

Number of rows 
equal number of rows 
in probability table 

Number of columns equals number of 
rows in impact table 

Risk  
Probability 
and 
Outcome 
can be 
expressed 
different 
ways 

You may add 
symbol or 
number 
before 
probability 
and impact 
label 

Click on number to 
assign custom risk score 
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Nonlinear intervals for probability and impact 

In standard risk impact and probability matrixes, intervals can be non-linear. For example, in 

some 5x5 risk matrixes, Very High probability often indicates a probability of 10 - 70%, High 70 

-50%, Moderate 50-30 %, Low 30-20% and Very Low is >10%.  The risk matrix can be setup so 

that the matrix “intervals” can be modified so that each interval can represent a different scale for 

both probability and impact. The sum of all intervals must be equal to 100%.  When you are 

modifying the ranges, if the sum is not equal to 100%, the background color will be pink. Once 

the sum equals 100%, the color changes to green. 

Very Low 10% 

Low 20% 

Medium 20% 

High 20% 

Very High 30% 

The same process can be used to customize your impact matrix 

Negligible 1% 

Minor 4% 

Moderate 5% 

Serious 10% 

Critical 80% 
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The example below shows how this would appear in the Format Risk Matrix dialog box. 

 

Risk Severity Levels 

Each color on risk matrix represents a particular risk severity level. By default, there are only 

three ranges: “Low” – green, “Medium” – yellow and “Critical” red. Each severity level can be 

associated with certain risk mitigation and response actions. For example, risks that appear on 

green cells are low risk and can be accepted. 

Nonlinear intervals for 
Probability  

Nonlinear intervals for 
Impact 

Nonlinear intervals for 
threats  

Nonlinear intervals for 
opportunities   

Intervals for each risk 
category can be different   
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You may change color of each cell by double-clicking on the cell. You may also define a name of 

each range, and order how different ranges are shown in the Risk Trend Chart, as well as the 

periodicity of the risk trend chart.  

Steps to Format Risk Matrix 

To format the Risk Matrix: 

1. Click the Risks tab. In the Settings group, click Format Risk. 

2. Select a risk category from dropdown list. “Default” category is used if you did not explicitly 

define labels for specific risk category.  

3. Modify the Intervals for Impact and Probability for the selected risk category. 

4. Modify the Impact and Probability labels as required for the selected risk category. 

5. Drag the Risk Tolerance slider to the left to set a low risk tolerance or to the right to set a 

high-risk tolerance.  

6. Toggle between Threat and Opportunity to view how the risk matrix will look like for 

threats and opportunities. 

7. Define how risk outcomes in Risk Information dialog box or Risk Register will be shown: 

• As label only (e.g., “Low Impact”) 

• As percent together with label (e.g., “Low Impact – 15%”) 

Double click on each cell 
to define a color  

Define name and order of 
severity level  
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• As percent only (e.g., 15%) 

• As index of the label (1,2,3,4…) in dropdown list 

• As index and the label: e.g. 2: Low Impact in dropdown list 

 

8. Add symbol or number before probability or impact label. For example, instead of “Very 

Low” label you may use “A: Very Low”. 

9. The define properties of the severity level by clicking on “Risk Trend Chart Settings” 

10. Formula to Calculate Combined Impact allows you define algorithm for impact 

calculation.  

 

Your settings will be saved to the system registry for all new projects on your computer. These new 

defaults will not affect any previous projects. You can also restore the pre-defined set of categories 

and outcome types by clicking on the Restore Defaults button. 

 

Risk Trend Chart Settings 

Using Risk Trend Chart settings dialog box, you can define: 

1. Order of bar on Risk trend chart associated with particular risk severity level. For example, 

for each time period Low risks (Green color) will first, Medium risk (Yellow color) will be 

second and High risks (Red color) will be third. You can use Move Up and Move down 

buttons to define the order. 

2. Name of each range. 

3. Risk trend chart periodicity (Monthly, Quarterly, Yearly, etc.) 

4. Maximum number periods in in Risk Trend Chart. For example, Risk trend will show 10 

month back starting from the current month. 

Risk Trend chart settings can be invoked from Format Risk Matrix dialog or by right click on 

Risk Trend Chart. 
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Algorithm for Impact Calculation 

You may define algorithm for impact calculation using Formula to Calculate Combined 

Impact button. There are two algorithms:  

• Combined impact = maximum impact of all categories; for example, Cost Impact is 30%, 

Schedule Impact is 40%, and Safety Impact is 10%. Total impact is 40% 

• Combined impact = sum of impacts in each category and then normalize. For example, 

Total impact will be 70%. However, if total impact for at least one risk in risk register 

with exceed 100%, all impacts for all risk register will be proportionally reduced to 

ensure that on impact is greater than 100%. 

To define algorithm for impact calculation:  

8. Click the Risks tab and then click on Format Risk Matrix 

9. Click on Formula to Calculate Combined Impact 

10. Select Calculation of combined risk impact for all categories:  maximum impact or 

normalized sum of impacts. 

Order of Severity Levels is defined in Risk 
Trend Chart Settings. 

1. Very Low – Dark Green 
2. Low – Green 
3. Medium – Yellow 
4. Critical - Red 

Define Risk Trend Chart 
Periodicity  
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Saving and Loading the Risk Register 

You can share a risk register between different projects. This feature is useful when you create a 

set of risks for your organization and want to share risks between different projects on different 

computers. Risk register can be saved on a corporate server. RiskyProject will lock risk register if 

you are using it to prevent another user from overwriting it. 

To save the risk register 

• Click the Risks tab. In the Export/Import group, click Risk Register and then Save 

Risk Register. The risk register will be saved as a separate file with extension *.alr.  

To load the risk register,  

• Click the Risks tab. In the Export/Import group, click Risk Register and Load Risk 

Register. 

 

• When you save a risk register, risk assignments that are used for quantitative risk analysis 

are not saved. If you wish to share information about global risk assignment between 

different projects use risk templates. 

• When you load a risk register to existing project all risks will be deleted. 

 

 

 



Chapter 3: Managing Project Schedules 
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RiskyProject for Microsoft Project and Oracle 
Primavera 

RiskyProject as a Standalone Application 

You can launch RiskyProject directly from the Windows Program menu. When you open 

RiskyProject, the main Project view appears in which you can enter schedule and risk, perform 

the analysis, track project performance and report the results.  

RiskyProject for Microsoft Project 

RiskyProject seamlessly integrates with all versions of Microsoft Project from 2010 and later. 

When you install RiskyProject, it checks if Microsoft Project is installed on the computer. If 

Microsoft Project 2010 or later is, installed RiskyProject installs ribbon tab and Add-In to 

Microsoft Project. 

Here is how the integration works: 

1. The first time you open Microsoft Project after installing RiskyProject for Project, check to 

see that the RiskyProject ribbon tab is visible. You can enable/disable ribbon tab by clicking 

on Options in the File menu. Project Options dialog will open where you can select 

Customize Ribbon. You can also check the installed RiskyProject add-in by selecting Add-

Ins. 

2. Create a schedule in Microsoft Project. 

3. Define uncertainties, perform calculation, and analyze results: 

• Define statistical distributions for cost and duration for selected tasks inside Microsoft 

Project; all statistical distributions are saved in a RiskyProject file. 

• Add risk-related information in the RiskyProject views if necessary: risk events, 

probabilistic and conditional branching, probabilistic calendars, etc. 

• Perform Monte Carlo simulations 

• View results of analysis and reports in Microsoft Project 

4. At any moment, you can go back to Microsoft Project and make changes to your schedule. 

All changes will be reflected in RiskyProject. However, if you make changes to the 

deterministic project schedule in RiskyProject, these changes may be overwritten by the 

Microsoft Project schedule. 
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• You must save the schedule in Microsoft Project to use the integration between Microsoft 

Project and RiskyProject.  

• Always use the RiskyProject toolbar or ribbon tab in Microsoft Project and Go back to 

Microsoft Project button in RiskyProject to move back and forth between RiskyProject 

and Microsoft Project. 

• Once you have added risks and uncertainties to your schedule in RiskyProject, they will 

be always associated with Microsoft Project schedule.  

• Once you open a risk view from within Microsoft Project, your Microsoft Project file will 

be associated with the RiskyProject data file that contains risks and uncertainties for the 

schedule created in Microsoft Project.  

• Links between the Microsoft Project schedule and the RiskyProject file (alm extension) 

are saved in the registry. If you move the RiskyProject file into a different directory, you 

will be prompted to browse to find the RiskyProject file associated with the Microsoft 

Project file.  

 

• If you move the Microsoft Project file, the link between Microsoft Project file and 

RiskyProject will also be broken. In this case, use the command File > Import > Risks from 

Another Project to find the RiskyProject file.  

• If you make any changes in Microsoft Project and open RiskyProject using the toolbar or 

ribbon tab, RiskyProject will reflect the change; however, the risks and uncertainties will be 

adjusted proportionately. For example, your schedule in Microsoft Project has a task “Project 

Click the Go Back to Microsoft Project button in 
RiskyProject to view original schedule and resources 

Use the RiskyProject toolbar or ribbon tab 
in Microsoft Project: 

1. Define statistical distributions for 
selected task or group of tasks 

2. Run Monte Carlo Simulations 

3. View results of selected task or group 
of tasks 

4. Open the selected risk view or report 
RiskyProject.  

Microsoft Project 

 

RiskyProject Add-In 
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Inception” with a Base duration of 5 days and in RiskyProject you define Low duration as 2 

days and High duration as 6 days. If you go back to Microsoft Project and change the Base 

duration to 10 days, when you return to RiskyProject, the Base duration will be 10 days (the 

same as in Microsoft Project); however, your Low and High durations will be adjusted 

proportionately (4 days and 12 days respectively. The same logic is used if you adjust the 

original fixed costs, work, income, lag, and start times. 

• Low, most likely, and high duration and costs are stored in Microsoft Project: duration1, 

duration2, duration3… Statistical distributions are stored in text fields in Microsoft Project. 

You must map the duration, cost, and text fields in Microsoft Project to low, most likely, and 

high duration or cost in RiskyProject using Field Mapping settings. 

• Some features of Microsoft Project are not supported in RiskyProject. For more information, 

see Frequently Asked Questions. 

• You can make changes to the schedule in RiskyProject. However, RiskyProject does not write 

these changes, such as task duration or task name, back to the Microsoft Project schedule. 

Therefore, we recommend that you do not to make any changes to original schedule in 

RiskyProject. Use RiskyProject to add risks, uncertainties and other risk related information. 

• If you want to transfer the original schedule updated in RiskyProject or results of 

probabilistic analysis to Microsoft Project, use File > Launch > Microsoft Project. Please 

note that RiskyProject is using Microsoft Project XML format. Some scheduling data may not 

be transferred due to limitations of the XML format. 

 

Using Microsoft Project Add-In 

Using the RiskyProject Add-In, you can quickly add Low and High estimates for Cost and 

Schedule directly to your Microsoft Project file, run the simulation, and view the results of the 

analysis. 

 

 

 

 

Setting up the Add-In options 

You can set up your Monte Carlo calculation, chart, and field mapping options using the Add-In. 

• Calculation options include the maximum number of iterations and convergence 

monitoring and more. To read more about calculation options, read Setting up calculation 

options. 

• Field mappings allow you to modify the default fields where the distributions for duration 

and cost are saved. To read more about the mapping, read Mapping custom fields in 

Microsoft Project to low/most likely/high duration/cost/income/distribution fields in 

RiskyProject 

Define 
distributions 

Run 
Monte 
Carlo 

View results 
for selected 
tasks 

View results 
and 
generate  
reports 

Settings 

Diagnostics of 
project schedule, 
created in 
Microsoft Project 
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Adding Low, Most Likely, and High Duration or Cost in Microsoft Project 

1. Select one or more activities. 

2. Click the RiskyProject 7 tab. On the Input Distributions group, click Duration or Cost. 

The Statistical Distribution dialog box opens. 

3. Enter in the Low and High estimates using coefficients or fixed values (single activity). 

4. Select a distribution and modify any parameters required by the distribution. The “Most 

likely” estimate is available for Triangular and BetaPert.  

5. Click OK. 

 

 

To clean edits made to distributions: 

1. Select the task or tasks in which you want to remove the distributions. 

2. Click the RiskyProject tab.  

3. On the Input Distributions group, click Clean. 

Run a Monte Carlo simulation using the Microsoft Project Add-In 

Once you have defined the low, most likely, and high estimates and distributions to your 

activities, you can run a simulation. 

To run a Monte Carlo simulation: 

1. Click the RiskyProject tab.  

2. On the Input Distributions group, click Calculate. A progress bar will open and indicating 

the number of iterations that have been completed.  

Click to open dialog 
box to add 
distributions for 
duration or cost 

Run Monte Carlo 

For multiple tasks 
enter coefficients for 
Low and High 
estimates and select 
a distribution 

View results and 
generate reports 
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3. When the simulations are completed the Project Information report opens, which contains a 

project summary of the results of the simulation. 

 

View the results of the simulation for a task 

You can quickly view either histograms or tornado charts for a task. Only one task can be 

selected. 

To view a histogram or tornado chart for a single task: 

1. Click the RiskyProject tab. On the Task Results group, click Histograms or Tornado. The 

Task Simulation Results report opens. To read more about these reports, see  

2. Viewing Task Simulation Results. 

3. Double- click on any of the reports to open a detailed view of the results. 

Create a statistics report 

You can automatically generate a report that includes a histogram, cumulative probability, and 

sensitivity analysis for one or multiple activities using the Statistics Report. To read more about 

the Statistics Report, see Statistics Report for Quantitative Analysis. 

To create report: 

1. Run a simulation. 

2. On the Task Results group, click Statistics Reports. The Statistics Report view opens. 

3. Select the activities that you want to include in the report. 

4. From the File menu, click Print to open the Print Options dialog box.  
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Running Diagnostics of Microsoft Project Schedule 

Diagnostics of Microsoft Project Schedule checks the schedule for logical errors as well as to 

uncover possible corruptions. Corrupted project schedules often cannot be imported to 

RiskyProject. To run project schedule diagnostics, click on Check Schedule button.  

 

Diagnostics in Microsoft Project is a subset of schedule diagnostics in RiskyProject. It only 

indentifies a few most important errors and does not execute DCMA 14 point schedule inspection 

 

 

About installing the RiskyProject/Microsoft Project integrated solution 

During installation, RiskyProject checks if you have Microsoft Project 2010 or later installed. 

RiskyProject is not integrated with earlier versions of Microsoft Project using the toolbar. For 

early versions of Microsoft Project, you must use one of the formats generated by Microsoft 

Project (XML, or MPX). 

Before you install the toolbar or ribbon, close all instances of Microsoft Project. RiskyProject 

adds the toolbar/macro or ribbon to the last installed version of Microsoft Project. 

Information about RiskyProject’s ribbon is saved in the system registry. RiskyProject will update 

these registry settings each time it is launched. 

You may also install the integration after RiskyProject is open. Click the Tools tab.  In the 

RiskyProject Configuration group, click Install Integration with Microsoft Project to install 

RiskyProject toolbar/macro or ribbon in Microsoft Project. 

 

• You must be an administrator to perform the installation. 

• Your system must have Microsoft .NET framework 2.0 or later installed in order to 

install RiskyProject for Project. If Microsoft .NET framework 2.0 is not installed, the 

RiskyProject installer will prompt you to download it from the Microsoft web site and 

install it on your system. 

 

Mapping custom fields in Microsoft Project to low/most likely/high 
duration/cost/income/distribution fields in RiskyProject 

You can use duration or cost fields in Microsoft Project or in any other software that uses 

Microsoft Project XML schema: duration1, duration2, duration3 … to define low and high 

duration in RiskyProject.  You can also use duration1, duration2, duration3… fields in Microsoft 

Project to define low and high remaining duration for partially completed tasks.  

You can use cost1, cost2, cost3, … fields in Microsoft Project to define low, base, and high cost 

and income. Text fields are used to save statistical distribution. 

If you previously used Risk+, you may map these fields duration and cost fields the same way as 

it was done in Risk+. This way you will be able to migrate data related to uncertainties in 

Microsoft Project from Risk+ to RiskyProject. 
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To use these fields, you must map them to the corresponding fields in before you import the 

schedule into RiskyProject. This includes if you are using the RiskyProject toolbar or ribbon in 

Microsoft Project. The default settings are shown below: 

 

To map Microsoft Project fields: 

1. On the RiskyProject Microsoft Project add-in click Field Mapping or in RiskyProject, click 

File and then choose Import > Map Microsoft Project Fields…. 

2. Select the Microsoft Project field associated with low/most likely/high duration, cost, and 

income in RiskyProject.  

3. Select if you wish to map remaining duration fields as original duration fields. If remaining 

duration fields are mapped to the same fields as original duration fields and percent complete 

> 0, low and high duration fields in Microsoft Project are used for low and high remaining 

duration in RiskyProject. For example, both original duration and remaining duration are 

mapped to the same fields: 

Microsoft Project XML RiskyProject 

Mapping: 

Duration1 -> Low Duration = Low Remaining Duration 

Duration3 -> High Duration = High Remaining Duration 

Scenario 1: % complete = 0% 

Duration1 = 3 days Duration Low = 3 days, Low Remaining Duration = 0 

Duration = 5 days Duration = 5 days, Remaining Duration = 0 

Duration2 = 7 days Duration High = 3 days, High Remaining Duration = 0 

Scenario 2: % complete = 50% 
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Duration1 = 2 days Duration Low = 5 days, Low Remaining Duration = 2 

Duration = 5 days Duration = 5 days, Remaining Duration = 2.5 days 

Duration2 = 4 days Duration High = 5 days, High Remaining Duration = 4 

For remaining duration, you cannot define Most Likely value, only base value will be used 

for analysis. 

4. If you do not want to import from Microsoft Project cost data, resources, cost fields, 

deadlines, and notes, select appropriate check boxes. It accelerates calculation. 

5. If you have cost resources, you may wish to convert cost associated with these resources to 

the fixed cost during import. You can apply statistical distributions to the fixed cost but 

cannot do it with cost resources. If you select check box Convert cost from cost resources 

to fixed cost, in RiskyProject cost resource will remain the same as in Microsoft Project, but 

cost defined in resource assignments will be equal zero. 

6. Click OK. 

Once you define mappings, it will stay in the system registry for all projects transferred from 

Microsoft Project to RiskyProject. 

 

• These mappings can be used for other scheduling applications that use Microsoft Project’s 

XML format, including Oracle’s Primavera. Please note: base fixed cost in Primavera may be 

saved as Cost1 in XML file. RiskyProject also supports XER file import for Oracle’s Primavera. 

• If remaining duration fields are mapped to the same as original duration fields and you 

changed % complete in Microsoft Project, you must redefine statistical distribution for 

duration or update values in duration fields for Microsoft Project. 

 

Advanced Mapping Options 

 

Using advanced mapping options, you may “relax” some constraints in your Microsoft Project 

schedule while it is imported into RiskyProject. You can also define the location of the temporary 

file used to import results to RiskyProject.  

 

You must define a temporary file location if the original  project schedule  has been read directly into 

Microsoft Project from Microsoft Project Server. 

 

To define advanced settings: 

1. Open the Mapping Fields in Microsoft Project and click Advanced Mapping. The 

Advance Mapping dialog box opens. 

2. Select the constraints in the original project schedule you want to modify during import. 

3. If your Microsoft Project schedule has elapsed duration, define the prefix for elapsed 

duration. In the English version, the prefix is ‘e’ (with space), e.g. ‘5 edays’. However, in 

other languages, this prefix may be different. 

4. Select the temporary file location for the RiskyProject Add-in in Microsoft Project. 
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5. Click OK.  

 

 

 

Format of distribution definition text field for RiskyProject/Microsoft Project  

If you define distribution in Microsoft Project, it will be saved in one of the text fields.  Actual 

text field is defined in the process of mapping (see “Mapping custom fields in Microsoft Project 

to low/high duration/cost/income/distribution fields in RiskyProject”). Default fields are Text11 

for duration and Text12 for cost distributions. The information will look like: 

1^240^480^720^1209886208^0^5^2^12.88^3 

Symbol ‘^’ is a separator 

The table below outlines all parameters for the distribution string 

Parameter Description Comments 

1 Unique Task ID If Unique Task ID is zero, the same distribution is defined for the group of 
tasks 

2 Low Duration or Cost Duration is in hours 

3 Base Duration or Cost Duration is in hours 

4 High Duration or Cost Duration is in hours 

5 Seed Seed ranges from 0 to 2,147,483,648 

6 Meaning of Low and High 
duration and cost 

Used for normal and lognormal distribution only: 

0: use standard deviation parameter instead of low and high values 

1: low and high values are P1/P99 

The constraint define in 
Microsoft Project will be 
“relaxed” in RiskyProject  
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2: low and high values are P5/P95 

3: low and high values are P10/P90  

For other distributions this parameter is ignored 

7 Distribution Type ID Uniform, Normal, Lognormal, etc. (See next table) 

8 Number of distribution 
parameters 

Must greater or equal zero, for example for uniform distribution number of 
parameters equals zero. For custom distributions, number of parameters 
equals number of point multiplied by 2. 

9 …. Distribution Parameters Set of values which depends on the particular distribution (see next table) 

 

Distribution types and parameters are shown in the next table 

Distribution 
Type ID 

Distribution Parameters Comments 

0 Undefined  No distribution (on uncertainties) 

1 Uniform   

2 Triangular Most likely parameter   

3 Normal Standard deviation 
parameter 

 

4 Lognormal Mean and standard 
deviation parameter 

 

5 Beta Alpha and beta 
parameters 

 

6 BetaPert Most likely parameter This is a modification of traditional BetaPert distribution 
which behaves differently if most likely value close to low 
or high values. 

7 Gamma Alpha and beta 
parameters 

 

8 Exponential  Mean parameter  

9 Laplace One parameter  

10 Cauchy  Shape parameter  

11 Gumbel Two share parameters  

12 Rayleigh Standard Deviation 
parameter 

 

13 Discrete Set of intervals with 
probabilities 

Pair of parameters defining current internal. Number of 
parameters equals number of intervals multiplied by two. 

14 Custom Set of points with 
probabilities 

Pair of parameter defining points. Number of parameters 
equals number of point multiplied by two. 
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XER File Import Settings 

Mapping user defined fields in XER files to RiskyProject fields  

If you are importing an Oracle Primavera *.xer file, you can use user defined fields to import low, 

most likely, and high estimates for duration and cost by mapping these fields to corresponding 

fields in RiskyProject.  To map user defined fields, you would need to choose an XER file to use 

as a mapping template.  

To map user defined fields in XER: 

1. In RiskyProject, click File and then choose Import > XER File Import Settings…. 

2. Click Browse to select a XER file to be used as a template. RiskyProject reads user defined 

fields in the file. 

3. Select the user defined field associated with low, most likely, and high duration and/or cost. 

4. Select units for the duration fields 

5. Click OK. Once you define mappings, the mappings are saved in the system registry.  If you 

import a file that uses different fields for duration and/or cost, you must update the XER 

mappings. 

 

You must use number (not text) user defined fields in Oracle Primavera to enter low, most likely 

duration and cost.  

 

XER File Encoding 

XER files do not include any information about what is being used to encode the files. If the file 

you are importing does not use standard encoding (for example, it uses Russian instead of 

English), then the characters may not display correctly when you import the file. You need to 

define encoding before you import XER file. 

To define encoding: 

1. In RiskyProject, click File and then choose Import > XER File Import Settings …. 

2. Select XER file encoding: ANSI, UTF-8, or UTF-16LE 

3. Click OK. Encoding will be saved in the system registry. 
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Setting up your projects 

Setting up your project defaults 

Project defaults are global project settings. There are two types of defaults: 

• Project Options – These options are applicable to a particular project and are saved in 

the project file. You define project options on the Schedule tab, Settings group, Options. 

• Global Options - These project defaults are applied to all new projects and are saved in 

the system registry. Global options include default risk properties, default risk outcomes, 

and default values of project options. You save global options clicking on Set as default 

in the tabs that support defaults in the Options, Risk Outcome, and Risk Properties dialog 

boxes. 

The Options dialog box includes seven tabs. Use the: 

• View tab to setup general project parameters and the appearance of the RiskyProject 

desktop  

• Duration tab to define the calculation of task durations 

• Calendar tab is responsible for the calculation of the project schedule 

• Units tab defines how time units are displayed or input 

• Calculation tab to set up default calculation parameters 

• Cost tab is responsible for default cost parameters and calculation 

• Risk tab defines default risks for the Global and Local risks. 

Setting up viewing defaults 

Use the View tab to set up general project parameters and modify the appearance of the 

RiskyProject workspace. 

1. Click the Schedule tab. In the Settings group, click Options. 

2. Click the View tab. 

3. Enter the default project information (i.e., Project Manager) in the text boxes. You can view 

them in the Project Results view and Main Project Settings dialog box next time you create 

new project. The Project Manager box is also used as a default value for risk properties: 

recorder, owner, and contact. 

4. Select the project view that will appear whenever RiskyProject is opened from the Default 

View list. “***LAST VIEW***” will automatically load the most recently open 

RiskyProject session. 

5. Select or clear the Show or hide startup view check boxes to enable or disable the workflow 

bar, legends, and splash screens. 

6. Use Restore Default Column Layout and Set Default Column Layout to restore and save 

column sequences and widths for all views. 

 

All viewing defaults are global, so they are applied to all new projects created on this computer. 
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Setting up duration defaults 

Use the Duration tab to define the calculation of task durations. 

1. Click the Schedule tab. In the Settings group, click Options. 

2. Click the Duration tab. 

3. Select the time units that you will use to enter Duration and Work. Duration and Work can be 

entered in minutes, hours, days, weeks, and months. 

4. Define default value for effort driven flag for new tasks. 

5. Select how low and high durations will be calculated:  

• Absolute values can be added (subtracted) to the Base Duration. 

• High and low durations are calculated by multiplying the Base duration with a 

coefficient. You must enter the coefficients. 

• Internally all calculations in RiskyProject are in hours. The units you select are only for 

data entry and display.  

• By default, Low, Base, and High durations are the same. This is important as 

RiskyProject recommends that you use Risks to calculate task durations rather than a 

range of uncertainty.  

• Low and High can represent a different uncertainty range depending upon the distribution 

that you apply. For uniform and triangular distributions, Low and High represent the 

minimum and maximum duration. For normal and lognormal distributions, the range 

can be P1/P99, P5/P95, or P10/P90, which you define in the Distribution tab of the Task 

Information dialog for each particular task.  

Setting up calendar defaults 

In the Calendar tab, you set up the default calculations for project schedules. Actual project 

calendars are set up in the Working Time dialog box. The specific calendars and type 

(Deterministic or Probabilistic)  are set up in the Main Project Settings. 

1. Click the Schedule tab. In the Settings group, click Options. 

2. Click the Calendar tab. 

3. Enter in the daily, weekly, and monthly translation values in the fields provided. 

4. Select the date format in the Output Date Format box. 

5. Enter a default start date for tasks in the New Task box. New tasks can be started on current 

date or default start date. Default start date is defined in Schedule tab > Project Settings > 

Project Start Time. If new task supposes to start on current date and different date is defined 

in Project Start Time of Main Project Settings dialog, new task will be constrained Start not 

early than. 

6. Use the Show Deadlines and Show Resources on the Gantt chart check boxes to modify 

what you want to view on the Gantt chart. 

 

Input date format is always MM/DD/YY. For example, if task start time or finish time is December 

31, 2010, you should enter it as 12/31/10 
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Setting up project units 

You define how time units are entered and displayed in the Units tab. 

1. Click the Schedule tab. In the Settings group, click Options. 

2. Click the Units tab. 

3. Select the labels that you want to use for each time unit. These labels will be used for entering 

rates or for results. However, they are not used for entering duration. Duration units are 

defined in the Duration tab 

4. Select the Add space before label check box to add a space between the data and label. For 

example: 5 days vs. 5days 

5. Click the Set as Default button to set these as the default project settings 

Setting up calculation options 

Setting up calculation defaults 

You define default calculation parameters in the Calculation tab. 

1. Click the Schedule tab. In the Settings group, click Options. 

2. Click the Units tab. 

3. Select the default calculation option from the Default Calculation for Projects. 

4. Enter the maximum number of simulations that will be run in the Maximum number of 

simulations box. 

5. Enter the convergence parameters in the boxes provided. Simulations can be stopped when 

the convergence criteria are met. 

6. Select the meaning of low and high results. For example, if you check P10 and P90 it will 

mean that low start time result of the simulations is actually in the 10th percentile of the 

distribution. You can choose a specific percentile for Low and High results. For example, P30 

will be associated with low results and P70 will be associated with High results.  

7. Select Critical Path Calculation to view critical path and analyze critical path metrics, such 

as Late Start and Late Finish, Free Slack, Total Slack, and Criticality Index. Enabling Critical 

Path Calculation will slow down Monte Carlo simulations.  

8. Define minimum sensitivity coefficient for sensitivity view. If a sensitivity coefficient is less 

than the defined value, it will appear as zero in the sensitivity view. For example, minimum 

sensitivity coefficient is 0.16. A sensitivity coefficient for a particular task’s duration and 

project duration equals 0.1. Sensitivity coefficient for this task will be set to zero and this task 

will not be ranked in the sensitivity view.  

Defining the maximum number of simulations 

Based on our experience with real project schedules, the results converge normally between 400 

and 700 simulations. However, in projects where there are risks with a very small change of 

occurrence, the number of simulations should be increased. For example, if there is risk with 

chance of occurrence of 0.1%, the number of simulations should be at least 1200. The maximum 

number of simulations is 30000. 
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• The number of tasks and number of simulations define small projects. RiskyProject 

automatically adjusts the definition of a small project based on your computer’s performance. 

• If Monte Carlo simulations are not performed automatically, you can perform them at any 

time by clicking the Calculate button on the ribbon. 

 

Setting up cost defaults 

You define fixed cost defaults in the Cost tab. When you create tasks, RiskyProject uses these 

parameters for tasks (fixed costs) and resources (variable costs). 

1. Click the Schedule tab. In the Settings group, click Options. 

2. Click the Cost tab. 

3. Enter in the scalar factors used to calculate default low and high fixed costs 

4. Enter in the default rate for variable costs in the Variable Cost box. This is used when new 

work or material resources are created 

5. If you want RiskyProject to calculate actual cost and income based on percent for work done 

(tracking information), click the Actual costs are always calculated by RiskyProject check 

box. Otherwise, you can manually enter actual data in Cost and Income view.  

6. Select the Currency symbol and format for any field with currency. 

7. Enter default type of cost and income accrual. Cost and income accrual can be at the start of 

the task, or at the end of the task and prorated.  

8. Enter Default Discount rate for NPV calculation. This discount rate is used in Cash Flow 

view. 

 

• If you define a distribution for cost using low, base, and high values and assign a risk for cost 

to the same task, this may cause a double count of the same risk factors. 

• You can use any currency symbols, except for numbers, commas, and periods. 

• You must define the particular unit for the default rate e.g. “hr” in the Units tab of the 

Options dialog box. By default, this unit is hours. 

 

Setting up risk defaults 

You define defaults for Global and Local risks in the Risks tab. When you create a new risk, 

RiskyProject uses these parameters as the default values. 

1. From the ribbon’s Schedule tab, choose Options. 

2. Click the Risk tab. 

3. Enter the default settings for the chance of: 

• Default chance of risk occurrence 

• Default type of outcome 
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• Default outcome 

The result of outcomes is used to calculate outcomes for Relative Delay and Cost or Income 

Increase, as well as all user defined risk outcomes for non-schedule risks. 

4. Select the default distribution for the moment of risk. This distribution is used to define when 

risk would occur during the course of project. It is defined by distribution type (uniform or 

triangular), and three parameters defining start, most likely, and finish time of risk occurrence 

expressed as a percent of total task duration starting from the beginning of the task. For 

example: 

• Distribution: Triangular 

• Start: 50% 

• Most likely:80% 

• End: 100%   

In the above case, the default for new task with duration 10 days risk would occur after 5th 

day, but most likely would occur on 8th day.  

5. Select the risk chance option. The chance can be defined per task (by default) or per duration 

unit. For example, 30% chance that task can be restarted per day. If task duration is 2 days, 

chance of risk occurrence per task will be 60%. This option works for all projects. You 

cannot have different risks with chance applied to the duration unit or chance applied to the 

complete task for the same project at the same time.  

5. Enable or disable automatic generation of Risk ID and define rules for automatic generation 

of risk ID. For more information about risk ID generation, read Risk ID settings. 

6. Define correlation of risk assignment . One risk can be assigned to different tasks or 

resources: 

 

Alternatively, the risk can be assigned globally (to all tasks or resources). These risk events 

may occur at the same time (risk assignments are correlated) on in different times (risk 

assignments are not correlated). If check box Risk assignments to different tasks are 

correlated is checked, all local and global assignments of the same risk will be correlated by 

default. You can always change correlation of local risk assignment: 

• Go to the Risk Assignment view or Task Information/Resource Information dialog 

boxes. 

• Double-click on risk assignment ID 

• Go to correlation tab 

For more information click on What is it? button 

7. Enable or disable statistical distribution for risk outcomes. For more information about 

statistical distribution of risk outcomes, read Uncertainties in Risk Outcomes or click on 

What is it? button. 

8. Update Risk Status when risk probability/impact are changed. If you change risk probability 

and impact, new record will be added to Risk Status View for the specific risk. 
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Setting up Calendars 

About Calendars in RiskyProject 

There are four types of calendars in RiskyProject: base calendars, project calendars, resource 

calendars, and task calendars. They are used to determine resource availability, resource 

scheduling, and task scheduling. Project calendars and task calendars are used to schedule tasks, 

and if resources are assigned to tasks, resource calendars are used as well. 

You can modify these calendars to define the working days and hours for the whole project, for 

groups of resources, for individual resources, and for tasks. These calendars are distinct from the 

Calendar view, which shows the project schedule in a calendar format.  

Base calendars 

A base calendar is used as a template that the project calendar, resource calendars, or task 

calendars are based on. It defines the standard working and nonworking times for the project. It 

specifies the work hours for each workday, the workdays for each week, and any exceptions, such 

as holidays. You can select a base calendar to use as the project calendar or as the basis for a 

resource calendar. You can also apply a base calendar to specific tasks. 

RiskyProject has five default base calendars: 

• Standard: The Standard base calendar reflects a traditional work schedule: Monday 

through Friday, 8:00 A.M. to 5:00 P.M., with an hour off for break.  

• 24 Hours: The 24 Hours base calendar reflects a schedule with no nonworking time. The 

24 Hours calendar can be used to schedule resources and tasks for different shifts around 

the clock, or to schedule equipment resources continuously.  

• Night Shift: The Night Shift base calendar reflects a graveyard shift schedule of Monday 

night through Saturday morning, 11:00 P.M. to 8:00 A.M., with an hour off for break. 

• Morning Off: The Morning Off base calendar reflects a schedule Monday through 

Friday, 1:00 P.M. to 5:00 P.M., without breaks. 

• Afternoon Off: The Afternoon Off base calendar reflects a schedule Monday through 

Friday, 8:00 A.M. to 12:00 P.M., without breaks. 

You can also create your own base calendar, which is useful if you have alternative schedules for 

multiple resources. For example, you might have resources working part-time, 12-hour shifts, or 

on weekends. 

Creating or modifying a base calendar 

Base calendars can be created or modified in the Working Time dialog (ribbon’s Schedule tab, 

schedule and calendar pane): 

1.  Click the Schedule tab. In the Schedule and Calendars group, click Working Time. 

2. Click the New button to create a new base calendar, the Delete button to remove base 

calendar, or the Rename button to rename base calendar 

3. Use the Working Time calendar options to modify the selected base calendar. Choose 

Working Time from Schedule tab. 

Project calendars 

The project calendar defines the working and nonworking days and times for tasks. This calendar 

usually represents your organization’s traditional working hours. RiskyProject uses this calendar 
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to schedule tasks that do not have resources assigned. By default, the Standard base calendar is 

used as the project calendar, but you can reflect alternative schedules by using other base 

calendars. 

The working days and hours in the project calendar reflect the working days and hours for your 

whole project. You can specify special days off, such as company holidays. 

Project calendar can be deterministic and probabilistic. Probabilistic calendars are useful for 

modeling uncertain scheduling conditions such as weather. Both deterministic and probabilistic 

project calendars can be selected from the list of available calendars in the Project Settings dialog 

(Schedule tab).  

Resource calendars 

Resource calendars make sure that work resources (people and equipment) are scheduled only 

when they are available for work. They affect a specific resource or category of resources. By 

default, the working time settings in the resource calendar match the project calendar. However, 

you can customize the resource calendar to show individual schedule information, such as 

vacations, leaves of absence, or equipment maintenance time. 

When you create a resource, the default resource calendar will be created. You can view this 

resource calendar in the Working Time dialog box. By choosing Working Time from the 

Schedule tab, you can edit resource calendars to indicate nonworking time. You can also create 

or assign different base calendars for individual resources to indicate specific working hours. For 

example, you can assign a resource to a calendar that you created for carpenters who may be 

working during a time that is different from other workers. You can edit Base calendars for each 

resource in the Working Time dialog box. 

When RiskyProject schedules the project, it uses the resource calendar to schedule the tasks that 

have resources assigned. For example, if a resource has a week of vacation specified on his or her 

resource calendar, RiskyProject will not schedule the task for that week. 

 If you have resources that work alternative schedules, such as part-time or the night shift, we 

recommend that you set up and apply a separate base calendar for each shift. You should use resource 

calendars to accommodate exceptions to an individual resource’s working times.

 

Task calendars 

Task calendars make it possible to schedule tasks during nonworking time, as defined by the 

project calendar or resource calendar. For example, you can set up a task calendar if you have a 

task that needs to be worked on overnight or through the weekend. 

You create a task calendar in the Working Time dialog box as a new base calendar. You can 

then apply the base calendar to a task by using the Advanced tab in the Task Information dialog 

box.  

If you have applied a task calendar to a task that already has assigned resources, by default, the 

task is scheduled for the working times of resource calendars. If you want to schedule the task by 

using only the task calendar, select the Ignore Resource Calendars check box on the Advanced 

tab in the Task Information dialog box. 
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Defining working time 

RiskyProject allows you to define multiple calendars. All calculations are done internally in hours 

and minutes. 

1. Click the Schedule tab. In the Schedule and Calendars group, click Working Time. 

2. Select a calendar from the Calendar list. There are five calendars provided: 

• Standard  

• Morning Off  

• Afternoon Off  

• 24 hours  

• Night Shift 

3. If you need to modify the selected calendar, click on a day in the calendar. The working and 

nonworking time is displayed in the schedule on the right. You can define working for 

specific weekday. To do it just click on weekday and modify working times for the weekday. 

You may also specify working time for the specific day. To do it just click on specific day 

and modify working times.  

4. Click on an hourly period to set it as working or nonworking time. White is working, pink is 

nonworking. 

5. Once you have completed the calendar, click OK to save the changes. 

Creating a new calendar 

You can create a new calendar and save it under a new name. 

1. Click the Schedule tab. In the Schedule and Calendars group, click Working Time. 

2. Click the New button. The New Calendar dialog box opens. 

3. Provide a name for the calendar and description. 

4. Select the base calendar from the Based on drop-down list. 

5. Click OK. 

6. Modify the new calendar as needed. 

7. Click OK to save the new calendar. 

Renaming a calendar 

You can rename calendars that you have created.  

1. Click the Schedule tab. In the Schedule and Calendars group, click Working Time. 

2. Select the calendar that you want to rename from the Calendar drop-down list. 

3. Click the Rename button. The Rename Calendar dialog box opens. 

4. Type in a new calendar name. 

5. Type in a note for this calendar (optional) 

6. Click OK. 
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When you use any calendar other than the Standard, ensure that you properly translate the 

duration through the project. To define hours per day, hours per week, and days per month go 

to Tools > Options and select Calendar tab.  

 

Deleting a calendar 

You can delete calendars that you have created.  

1. Click the Schedule tab. In the Schedule and Calendars group, click Working Time. 

2. Select the calendar that you want to delete from the Calendar drop-down list. 

3. Click the Delete button.  

 

• You cannot delete the Standard, Morning Off, Afternoon Off , and 24 hours, Night Shift 

calendars. All other base calendars can be deleted as long as they are not used for resource, 

task, and project calendars. 

• Resource calendar will be deleted automatically, when you delete the resource and this 

calendar is not used for other resources. 

 

Probabilistic Calendars 

You can create a probabilistic calendar. Probabilistic calendars will be used only for Monte Carlo 

simulations. The current project schedule will use the project calendar. 

Probabilistic calendars are a set of base calendars with their respective probabilities.  

Defining probabilistic calendars 

1. Click the Schedule tab. In the Schedule and Calendars group, click Working Time. 

2. Define base calendars that will be used for your probabilistic calendar. For example, if you 

would like to model that March will be 50% non-working, you need to create a base calendar 

entitled “March non-working”. 

3. Click the Schedule tab. In the Settings group, click Project Settings. 

4. Enter probabilities for each base calendar. For the example above, enter 50% probability for 

the standard calendar and 50% probability for “March non-working”. The sum of all 

probabilities must be exactly 100%. 

Calculations with probabilistic calendars are performed according to the following rules: 

• If a resource calendar is used, base calendar for resources would use a probabilistic 

calendar. For example, you have a resource Crew that has a non-working exception for 

February 18 on the standard calendar. This exception will be applied to the standard 

calendar 50% of the time and to the “March non-working” another 50% of the time. 

• If the task calendar is defined, the probabilistic calendar will be ignored and the task 

calendar will be used. 
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• If there is no task calendar or resource calendar defined, the probabilistic calendar will be 

used.  

Weather Calendars 

Weather calendar is a type of probabilistic calendar, which defines the number of non-working 

days per month. In each day, you can define low, base, and high estimates for non-working dates. 

The particular number of non-working dates is calculated for each simulation. For example, let us 

say you define that in March there will be between 5 to 10 non-working days.  On the first 

iteration on Monte Carlo simulations, it will be 7 non-working days, and on the second iteration, 

it will be 6 non-working days, etc. 

Defining weather calendar 

1. Click the Schedule tab. In the Schedule and Calendars group, click Working Time. 

2. Select Calendar from the dropdown list, which will become the weather calendar. 

3. Click on the check box This is a weather calendar. 

4. Click on Settings. The Weather Calendar Settings dialog opens. 

5. In the Settings dialog, define the number of non-working days each month. 

6. Select statistical distribution for the number of working days per month. It can be either 

uniform or triangular. 

7. Select the year during which non-working days will occur. It can be a specific year, for 

example, year 2018, or a general number of non-working days that will occur every year. 

8. Update the seed, if required. Using the seed, you can correlate different weather calendars, 

for example, if they are to be assigned to different tasks or resources. 

9. Click OK on the Weather Calendar Settings dialog. 

10. Use the slider in the Working Time dialog to see how many non-working days are generated 

on the first 25 iterations of Monte Carlo simulations. This will help you confirm that you 

have correctly entered information about non-working days. 

 

The number of non-working days defined in the Weather Calendar Settings dialog can overlap with 

regular non-working days, such as Saturdays and Sundays, in the Standard calendar.
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Creating Projects 

Creating a new project 

The original view for a new document is defined in the Options, View tab. The default view can 

be the last view in the previous RiskyProject session. 

1. Click File and then New. The new project file opens. 

2. To save the project click the Save button and type in a project name. 

 

In addition to project files created in RiskyProject, you can also open files that have been saved 

as a Microsoft Project XML and Oracle Primavera XER format. Microsoft Project XML  is the 

industry standard for project management software and is supported by Microsoft Project, 

Oracle Primavera, and many other project management software applications.  

 

Importing existing project schedules 

You can import existing project schedules from Microsoft Project, Primavera and other project 

management tools using a variety of file formats.   

Importing Microsoft Project files 

You can import MS Project files using XML format.  

1. Click File and then Open. The Open File dialog box opens. 

2. Select the format that the project file is in from the Files of type drop-down list. 

3. Select the MS Project file format that you just saved. 

4. Click OK.  

 

You can use the RiskyProject toolbar or ribbon in Microsoft Project to transfer your schedule from 

Microsoft Project to RiskyProject. When you use the RiskyProject toolbar or ribbon, your schedule in 

Microsoft Project will be associated with risks and uncertainties defined in RiskyProject. Please read 

“RiskyProject for Microsoft Project” for more information. 

 

Importing data from other project management software 

RiskyProject can import data from other project management software in Microsoft Project XML 

and Oracle Primavera XER file formats. 

1. Click File and then Open.  

2. Select the XML or XER project schedule. 

 

Due to the specific features of each application and the probabilistic nature of RiskyProject data, in 

very rare cases there may be discrepancies between the original project schedule and the imported 
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schedule in RiskyProject.

 

Importing data from other project management software and retaining risk 
assignments 

Sometimes you may want to import a project schedule from Microsoft Project or other software 

and retain existing risk assignments. It can be useful when you have imported a project schedule 

from Microsoft Project or other software, assigned risks in RiskyProject, and then updated the 

project schedule in Microsoft Project.  

1. Click File and then Import. 

2. Select the format type of your project data (XML or XER). 

3. Select whether or not you want to import the risks already assigned to the project.  

 

RiskyProject will associate assigned risks with new tasks based on unique task IDs. Unique IDs do not 

change when you insert or delete tasks. You can rename the task in Microsoft Project, but risks will be 

assigned to the proper task and resource based on this unique ID.

 

Importing risks and uncertainties from different RiskyProject file 

You can import risks and uncertainties from a different RiskyProject file and assign them to tasks 

and resources in the current schedule.  

1. Click File and then Risks from Another Project. 

2. Select the RiskyProject file (alm extension) with risks and uncertainties. 

 

If the schedule originated in Microsoft Project, the risks will be assigned to the correct task and 

resource using the unique ID. Unique IDs do not change when you insert or delete tasks. If you 

created the schedule in the RiskyProject the risk will be assigned based to the tasks or resources 

based on ID shown in the task or resource data sheets. Such ID changes when you insert or delete 

tasks. 
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Project Settings 

The Project Settings are where you enter general project information, project deadlines, and set 

the project calendars. Project settings can be defined by clicking on Main Project Settings 

(Schedule tab, Settings and Options group). 

General Project Information 

General project information includes: 

• Project Name 

• Project Manager 

• Project Description 

• Company 

• Group/Division 

This information will be shown on the Project Summary view as well as on reports. The Project 

Manager name will be used as a default value for risk properties: recorder, contact, and owner. 

Default values for these parameters are defined in Tools >Options view tab. 

Project Start Time 

Project start time is entered or edited in the Main Project Settings dialog box. Project start time 

is always deterministic. You change project start date and all project schedules will shift. 

Project Status Date 

Project status date is entered or edited in the Main Project Settings dialog box. Status date is 

used to report project’s progress on this day you set. In RiskyProject project status dates is used 

for project diagnostics, particularly for the DCMA 9A, DCMA 9B, DCMA 11, DCMA 13, and 

DCMA 14 tests. 

Project Calendar 

Project calendar is used for scheduling tasks if task or resource calendars are not defined. Default 

project calendar is Standard. 

Project Deadlines 

Project Deadlines are entered or edited in the Main Project Settings dialog box. Deadlines affect 

the results of the probabilistic calculations, but do not affect the results of deterministic current 

schedule calculation. 

• Earliest Project Deadline: if any task is started or finished before this date, the task and 

the complete project will be marked as canceled for the particular iteration. Start and 

finish time of the project will be adjusted. If the finish time of the task date is before the 

earliest project deadline, the task will have zero duration and begin on the earliest project 

deadline.  

• Latest Project Deadline: if any task is started or finished after this date, the task and the 

complete project will be marked as canceled for the particular iteration. The start and 
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finish time of the project will be adjusted. If the start date of the task is after latest project 

deadline, the task will have zero duration and begin on the latest project deadline. 

• Maximum project duration:: actual project start time plus maximum project duration is 

the maximum project finish time. It affects the project schedule the same way as Latest 

Project Deadline. 

 

When any task within a project reaches the project deadline, the project will be marked as 

canceled for the particular iteration. However, task duration, start and finish times can vary 

between the different iterations due to the risks and uncertainties; therefore, tasks can reach the 

deadline in a single iteration, but not in another. RiskyProject calculates the project success rate 

based on the number of iterations where the project is successfully completed. 

Example: 

• Maximum Project Duration is 5 years 

• Actual start time is Oct 1,2003 

• Projected Finish time is Oct 1, 2009 

• Project will be canceled because Oct 1,2003 + 5 years < Oct 1,2009 

Maximum project duration is working time (not calendar time). For example, one-month 

maximum project duration is 20 working days. It is done to make maximum project duration 

consistent to duration of any task. 

 

Earliest Project Deadline and Latest Project Deadline are shown as red vertical lines on the Gantt 

chart. You cannot scroll Gantt charts beyond these dates. 

 

If the project is outside of Earliest Project Deadline and Latest Project Deadline, the Monte Carlo 

simulations will not execute. For example, 

• Actual Project Start Time:  Oct 1,2008 

• Projected Finish Time:   Oct 1,2011 

• Earliest Project Deadline: Jan 1,2008 

• Latest Project Deadline:  Jan 1,2011 

In this example, the projected the probabilistic calculation will not proceed. 

 

Entering main project information 

1. Click the Schedule tab. In the Settings group, click Main Project Settings.  

2. Define Project Start Time. 

3. Define Project Calendar. 

Earlies project 
deadline 

Latest project 
deadline 

Maximum Project Duration 
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3. Define Earliest Project Deadline, Latest Project Deadline, and Maximum project 

duration. 
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Project Tasks 

When you first start RiskyProject, the Project view opens. Start the scheduling process by adding 

tasks. Each task should have a name and a base duration. You can enter this information directly 

onto the datasheet or using the Task Information dialog box. 

Opening the Task Information dialog box 

The Task information dialog box can be used to enter task parameters (duration, start, finish 

times, assign resources to tasks, assign risks, etc.). You can open the task information dialog 

using one of the following ways: 

• Double-click on Task ID 

• Right-click on task ID and Select Task Information 

• Select Task and Click on Project > Task Information 

Entering task name and duration 

When you create a task, the first step is to enter a name and a base duration. 

1. Click on the Task Name field in the Project view.  

2. Provide a name for the task. 

3. Enter a base duration in the Base Duration field. You can enter elapsed duration. Elapsed 

task duration is calculated using a 24-month calendar. To define elapsed duration, enter ‘e’ 

before units, for example, “10 edays”. 

 

The default Start Time for tasks is defined in the Calendar tab of the Options dialog box. The start 

time can be either the current date or a project start date, defined in Project >Main Project Settings. 

You can always change start time using constraints (see Start, Finish Times and Constraints). You can 

also change other default parameters in the Options dialog box. 

 

Define task durations using the Base Duration column. Once you have added all of the tasks, you can 

add uncertainties by assigning low and high durations. See Define Distributions for Start Time, 

Cost, and Duration for more information. 
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Defining summary tasks and subtasks  

Summary tasks represent groups of tasks (subtasks) that can be logically grouped together under a 

larger task. In large projects with many tasks, this is a useful method of organizing your tasks. 

1. Create a task directly above the tasks that you want to group under it. This will become the 

Summary Task. 

2. Select the tasks that you want to be the subtasks of the summary task you created in step 1. 

3. Click the Indent button located on the Format toolbar to indent the tasks. The indented tasks 

are automatically recognized as subtasks of the summary task. If you want to move at task out 

from under the summary task, select the task and click the Outdent buttons. After you click 

on an Indent or Outdent button, RiskyProject automatically recalculates the project. 

 

 

Outline Selected Level 

You may view summary tasks associated with a particular level of the hierarchy using the Outline 

button (Schedule tab). 

Task Links 

All projects require that the WBS tasks be performed in a certain order. These relationships are 

defined in RiskyProject using the four linking buttons located on the standard toolbar. 

  

The four types of task dependencies are show in the following figure: 

 

 

If you want a next task to be a predecessor of a previous task, for example task 5 to be a 

predecessor of task 3, you will have to use Predecessors tab in Task Information dialog box. You can 

also use the Predecessors tab if you want to define lags time greater than zero. 

 

Use this buttons to 
change the level of 
the tasks 

Select tasks that you 
want to be subtasks 

Expand or collapse 
summary tasks 
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Remember the following rules: 

1. You cannot link summary 
task to one of its subtasks 

 

2. The predecessors of a 
summary task must have a 
finish-start or start-start 
dependency.  

 

3. You cannot create circular 
relationships. 

 

The connecting line between successors and predecessors will be red if there is a scheduling 

conflict:  

 

Predecessors and Lags 

You define information about predecessors and lags in the Predecessor tab of Task Information 

dialog box. 

You can use the Standard toolbar button to link tasks; however, this method of creating task 

dependencies has limitations: 

• You cannot link a task (from example Task #5) to a previous task (for example Task #3). 

• You cannot input lag, which is time delay between predecessor and successor. 

RiskyProject allows you to setup probabilistic lag with statistical distribution defined by 

low, base, high number. 

 

Sometimes it is convenient to use predecessor tab instead of link toolbar buttons when task has 

multiple predecessor or if there is a big difference in task Ids between current task and predecessor. 

For example, it is not convenient to link task number 5 to task number 74 using toolbar buttons. 

You can use Predecessor column within Project view to define or modify predecessors. Text: “1, 2+2 

days” would mean than current task has two predecessors (Task 1 and Task 2 with lag 2 days). 

 

Adding a predecessor to a task 

1. Select the task to which you want to add a predecessor. 

2. Open the Task Information dialog box.  

3. Click the Predecessor tab. 
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4. On the first row of the grid, click in the Task Name cell. A drop-down list appears containing 

a list of all available tasks or type  

5. Select the predecessor from the drop-down list. By default, the predecessor type is Finish- 

Start (FS). 

6. If required, enter a lag time. Use the Lag low and Lag high cells to enter a range of time. Lag 

can be positive or negative 

7. If you are entering a base, high and low lag, you can change the default distribution using the 

drop-down list in the distribution cell. 

• If the low and high lags are different, the default distribution is triangular.  

• If low, base, and high lag are the same the distribution is undefined. 

8. If required, edit the Seed number. Seed is the starting parameter used for the random number 

generation that is used to calculate lag. If you have two predecessors, and they have strong 

positive correlations between their lags, you can make their seeds the same. For example, a 

low lag for one predecessor will coincide with a low lag for another predecessor.  

9. Click OK. 

 

• You cannot make a task be a predecessor to itself 

• You cannot create a schedule that it will lead to a circular relationship between tasks 

• You cannot link a summary task to one of its subtasks 

• You cannot link two tasks twice. 

• You can have two predecessors (SS and FF) to the same task. 

 

Constraints  

Constraints are limitations that you set on tasks. For example, you can specify that a task must 

start on a particular date or finish no later than a particular date. In RiskyProject, you can assign 

one of seven constraints to a task: 

• As soon as possible (default) 

• Start no earlier than 

• Must start on 

• Must finish on  

• Start no later than 

• Finish no earlier than 

• Finish no later than 

Summary tasks have only “As soon as possible” and “Start no earlier than”. 

Use the General tab of Task Information dialog box to add or modify constraints. If you set a 

constraint to Start no Earlier Then, an additional edit box opens in which you set the date for this 

constraint. 

If you assign a constraint other than As Soon As Possible, the background color for low, base, 

and high Start Times or low, base and high Finish Times changes to orange to indicate that the 

constraint is other than As Soon As Possible.  
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Use constraints to ensure that the task starts or finishes on the specific dates. Use caution when 

you link tasks with a constrained start or finish time with predecessors because of the potential for 

scheduling conflicts. In this situation, to avoid scheduling conflicts, set the constraint to As Soon 

As Possible.  

Constraints affect both probabilistic and deterministic calculations. If you change the Low or 

High Start times, the constraint is set to Must Start On, similar to when you change the Base Start 

time. 

 

• When a task has a constraint other than As Soon as Possible, it may not shift due to the 

nature of Monte Carlo calculations, even if predecessors have risks and uncertainties. 

Therefore, use caution when planning to perform probabilistic calculations with constraints. 

• When you enter the actual start date of the task as part of tracking input, task would 

become constrained for the probabilistic calculation only. Start time will not change 

regardless of risks and uncertainties for predecessors. 

 

 

Adding constraints 

Before you add a constraint, you should define the task name and duration. 

1. Double- click the task to which you want to add a constraint. 

2. Click the General tab. 

3. From the Constraints drop-down list, select a constraint that you want to add to the task. 

Milestones 

You can flag a task as a milestone. If you turn on a milestone, the task bar within a Gantt chart is 

displayed as: 

 

Any task with zero duration is automatically displayed as a milestone in the Gantt chart; however, 

any task can be marked as a milestone. The milestone flag is for display only and does not affect 

the project calculations. 

If a task has no duration entered, it is automatically displayed as a milestone, and you do not have 

to complete the following steps. If you want to flag a task that has duration, complete the 

following steps. 

Creating a milestone 

1. Select the task that you want to flag as a milestone. 

A red dot indicates that the constraint is 
not set to As Soon As Possible, Must 
start on and Must finish on 

Shading constrained time (rather than 
As Soon As Possible) 
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2. Open the Task Information dialog box. 

3. Click the Advanced tab. 

4. Select the This task is a milestone check box. 

5. Click OK. 

Task Deadlines 

You define task deadlines in the Deadline Tab of Task Information dialog box.  

The Actual task deadline is defined by two factors: the maximum task duration and the task 

deadline. The Actual task deadline is a minimum of two numbers: task start time + maximum task 

duration and task deadline.  

Three different actions can occur when a task deadline hits its deadline: 

• No Actions: A red deadline arrow is displayed on the Gantt chart for all views, but it will 

not affect the calculation. 

 

• End task: The task duration is reduced, but the task is not canceled. 

• Cancel task: The task duration is reduced, and the task is canceled. 

 

• Deadlines do not affect the results of the deterministic calculation (for the current 

schedule); however, a red deadline arrow is shown on all views that include a Gantt chart. 

You can turn display of the deadline arrows on and off in RiskyProject Options (Calendar 

tab). 

• If the actual deadline occurs on a non-working time, it is moved to the nearest previous 

working time.  

• When a task reaches the deadline when it is assigned the Cancel Task option, the task is 

canceled. However, task duration, start and finish times are different on different 

iterations due to the risks and uncertainties. Therefore, the task can reach the deadline in 

one iteration and not another. RiskyProject calculates task success rate based number of 

iterations where the task has been successfully completed. Deadlines are one of the 

examples of Event Chains where events on one task (e.g., restart or delay) may cause 

another event (cancellation because deadline has been reached). 

• Example: Task deadline is October 17, 2009. At the finish of the Monte Carlo 

simulations, the finish time of the task was less than October 17, 2009, 100 times and 

greater than October 17, 2009 150 times. A “Cancel task” result was set for the task 

deadline. Task success rate will be 40%. 

 

Adding a deadline to a task 

1. Select the task to which you want to add a deadline. 

2. Open the Task Information dialog box. Click the Deadline tab. 

3. Enter in the Maximum duration in the Maximum task duration boxes. 

4. Select the time unit from the drop-down list. 
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5. Click on the Task Deadline box. A calendar opens. 

6. Select a date from the calendar. 

7. Select an action that will occur if the task reaches the deadline from the Action for 

Probabilistic Calculation option box. 

8. Click OK. 

Subprojects 

You can insert a subproject to the project as a single task with uncertainties. It can be useful when 

you have a large integrated project, which include subprojects with risks and uncertainties. You 

can calculate each subproject separately and insert these subprojects with results of Monte Carlo 

simulations to the master project.  Statistical distribution of project cost and duration will become 

custom input distribution for the task that represents subproject. This approach can significantly 

simplify schedule and accelerate Monte Carlo simulations on very large programs. 

To insert subproject to the master schedule: 

1. Open the subproject, run the simulation, and save. The subproject simulation results are saved 

to the file.  

2. Open the file that will be the master schedule. 

3. Select the row in the schedule where you want to insert the subproject. 

4. Right click on task ID and from the shortcut menu choose Insert Subproject…  

 

 

 

5. In the Open dialog box, navigate to the project you want to insert and click Open. The 

subproject will be inserted as a single task to the schedule.  

 

• Custom statistical distributions for task fixed cost and duration will be defined if subproject 

has results of Monte Carlo simulation. You can verify them in Distribution tab of task 

information dialog. Low, base, and high fixed cost and duration of this subproject task will be 

also defined based on results of simulations. 

• Start time of new task will be set based on start time of the subproject. The constraint will 

be set to “Must Start On”. You may remove this constraint and define predecessors and 

successors of this subproject. 

 

• You can insert any number of subprojects. The subproject may contain nested subprojects. 

• You can assign risk events to the subproject task. However ensure that these risks are not 

assigned in the subproject schedule. Otherwise this will cause a double count of the same 

risks. 

Right click on task ID to insert 
subproject above selected task 
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• Subprojects  start and finish must be linked to tasks in master project schedule. If internal 

tasks of a subproject are linked to master schedule tasks, you may need to split one 

subproject into on or more smaller subprojects. 

 

Refreshing Subprojects 

If you run a new simulation on a subproject, it can be updated in the master schedule. You can 

update manually, or it can be updated automatically when you open the master schedule. You can 

define the refresh mode in Advanced tab of the Task Information dialog box. Manual mode is 

the default setting. 

• Manual refresh: click the Refresh button Low, Base, High fixed cost and duration, as 

well as statistical distributions of fixed cost and duration of the subproject task will be 

updated.  

• Automatic refresh: select this to automatically update when you open the master 

project. Automatic mode will increase the time it takes to open master projects. 

 

If your subprojects contain other subprojects, only subprojects at the next lower level will be 

refreshed. To refresh nested subprojects, open each individually and refresh them.

 

For more information about refreshing subproject please see Advanced Task Management. 

Advanced Task Management 

Use the Advanced tab on the Task Information dialog box to enter, review, or change 

supplemental task information. You can: 

Specify the task type:  A characterization of a task based on which aspect of the task is fixed and 

which aspects are variable. There are three task types: Fixed Units, Fixed Work, and Fixed 

Duration. The default task type in the Project is Fixed Units. See Task Types below. 

Specify the task calendar: The base calendar that you can apply to individual tasks to control 

their scheduling, usually independent of the project calendar or any assigned resources’ calendars. 

By default, all tasks use the project calendar. You can select to ignore the resource calendar. Use 

the Working Time dialog box to modify calendars. 

Mark the task as effort-driven: In effort driven scheduling the duration of a task shortens or 

lengthens as resources are added or removed from a task, while the amount of effort necessary to 

complete a task remains unchanged. 

Change link to subproject, refresh link and define refresh mode: You can change a path to 

the subproject, which will also allow you to replace the linked subproject. You can also define the 

refresh mode: manual or automatic See Subprojects for more information.  

Task Types 

The three task types used in Project are: 

• Fixed units: Fixed unit is a fixed value and any changes to the amount of work or the 

task’s duration do not affect the task’s units. It is a default task type. 

• Fixed work: Fixed-work task is a task in which the amount of work is a fixed value and 

any changes to the task’s duration or the number of assigned units [or resources] do not 

affect the task’s work.  
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• Fixed duration: Fixed duration task is a task in which the duration is a fixed value and 

any changes to the work or the assigned units are not affected. 

Each of the task types affects scheduling when you edit one of the three elements as follows. 

Task type  Change Units  Change Duration Change Work 

Fixed units 
task  

Duration is 
recalculated.  

Work is recalculated.  Duration is 
recalculated.  

Fixed work 
task  

Duration is 
recalculated. 

 Units are recalculated.  Duration is 
recalculated.  

Fixed duration 
task  

Work is recalculated.  Work is recalculated.  Units are recalculated.  

Formatting Gantt Bars 

You can adjust the shape and color of Gantt for specific tasks or for specific types of tasks: 

standard tasks, summary tasks, critical tasks, milestones, etc. 

Formatting Gantt Bars for All Tasks 

• Click the Schedule tab. In the Settings and Options group, click Format Gantt Bar.  

Formatting Gantt Bars for Selected Tasks 

1. Select task or a group of tasks 

2. Right-click on Task ID and choose Format Bar… 
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Managing Resources and Work 

Resources are the people and equipment that are assigned or the material that is used to complete 

a task. 

Adding resources 

1. Click the Schedule tab. In the Schedule Views group, click Resources. 

2. Click on a row. 

3. Provide a Name (mandatory), Initials (optional), and Rate (mandatory). 

• You can group resources to define reams using the indent and outdent buttons. 

• Initials and notes are for information only and do not affect the calculations. 

• Rates affect the cost the task to which the resource is assigned. Rates for work resources 

can be per year, month, week, day, hour and minute. Rates for material resources are per 

unit (e.g., 10 tons).  

4. Select the resource type: Material, Cost or Work.  

• Material label indicates type of material resources (e.g., tons)  

5. Maximum units are used to calculate Overallocation of work resources. It is not used for the 

material or cost resources. 

 

• Use the Resource Information dialog box to assign resources risks. 

• You can add risks to a resource using the Risk tab of Resource Information dialog box. If you 

have only a few risks assigned to a few resources, this is the preferred method to define 

resource risks. If you have many resources, we recommend that you add the risks in the Risk 

Register of Risk workflow tab and then assign them to the resources from one of the risk 

views.  

• Default rate for resource type Work is defined in Tools > Options Cost tab. 

 

Assigning resources to tasks 

1. On the Schedule tab, in the Schedule Views group, click Project View. 

2. Select the task to which you want to assign the resource. 

3. Click in the Resource field associated with the task. 

4. Select a resource from the drop-down list. If you type in a new resource name, it will be 

added to the list of resources in the resource view. When you add a new resource in this 

manner, it will be assigned at 100% effort for work resource. 

5. Enter Cost for cost resources 

 

• Multiple resources can be assigned to a particular task. 

• Tasks do not have to have resources assigned to them.  
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Assigning a calendar to a resource 

1. By default, RiskyProject assigns the Standard calendar to resources. 

2. On the Resource view, double-click on a resource ID. 

3. Select a resource calendar from the Base Calendar drop-down list. 

4. Click the Working Time button (Schedule tab) to modify the resource calendar. 

Defining work  

You can enter tasks as work rather than duration. The Work view shows the total work of all 

resources assigned to a task. 

1. On the Schedule tab, in the Schedule Views group, click Work. 

2. Select the Task type: fixed units, fixed duration, or fixed work. The same information can 

be defined using Advanced tab of Task Information dialog box 

3. Check the Effort driven flag if the task is effort driven (default value). Effort driven task can 

be defined in the Advanced tab of Task Information dialog box. 

4. Enter low, base, and high work for the selected task. Units for work are defined in the Tools 

> Options > Duration tab. Duration and units for the task will be calculated based on task 

type. 

 

• For probabilistic calculations, work is always correlated with duration. Seed and distribution 

of the duration are used for work as well. Therefore, seed and distribution for work are not 

entered.  

• You may view work assigned to the particular resource in the Resources tab of Task 

Information dialog box. 

 

Cost Rate Tables 

Cost rate tables allow you to define rates and cost per use that change over time. For example, on 

January 1, 2011, cost was $10/hr. On February 1,2011, cost became $12/hr. For rate you may 

enter a value or a percentage of increase or decrease from the previous rate.  For instance, if a 

resource’s cost per use is reduced by 20% type -20%. 

To define cost tables: 

1.  On the Schedule tab, in the Schedule Views group, click Resources. 

2. Double-click on Resource ID. Resource information dialog opens 

3. Go to Costs tab 

4. Enter effective date, rate and cost per use for this effective date 
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Managing Costs 

Cost, Income, and Profit Calculations in RiskyProject 

You can define cost and income associated for tasks with risks and uncertainties. You can use 

income to perform an analysis of the full life cycle of a project. Profit is calculated as the 

difference between income and cost. This will affect the way that RiskyProject presents data in 

the Cost and Cash Flow views. If the project has income, all cost and cash flow, data is now 

shown as Profit where costs are a negative value. In these cases, it is possible that a project will 

have negative profit.  

The example below illustrates how fixed, and variable (resource) costs are calculated with respect 

to tasks and subtasks: 

 

 

 

The project schedule includes the summary task “Web Site Design”, the summary task “Art 

Works”, and subtasks “Selection of artwork” (2 days duration) and “Purchase of art work” (0.2 

days duration). “Selection of artwork…” has base fixed cost $200 and is assigned to the Graphic 

Artist with rate $50.00/hour. “Purchase of artwork” has a base fixed cost of $400 and is 

performed by Purchaser with a rate of $40.00/hour. The work is supervised by project manager 

with rate $80.00/hour, but only 10% his time is assigned to this project. It is assumed that a day 

has eight (8) working hours. 

 

The Fixed cost for the summary task is calculated as the sum cost of all subtasks, which do not 

have subtasks under them. Resource costs for summary tasks are calculated as cost of all 

resources assigned to summary task plus resource cost of all subtasks. 

A. Calculation of base fixed cost for summary task “Web Site Design”: 

Base fixed cost for “Selection of artwork…” (Task 3) = $200.00 

Base fixed cost for “Purchase of artwork” (Task 4) = $400.00 

Total = $600.00 
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B. Calculation of variable (resource) cost for summary task “Web Site Design”: 

Resource cost for project manager = 17.6 hours * $80/hr / 10   = $140.80 

Resource cost for Selection of artwork (Task 3) 16 hours * $50/hr = $800.00 

Resource cost for Purchase of artwork (Task 4) = 1.6 hours * 40/hr = $64.00 

Total = $1004.80 

Income is calculated similarly to cost calculation. Income cannot be assigned to the resources. 

Variable and Fixed Costs and Income 

There are two types of costs in RiskyProject:  

• Fixed costs, which are associated with tasks; and, 

• Variable costs, which are associated with resources.  

Costs associated with resources are calculated based on rate, units assigned, and work of the 

particular resource.  

Income is always fixed. You define it in the same manner as fixed costs. Both fixed cost and 

income can be accrued at the beginning of the task, at end of the task or be prorated.  

You define and verify costs and income in the Cost and Income tab (Schedule tab if the 

workflow bar) and report results within Profit Report view (Report tab). 

Cost Per Use 

Per-use costs are one-time fees for the use of a resource, such as equipment. Per-use costs never 

depend on the amount of work done. Instead, they are one-time costs that are incurred every time 

that the resource is used. Although a per-use cost for a work resource depends on the number of 

assignment units used, a per-use cost for a material resource is applied only one time. For 

example, if a bricklayer has a per-use cost of $100 (instead of an hourly rate) and it takes three 

brick layers to complete a task, the cost is $300. However, a per-use delivery cost of $100 for a 

material resource like cement is applied only once per delivery, whether 10 tons of cement are 

delivered or 100 tons. 

Adding fixed costs and income to tasks 

The Cost and Income view also shows the calculated results for fixed costs and resource costs. 

1. On the Schedule tab, click the Cost and Income view. 

1. Select the task in which you want to include fixed cost or income. 

2. Enter base fixed cost in the Cost field. You can enter in Low and High estimated costs.  

3. Select an accrual method in the Accrual column. Accrual methods indicate how cost or 

income is accrued in the task. Default accrual method if defaulted in Tools > Options, cost 

tab separately for cost and income. Accrual methods available are: 

• Start 

• Finish 

• Prorated 

4. Enter Income in the same manner as above. 

 



RiskyProject Professional User Guide 

 

109 

• You may assign fixed cost and income to the summary tasks the same way as they are 

assigned to the subtasks 

• You may define uncertainties in fixed cost and income using low, base and high values of cost 

and income, as well as seed and statistical distribution. 

• Uncertainty in variable cost is originated in task work since variable cost = resource work * 

number of units * rate. 

 

 





 

111 

Chapter 4: Quantitative Risk Analysis 
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Assigning Risks to Tasks and Resources 

Risk Assignments 

Risks must be assigned to calculate their impact.  If a risk is not assigned to any tasks or resources 

it will remain in the risk register, but probability, impact, and score will not be shown. 

RiskyProject has two types of risks assignments:  

• Global Risk Assignments – Global risk assignments are those risk assignments that have 

a chance of affecting the project as a whole and are not limited to specific tasks or 

resources. For example, political or weather risks would be assigned as global. 

• Local Assignments – Local risk assignments are those risks that have a chance of 

affecting only specific tasks or resources. A local risk assignment can affect more than 

one task or resource. For example, risks affecting the delivery of specific equipment for a 

certain phase of a project would be assigned local. 

 

You can edit or view risk assignments in the following dialog boxes and views: 

View  dialog box/Tab Local or Global  Assigned to 
tasks or 
resources 

Drag’N’Drop Risk View   Local risks Both task and 
resources  

Risk Assignment View   Risks can be re-assigned 
to different tasks or 
resources or become 
global  

Both task and 
resources  

Risk Register Risk information 
dialog (double-click 
on Risk ID), 
Assignment tab 

Both local and global risk  Both task and 
resources 

Any view with task 
information (Project 
View, Result Gantt, etc.) 

Task information 
dialog (double-click 
on Task ID), Risk tab 

Local risks Task 

Resource View Resource 
information dialog 
(double-click on 
Resource ID), Risk 
tab 

Local risks Resources 
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Converting your project from Qualitative to Quantitative Risk Analysis 

If you have risks in the Risk Register, but no schedule, you can perform a qualitative risk analysis 

of your project. If you add even one task to the project, all your risks will convert to global risks, 

and will therefore be assigned to all tasks.  

In quantitative risk analysis risk categories are separated into two groups: 

• Schedule related risk categories: “Schedule and Scope” which is related to category 

“Duration” in qualitative analysis and “Cost and Income” which is related to category 

“Cost” in qualitative analysis. 

• Non-schedule categories (Safety, Quality, Technology, etc.) 

In qualitative risk analysis  the “Duration” category has only one outcome type “Relative delay”; 

however, in quantitative analysis, the corresponding category “Schedule and Scope” has many 

outcome types (fixed delay, relative delay, etc.). Similarly, in qualitative analysis  the“Cost” 

category has only one outcome type, “Relative cost increase”; whereas the  “Cost and Income” 

category in quantitative analysis has many outcome types (fixed cost increase, relative cost 

increase, etc.).  

If you add a schedule (i.e. activites or tasks) to your project, the following occurs: 

• Risks with the outcome type “Relative Delay” will convert to a global risk with the same 

outcome type.  

• Risks with the outcome type “Relative Cost Increase” will convert to a global risk with 

the same outcome type”.   

At this point, you may need to reassign these risks to particular tasks or resources and modify the 

outcome types. For example, a risk which had a Relative Cost Increase may need to be modeled 

as a Fixed Cost Increase. 

• The Probabilities and impacts of schedule related risks in quantitative analysis are 

calculated differently than in qualitative analysis.  

• Schedule related risk impacts are calculated as a correlation between the duration or cost 

impact for each risk and project duration or cost.  

• As a result, probabilities and impacts of schedule risk for quantitative and qualitative 

analysis will be different. 

For more information about calculation of probabilities and impacts of risks for quantitative 

analysis read, “How are risk probabilities, impacts, and scores calculated?” in the Frequently 

Asked Questions.  

• The risk register has an additional column for quantitative risk analysis: risk assignment. 

To view pre- and post-mitigation probabilities and impacts for quantitative risk analysis, 

you must calculate your project.  

• When you have a project with a schedule, the Risk Assignment view is enabled. The Risk 

Assignment icon will be disabled in the workflow bar for qualitative analysis (no 

schedule). 

• When you remove a schedule but do not remove risks, you will be performing qualitative 

risk analysis. 
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Risk Attributes for Quantitative Risk Analysis  

Each risk has the following information related to quantitative analysis. 

• Risks can be assigned to Tasks or Resources 

• Risks are defined by the chance of occurrence (from 0% to 100%). The chance can be 

defined per task (by default) or per duration unit. For example, if there is a 30% chance 

that task can be restarted per day. If task duration is 2 days, the chance of the risk 

occurring per task is 60%. This chance calculation option is defined for all tasks and 

resources for the project in the Risk tab of the Options dialog box: 

 

 
 

• Each risk has a different outcome type. Outcome types can be schedule and cost related 

and non-schedule related, which you can customize using the Risk Outcome dialog box. 

Standard schedule-related risk outcomes are shown in the table. 

 

Outcome Type Description  

No Impact This is for information only and has no impact 
on project schedule 

 

Relative Delay 

Fixed Delay 

Durations will be expanded in the period, 
defined in the Result field regardless of, 
when the risk occurs. If the Result is 
negative, the task duration will be reduced. If 
task duration is elapsed, the delay will also be 
represented in elapsed units (edays, ehour, 
etc.) 

 

Relative Cost 
Increase 

Fixed Cost Increase 

Task related fixed costs are increased by the 
amount, defined in the field Result regardless 
of when the risk occurs. If the Result is 
negative, costs are reduced. These risks do 
not affect cost per use. 

 

Relative Income 
Increase 

Fixed Income 
Increase 

Works in a similar manner to fixed cost 
increase and relative cost increase but 
applied to the income. 

 

Restart Task Tasks are restarted from the moment the risk 
occurs. As a result, the task duration is 
increased.  

 

End Task Tasks are successfully completed when the 
risk occurs. As a result, the task duration is 
reduced.  

 

Cancel Task Tasks are canceled when the risk occurs. As 
a result, the task duration is reduced, and the 
task is marked as canceled. 
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Cancel Task + all 
successors 

Tasks and all its successors are canceled 
when the risk occurs. As a result, the task 
duration is reduced, and the task and all its 
successors are marked as canceled. 

 

Rate Increase This risk can only be used on resources. If 
this risk occurs, the rate will be increase or 
reduce. For example, if the rate is $20/hour 
and risk outcome is 50%, the rate will be 
$30/hour if the risk occurs. This outcome 
affects project cost. 

 

Execute Response 
Plan 

Result field for this risk contains a dropdown 
list with mitigation plans. They come from 
Risk Mitigation or Response view. If task has 
multiple local and global risks, which require 
execution of the particular mitigation or 
response plan, this plan will be executed only 
once. 

 

• The Outcome is related to the outcomes “Fixed cost increase”, “Relative cost 

increase”, “Fixed delay”, “Relative delay”, and “Rate Increase”. It defines how much 

the duration or cost will be increased or reduced.  

• RiskyProject calculates the Risk Impact for duration and cost using sensitivity analysis 

and displays this in the Risk Register, Risk Assignment views and Risk Tabs for Tasks 

and Resources. Colors are used to indicate the level of correlation between the risk and 

project duration and cost.  

• Red indicates a strong correlation 

• Yellow a medium correlation 

• Green a weak or no correlation 

Colors for threats are the opposite. Particular colors for the risk impact value depend on the 

risk tolerance defined in Format Risk Matrix dialog box. 

The Moment of risk is defined by:  

• Start time of Risk occurrence; 

• Most likely Time of risk occurrence; 

• Finish Time of Risk occurrence 

• Uniform or triangular distributions 

 

Start, Most Likely, and Finish times are entered as a percentage of total task duration 

starting from the beginning of the task. 

For example: 

• Distribution:  Triangular 

• Start:  50% 

• Most likely: 80% 
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• End:  100%   

This description means that by default for A new task with duration 10 days risk would occur 

after 5th day, but most likely would occur on 8th day.  

Assigning local and global risks 

Once you have added your risks you can start assigning your local risks to tasks and resources. 

You cannot assign the same local risk to both a task and a resource. RiskyProject offers a number 

of ways to assign risks to task and resources. 

Method 1: Assigning risks using the Drag’N’Drop Risk view 

This is the preferred method for assigning risks to complex projects as it allows you to quickly 

assign risks to multiple tasks or resources.  

 

 

 

1. On the Risks tab, click the Drag’N’Drop Risk view. 

2. You must indicate whether you are assigning the risk to Tasks or Resources using the options 

below the list of tasks or resources. Select Task or Resources and the right pane will list 

change based on your selection. By default, the view is set to Tasks.  

3. Select tasks or resources your risk will be assigned to. 

4. Select one risk. 

5. Drag risk onto the tasks or resources. 

2. Select do you want to assign your 
risks to task or resources  

3. Select tasks or resources your 
risk will be assigned to  

4. Select one risk  

5. Drag the risk on 
the tasks or 
resources  1. Click 

Drag’N’Drop Risk 
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6. The Assign risk to task or resource dialog box opens. It shows a list of the task or resources 

that the risk will be assigned to and allows you to define risk chance, outcome type, outcome, 

and moment of risk 

7. Select whether you want to add or update a risk for the specific task or resource or if you do 

not want to make any changes to risk assigned to the specific task 

8. Enter the risk chance, outcome type, outcome and moment of risk. These parameters will be 

the same for all selected tasks. 

9. Click OK. The risk assignment to the selected tasks or resources is updated.  

 

Method 2: Assigning global and local risks using Risk Register 

This method is useful when you edit risk assignment, for example for mitigation planning. You 

will be able to view all risk assignments in one place.  With the risk register, you can assign both 

local and global risks. 

1. Open the Risk Register. 

2. Double- click on the risk to which you want to add properties. 

3. Click the Assign to tasks or resources tab. 

4. Depending upon whether you are assigning local or global risk to a task or resource click on 

the first empty row in either the Tasks or Resources tables.  

5. Select the task or resource from the drop-down list. You may select “All Tasks” or “All 

Resources” for global risk assignments. If you select a specific task or resource, it will have a 

local risk assignment. 

6. Click the row ID cell the item you just select to enable the Selected assignment table to the 

right. This is where you define the risk assignment. 

7. Click in the Chance cell to start entering the Chance, Outcome, and Result of the risk. 

8. Select the Moment of risk distribution from the drop-down list. If it is triangular, you must 

define the Start, Most Likely, and Finish parameters. 

9. Click in an additional row to enter a mutually exclusive risk alternative. A risk alternative is a 

different outcome from the same event.  

This shows how you assign risks to tasks in the Risk Register:  
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• Use the Pie Chart for mutually exclusive risk alternatives to as a guide for how they affect 

the overall chance that the risk will occur. 

• If you do not enter chance, outcome, results, or moment of risk assignment will not be saved 

even you selected task or resources.  

 

Method 3: Re-Assigning risks using the Risk Assignment view 

This is the recommended method to re-assign risks to different task and resources or make them 

global.  

 

 

To reassign risks: 

1. On the Risks tab, click the Risk Assignment view. 

2. Double-click on a risk assignment; the Risk Assignment Information dialog opens 

3. Select either global risk (for all tasks or resources) or local risk (for particular tasks or 

resources) 

4. For Local risks, select Task or Resource 

5. For Local risks, select tasks or resources from the list box. 

 

• If a risk has multiple alternatives, you may need to re-assign all alternatives  

2. Double click on 
risk assignment  

1. Click on Risk 
Assignment view 

3. Select local or 
global risk  

4. Select Assign to 
Task or Resource  

5. Select task or 
resource 
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• You can disable Global risks for specific tasks.  To disable a global risk for a specific tasks, 

open the  Task Information dialog box, Risks tab and clear Apply global risks to this task 

checkbox. 

 

 

Method 4: Assigning Local Risks Using the Task Information dialog box 
and Resource Information dialog box 

You can define task risks in the Risk Tab of Task Information dialog box. All risks entered here 

are “local risks”. It is a preferred method if you want to assign few different risks to few separate 

tasks and resources. 

1. Open the Task Information or the Resources Information dialog box. 

2. Click the Risks tab. 

3. Double-click on Risk Name field and type in the name of the risk.  

4. In addition to the above steps, you can: 

• Click the Enlarge button to expand the view and make it easier to assign risks. 

• Click the Load Risks from Template button to load all risks from a risk template.  In 

this way, you can create a master list of risks in the template, load it here and enable or 

disable risks as required. 

• Clear the Apply global risks to this task check box (it is selected by default) if you do 

not want to include this task in global risk calculations. 

• Check Enable statistical distribution for risk outcome to be able to enter low and high 

risk outcome for this and other tasks. For more information about probabilistic risk 

outcome types, read “Uncertainties in Risk Outcomes”. You can also Enable/Disable 

statistical distribution for risk outcome in Schedule > Project Options > Risk tab. 

 

• You cannot add risks to summary tasks. 

• Ensure that you have clearly defined your risks and uncertainties. For example, if you have 

already accounted for risk using a range (Base, High, and Low) of durations; do not add this as 

a risk as it is accounted for twice in the calculations. 
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You can copy and paste risks between tasks. Right-click and choose Copy Risks to copy a risk. In the 

target task’s risk list, right-click and choose Paste Risk to add the risk to the task. 

 

Parallel Risks 

Parallel risks represent a way of modeling risks in cases where multiple risks occur 

simultaneously. If risks are parallel, RiskyProject will only account for maximum impact of the 

most critical risk during each iteration of a simulation. This is useful if one or more less critical 

risks occur in conjunction with a critical risk recovery from all potential risks that can occur over 

the same period. In such cases, only the impact of the most critical risk will be accounted for in 

the simulation.  

For example, a risk ‘Not enough information…’ causes a delay of 5 days, and a risk ‘Staff 

turnover’ causes a delay of 1 day. If these risks occur together and they are not parallel, the 

cumulative impact will be 6 days maximum. If they are parallel, cumulative impact will be 5 

days.    

Load risk from 
template  

Click to open a separate 
window to simplify risk entry  

Uncheck this box if you don’t want 
to apply global risks to this task 

Click here to be able to enter low and high 
risk outcome for this and other tasks 
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To set a risk to run in parallel: 

2. Double- click on the task id for the task in which you want to set a parallel risk. 

3. Click the Risks tab. 

4. Locate the risk you want to run in parallel. 

5. In the “Parallel Risk” column for the risk, click the check box. The risk will now run in 

parallel to the other risks assigned to the project. 

6. Repeat for all other risks that you want to run in parallel. 

 

Parallel risks are calculated for increasing cost and duration. They do not affect risk outcomes of 

cancel/end tasks or non-schedule risks. 

 

Select the risk that you want to run 
in parallel.  
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Risk Assignments on the Gantt Chart 

Risks and issues can be shown on the Gantt chart as arrows: 

 

Colors represent the calculated the impact of the risk on all project parameters combined. The 

size of the arrow represents probability. You may click on each risk arrow within a Gantt chart to 

be shown with information about risks: 

 

 

• Only local risks are shown as arrows. 

• You cannot add or remove mutually exclusive alternatives using this dialog, but you can 

input chance of occurrence, outcomes, result, and moment of risk. 

 

Showing or hiding risks on the Gantt chart 

Click the   button on the Analysis tab toolbar to toggle the risk arrows on or off. You may also 

Right-click on Result Gantt chart and select Show Risks. 

Use risk grid to enter information about chance of occurrence, 
outcomes, and result of each mutually exclusive alternative 
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Risk Correlations 

Different risks can be correlated to each other. For example, bad weather conditions (risk 1) can 

mean that the delivery of the goods can be delayed (risk 2). For each risk, you can specify 

correlated risks or view risks, which can occur with a particular risk. For example, the risk 

Technical Difficulties with HTML editor occurs together with the risk Major problem with 

web site.  

If you define a correlation between risk 1 and risk 2, and then define a correlation between risk 1, 

risk 3 and risk 4, the correlation between risk 1 and risk 2 defined in the previous step will be 

removed. Therefore, if you want to setup correlations between many different risks, you must 

perform this in one-step. 

 

Risk 1 Risk 2

Risk 3 Risk 4

Step 1 Step 2

Risk 1 Risk 2

Risk 4Risk 3

 

• Risk correlations can be specified once for different mutually exclusive alternatives of the 

same risk. The Moment of risk will not be correlated: even though risks are correlated, they 

may occur at a different moments during the task duration. 

 

How correlated risks are calculated 

RiskyProject uses the same seed for correlated risks. If seeds for two risks are the same, then 

sampling will follow the same pattern and risks will be correlated with each other.  

If risks are correlated with each other, it does not mean that they will always occur together as the 

risks may have different chances of occurrence. If Risk 1 has a chance of occurrence of 10% and 

Risk 2 has a chance of occurrence of 20% and both risks are correlated, Risk 1 will always occur 

when Risk 2 occurs, but Risk 2 may occur when Risk 1 does not occur.  

Correlating risks 

Risk correlations can only be defined in the risk tabs on Task Information and Risk Information 

dialog boxes. 

1. Right-click on the risk. 

2. Click the Correlations tab. 

3. Select a risk from the list of all available risks. 
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4. Select the task or resource to which this risk is assigned. This is required when risks with the 

same name are assigned to different resources or tasks. 

5. Click OK to save this information. 

Correlation of risk assignments 

The risk events may occur at the same time (risk assignments are correlated) on in different times 

(risk assignments are not correlated). The default rule, or how different risk assignments are 

correlated, is defined in project options. To change this rule: 

1. Click the Schedule tab. In the Settings and Options, click Options. The Options dialog box 

opens. 

2. Click the Risk tab. 

3. If check box Risk assignments to different tasks are correlated is checked, all local and 

global assignments of the same risk will be correlated by default. 

 

 



RiskyProject Professional User Guide 

 

125 

Risk Templates 

Risk templates allow you to quickly add risks to your project and assign chances of occurrence 

and outcomes. Risk templates are different from the Risk Register: they contain information 

about risk assignment. Risk templates are useful when you want to: 

• Move risk assignments between different projects 

• Perform a risk assignment as you did in a previous project 

• Manage different sets of risk assignments for different types of projects 

Creating a risk template 

 Create a set of global risks assignments: 

1. Click the Risks tab. In the Export/Import group, click Risk Assignment and then Save 

Risk Template. Only global risk assignments will be saved to the template. 

2. Provide a name and description.  

3. Click OK. RiskyProject automatically saves the files. If the template already exists, a 

warning will open. 

 

• You may have both Global and Local risk assignment. They are shown in Risk Assignment view. 

But when you create a template only Global risk assignments will be saved in the template. 

 

 

Loading a risk template 

1. Click the Risks tab. In the Export/Import group, click Risk Assignment and then Open 

Risk Template. The Open Risk Template dialog box opens.  

2. Click on a list to select it.  

3. Click OK. The template risks will replace any global risks that exist in the project. 

Selecting a default risk template 

When you select a template as the default, the template will be loaded each time you create a new 

project. 

1. Click the Risks tab. In the Export/Import group, click Risk Assignment and then Open 

Risk Template.  

2. Select the check box to the left of a template to set it as the default template. 

 

• Templates are saved into the Templates directory. Templates directory is a subdirectory of 

RiskyProject directory. Templates directory is generated during installation. You Templates 

directory does not exist, templates are saved to the RiskyProject directory. The file 

extension for the template is *.aln. Template names are displayed in the status bar. 
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Using risk templates for local risk assignments 

1. Open the Risk tab located in the Task Information dialog box or the Resource Information 

dialog box.  

2. Click Load Risks from Template button. The Load Risks from Template dialog box opens. 

3. Select the template from the list and click OK. The risks template will overwrite all existing 

local risks for the particular task or resource. 

 

• Templates may contain risks assigned to both task and resources. If you load a risk template 

from Task Information dialog box, resource risks will not be loaded. If you load risk template 

from Resource Information dialog box, task risks will not be loaded. 
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Managing Uncertainties 

If you have accurate historical statistical data that is analogous to a particular element in your 

project, we recommend that you use this data to model uncertainty in your project as opposed to 

risk events. Be aware of double-counting risk and uncertainty as most of the uncertainty in a 

project is due to the probability of risk events occurring. 

To define uncertainties: 

1. Define a 3-point estimate for any of task parameters: fixed cost, income, duration, and start 

time. 3-point estimates for work will be calculated automatically based on uncertainty in 

duration. You may also define 3-point estimates for the lag.  

2. You can define a Most Likely duration or fixed cost. By default, Most Likely duration or 

fixed cost equals Base duration and Fixed Cost. However, you can define separate Most 

Likely values. This can be used if you believe that the Base values from original project 

schedule is not realistic, but you want to maintain the original Base values. Most Likely 

values are used only with Triangular and BetaPert distributions. 

3. After you define 3-point estimates, a statistical distribution will be assigned. You may change 

the default statistical distribution for the duration, cost, income, and start time parameters in 

the gf Distributions tab of Task Information dialog box. 

 

The meaning of low, base, and high data depends on the statistical distribution defined in the 

Distributions tab of the Task Information dialog box. 

 

Adding 3-point estimates for task duration and start times using Task 
Information Dialog 

1. On the Project view, double-click on the task ID.  

2. Click the General tab.  

3. Define a Base, Low, and High dates for Duration and/or Start Time.  

4. Define a Base, Low, and High values for Duration. By default, when you enter a value for 

duration, the default values for Low and High are calculated based on the defaults set in the 

Duration Options. 

5. Click OK to save the estimates. 

Adding 3-point estimates for task duration using the Project View 

1. On the Project view, select the task to which you want to add cost and income estimates 

2. Enter cost data for Duration Low, Duration Base, and Duration High. By default, when 

you enter a value for Duration Base, the default values for Low and High are calculated based 

on the Duration defaults set in the Duration Tab of Project Options dialog. 

3. You may define a Most Likely Duration. The Duration Most Likely column is hidden by 

default, so you will need to insert the to your datasheet. To insert column right click on 

column header, choose “Insert Column Before…” or “Insert Column After…”, and select 

Duration Most likely. 
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Adding 3-point estimates for task cost and income 

1. On the Cost and Income view, select the task to which you want to add cost and income 

estimates 

2. Enter cost data for Cost Low, Cost, and Cost High. By default, when you enter a value for 

Cost, the default values for Low and High are calculated based on the Cost defaults set in the 

Cost Tab of Project Options dialog. 

3. You may define a Most Likely Duration. The Duration Most Likely column is hidden by 

default, so you will need to insert the to your datasheet. To insert column right click on 

column header, choose “Insert Column Before…” or “Insert Column After…”, and select 

Duration Most likely. 

4. Enter income data for Inc. Low, Income, and Inc. High. 

Adding 3-point estimates for lags 

1. On the Project view, double-click on the task ID. 

2. Click the Predecessor tab.  

3. Enter Low, Base, and High Lag. Default statistical distribution will be generated 

automatically. There are only two distributions for lag: Uniform Triangular. 

4. Click OK to save the estimates. 

Distributions for 3-point estimates for duration, cost, income, and 
start time 

You define distributions for 3-point estimates in duration, start time, income and cost in the 

Distributions tab of Task Information dialog box. Distribution for work is the same as 

distribution for duration. Distributions do not affect the deterministic calculation of current 

schedule. You cannot define distributions for summary tasks. 

The Distributions tab allows you to assign distributions and define the meaning of low and high 

values for normal and lognormal distributions. The actual values for low, base (most likely), and 

high duration, cost, and start time are defined when you enter task parameters in data sheets. Low 

and high duration and start time can be entered in General tab of Task Information dialog box 

of in data sheets. Seeds, which are associated with the distributions, are defined in data sheets. 

RiskyProject offers the following distributions: 

 Distribution Parameters How to use 

1 Beta Alpha and beta 
parameters 

Used for wide range of conditions. If Alpha and Beta 
are 1, Beta distribution will uniform. If Alpha and 
Beta are the same, the distribution will be 
symmetrical.  

2 BetaPert Mean parameter Used as “smoother” substitute to Triangular 
distribution 

3 Cauchy  Shape parameter Used if low duration, cost, or start time represents 
“best case scenario” value. High value represents a 
cut off: how long duration, cost, and start time can 
expand.  
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4 Custom Set of points with 
probabilities 

Used to define generic shape of distribution by 
entering point as a percentage of task duration, start 
time or cost, and associated relative probability. 

5 Discrete Set of intervals with 
probabilities 

Used to define distributions consisting of multiple 
segments with associated relative probabilities. 
Each segment is defined by uniform distribution. 
Interval is entered as a percent of task duration. 

6 Exponential  Mean parameter Similar to Cauchy distribution 

7 Gamma Alpha and beta 
parameters 

Similar to Cauchy distribution 

8 Gumbel Two share parameters Skewed distribution. Useful if there is lower chance 
that task will take longer time than a shorter time. 

9 Laplace One parameters Similar to Cauchy distribution 

10 Lognormal Mean and standard 
deviation parameter or 
P1/P99, P5/P95, 
P10/P90 

Similar to Gumbel distribution 

11 Normal Mean parameter or 
P1/P99, P5/P95, 
P10/P90 

Symmetrical distribution. Low and high values of 
duration, cost, and start time serve as cut offs. 

12 Rayleigh Standard Deviation 
parameter 

Similar to Gumbel distribution 

13 Triangular Most Likely parameter Most likely parameter overwrites base value of 
duration, cost, or start time. 

14 Uniform  Equal probability that duration, cost, or start time will 
be between low and high values. 

Defining task distributions 

1. Select the task in which you want to define distributions. 

2. Open the Task Information dialog box.  

3. Click the Distributions tab. 

4. Select the Cost, Duration or Start Time tab. 

5. Select the distribution from the Distribution list. If you select Undefined, the base value will 

be used for all iterations. 

6. Define the distribution parameters. The Probability Density chart is automatically updated. 

You can adjust distribution parameters using the sliders. 

7. If you use a custom or discrete distribution, a grid opens. The grid will allow you to define 

points (or intervals for discrete distributions) and associated with each point (interval) 

8. If you select Normal or Lognormal, you must select the Low and High probability range 

(P1 and P99, P5 and P95 or P10 and P90). These are “cut-off” parameters; meaning that 

duration, cost, or start time cannot go beyond these values. 

 

• The Probability Density chart’s colors are consistent with those found in the Project 

Summary and Monte Carlo Simulation results: Duration is blue, Cost is green, and Start Time 

is yellow.  
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• Double- click on the probability density chart to enlarge it. 

• To copy the chart to the clipboard or as a  file, right-click and choose a copy command from 

the shortcut menu.  

 
 

In most real life examples, the type of distribution (triangular, normal, and lognormal, etc.) may 

not significantly affect the results of calculation. Results of project scheduling cannot be 

accurate with high precision due to the large systemic errors of estimation in project 

management. It is recommended that you assign different statistical distribution if you have 

reliable historical data about similar tasks. 

 

Using Empirical Data to Generate a Statistical Distribution 

You can use empirical data to define a custom statistical distribution. The data must be saved in a 

comma separate file and contain numbers only. The minimum number of values should be 20. At 

least one value should be different from all others. If there is a text field, it will be interpreted as a 

zero value. Values can be entered on multiple lines. But it could be one row, or one column. Here 

is the example of a file: 

67.78, 88.32, 32.33, 47.54, 57.32, 45.23, 58.23, 67.00, 56.20, 32.87, 32.22, 30.00, 32.33 

32.99, 18.32, 56.22, 32.21, 32.98, 23.23, 73.43 

58.23, 67.00, 56.20, 32.87, 32.22, 30.00, 32.33, 22.45, 48.34 

Fitting a distribution 

1. Open Project View 

2. Double click on Task ID; Task Information dialog opens 

3. Go to Distributions task 

4. Selection Cost, Income, Duration or Start Time 

5. Click the Get Empirical Data button.  

6. Select the comma separated file that contains the data 

7. Existing durations for low, base, and high values will be replaced with the custom 

distribution generated using the empirical data. 

Assigning Low, Most Likely, and High Estimates for Duration and 
Cost for Group of Tasks 

You may assign statistical distribution for duration and cost for a selected group of tasks: 

1. Open the Project View. Select a group of tasks. 

2. Right-click on a Task ID. 

3. Select Set Low/ /High Duration or Low/ High Fixed Cost.  

4. Enter fixed values or use coefficients to calculate Low, Most Likely, and High duration or 

cost based on Base duration or Cost.  
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5. Select a distribution from the drop-down list. 

6. Click OK to apply changes. 

 

You may clear the statistical distribution for a particular group of tasks. To do so, go to the same 

dialog and select “Set low, most likely and high duration equal base duration” for duration or “Set 

low, most likely and high cost equal base cost” for cost. 

 

Uncertainty Bands 

If you are able to identify or characterize activities based on  a known levels of  uncertainty, you 

can create uncertainty bands to model these and quickly apply them to all activities that meet the 

criteria. You can define a set of coefficients to calculate low and high duration or fixed cost. For 

example: 

Band 1 (Low):  

Duration Low = Duration Base * 0.95 

Duration Most Likely = Duration Base * 1.0 

Duration High = Duration Base * 1.1 

Band 4 (Critical):  

Duration High = Duration Base * 0.8  

Duration Most Likely = Duration Base * 1.05 

Duration High = Duration Base * 1.3 

Each band is associated with certain color. This color will be a background color for 

low/base/high duration or fixed cost, which belong to particular band. You can assign bands to 

the group of selected tasks. 

To define uncertainty bands: 

1. Click the Risk tab.  

2. Click Uncertainty Bands. Uncertainty Bands dialog box opens. 

3. Each row represents a band. Define the Name, Low, Most Likely and High coefficients, color 

and note for each band. Use the Delete button to remove bands if required. 

4. Select the Statistical Distribution for the Band. Uncertainty Bands only support only 

Triangular or BetaPert distributions.  

5. Toggle between Duration Bands and Cost Bands to define bands for duration uncertainties 

or fixed cost uncertainties.  

6. Click OK. 
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• Each time you make changes to uncertainty bands they are saved in the system registry as 

default sets of bands for all new projects. 

• It is recommended not to repeat coefficients for different bands 

 

To assign an uncertainty band to activities: 

1. Select a group of tasks in any view where tasks are shown  

or 

 Click on Find button, select tasks based on certain criteria (see Finding Text or Data). 

2. Right-click on a task ID. The uncertainty bands drop down list appears next to the shortcut 

menu. Uncertainty Bands for fixed costs and income are available in the Cost and Income, 

Cost Analysis, Cash Flow, Work and Profit Report views.  

3. Select a band from uncertainty bands: the background color the activity estimates will be 

changed to match the selected the band color. 

 

 

Select the band from 
drop down list 

Color for duration and 
fixed cost cells 
corresponds with color 
of duration/cost bands 

Click here to define 
uncertainty bands 

Right click on task 
ID: uncertainty 
bands drop down list 
comes up 
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Finding Text or Data 

A popular method to quickly assign low and high estimate for duration and cost using coefficients 

is to assign them to groups that are identified by specific values in text or data fields. This is often 

referred to as grouping or banding. 

To find specific text or data values in your project fields. 

1. Click the Schedule tab. On the Zoom and Find group, click the Find    button. The Find 

dialog box opens. 

2. From the Look in field: dropdown list, select the column that you want to search. This list 

contains only those columns available in currently open view. 

3. From the Test: dropdown list select the logic definition that you want to use for your search. 

Type in the value that you want search for in the text box to the right.  Selected activities are 

highlighted.  Activities will remain selected until you clear the selections. 

4. To clear your selections, click the Unselect   button. 

For example, if you want to find/select all Tasks with that include “Design” in the task name, 

select Task Name in the Look in field:  dropdown list. From the Test: dropdown list, select 

contains and type in “Design” in the text box and click Find. 

 

 

To select all activities: 

1. Click the Schedule tab. On the Zoom and Find group, click the Find    button. The Find 

dialog box opens. 

2. Click Select All.  All activities are selected.  

Find 
Data 

Clear selected 
data 
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Assigning Low and High Estimates for Duration and Cost to Found 
Tasks 

Once you have selected the activities that you want to modify, you can then mass edit the low and 

high estimates for duration and cost to the selected activities. 

To set low and high duration or cost to found activities: 

1. Using the Find feature, search for those activities to which you want to set the low and high 

duration or cost. 

2. In an open view, click on the Task ID of one of the found activities (highlighted in black) to 

select it. The highlighting will change to a lighter shade of gray to indicate that you have 

made a selection.  

3. Right-click and from the shortcut menu, choose either Set Low/High Duration or Set 

Low/High Fixed Cost.  

4. In the dialog box, click the Apply to Found tasks option.  

5. Enter the rest of the required values or coefficients for Low and High estimates and select a 

statistical distribution. 

6. Click OK. 
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Calculations 

RiskyProject has two types of calculations: 

• Deterministic calculation of current schedule - The default calculation is automatically 

performed when you modify a project schedule. As this calculation occurs automatically, 

you do not need to press the Calculation button. This calculation uses the Base input 

parameters (duration, start time, lag) without calculating the effect of risk or uncertainty. 

• Probabilistic (Monte Carlo simulations) - Use this to calculate the project schedule and 

costs with uncertainties and risks.  

• Automatic Monte Carlo simulations for small tasks are enabled by default.  

Enabling or disabling automatic Monte Carlo simulations for small projects 

1. Click the Schedule tab. In the Settings and Options, click Options. The Options dialog box 

opens. 

2. Click the Calculations tab. 

3. From the Default Calculation for Small Projects option box, select one of the two options: 

• Current Schedule Calculation only 

• Probabilistic Calculation (Monte Carlo simulation)  

4. Click OK. RiskyProject automatically determines which project is small based on your 

computer’s performance and the size of the project. 

Running probabilistic calculations 

Click the Calculate button. You may cancel the probabilistic calculation at any time; however, if 

the number of simulations performed is less than 20, no probabilistic results will be calculated.  

 

• By default RiskyProject performs convergence monitoring. Simulations can be stopped when 

they convergence equals mean and standard deviation values defined in Schedule tab > 

Options > Calculation. 

• Minimum number of simulations is 200. 

• If you cancel a calculation after more than 20 simulations and generate results, use these 

results with caution as the number of simulations which have been run may be too small to 

provide an accurate portrayal of the project’s risks and uncertainties. 

• If you try to perform Monte Carlo simulations without risks and uncertainties, simulations will 

not proceed in the same manner as when you define risk and uncertainties. Remember that 

uncertainties include a probabilistic calendar.  

 

Defining the number of simulations 

You can define the total number of simulations run during each probabilistic calculation. 

1. Click the Schedule tab. In the Settings and Options group, click Options. 

2. Click the Calculations tab. 

3. Type in the number of simulations in the Maximum number of simulations box. The 

number of simulations that have actually been run could be less if the simulations converge. 
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Analyzing Results 

Project Summary  

The Project Summary  view shows the main information about your project: total cost or income 

(if income is defined), finish time, duration, and success rate for both deterministic and 

probabilistic calculations.  

 

 

 

 

 

 

The Project Summary is divided into four sections: 

• Main project information – the main project information includes the project name, 

manager, etc. 

• Main project parameters with and without risks – this table is located in the center of the 

project summary and shows the project start time, duration, finish time, cost, income, and 

profit for the current schedule (no risks) and the low, base, and high calculated results. 

• Main project parameter frequency/cumulative probability charts – interactive charts that 

show the distribution of the results.  

Main Project 
information. You 
can also enter or 
modify this 
information in the 
Project Settings 
dialog box 

Interactive frequency charts represent the 
risk profile of the project. Double-click on a 
chart to open the Detail view of the chart. 

Move the slider to view 
the chance that cost, 
duration or finish time 
will be less than a 
certain value. 

Right-click on a chart to 
view menu items that 
provide analysis and 
output options. 

This table shows the project parameters for: 

A. Current schedule (no risks) and  

B. Probabilistic calculations (with risks).  

The cells related to probabilistic results will be blank if 
probabilistic calculations have not been run. 

If your project has any 
income, this will be the 
project profit.  

Use meter to see risk 
score for project cost and 
duration 
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• Meters: provide project risk scores for cost and duration. You can adjust the scale and 

calculation formula for project meters by clicking on the question mark (?) on the left 

bottom corner of the duration meter. You can also define a formula for project risk score. 

 

Risk Score Meter Settings 

To define risk score meter scale and calculation formula click on the question mark at the lower 

right corner of the Duration Score meter.  

Project duration score is calculated using the following formula: 

 

 

 

 

Where: 

Risk Duration – could be mean project duration as a result of analysis, mean project duration 

plus a standard deviation of duration, or a certain percentile of the entire project duration. 

Original Duration - Original (baseline) project duration with no risks and uncertainties 

• If the project does not have duration risks, the Duration score will be equal 1.  

• If the Duration risk score is > 1, the project has threats related to duration.  

• If the Duration risk score is < 1, the project has opportunities related to duration.  

Project cost score is calculated similarly 

To define risk score meter settings: 

1. Select risk parameter from dropdown list 

2. Define maximum threat score 

3. Click OK 

 

Viewing the project summary frequency charts 

The frequency charts are interactive and show the risk profile for each project parameter: Cost, 

Finish Time, and Duration.  

1. Drag the slider across a chart to view the chance that the project parameter will equal a 

certain value. 

2. Double- click on a chart to enlarge it. The enlarged chart provides several different features 

including: 

• Cumulative probability chart 

• Full access to all statistical data for the selected parameter 

3. Click on the Statistical Data for Work button to view the distribution for work. Work data is 

correlated to project duration distributions. 

4. Right-click on the chart to view a full menu of analysis and copying options. 

          Risk Duration 

Score = -------------------------------- 

                    Original Duration 
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• The low and high results of probabilistic calculations (cost, duration, and finish times) are 

associated with P1/P99, P5/P95, P10/P90, or any custom percentiles. These are defined in the 

Options (Calculation tab). 

• You may customize frequency charts either using Format > Format Frequency Chart or by 

right-clicking on a frequency chart and selecting Options.  

 

Results Gantt Chart 

RiskyProject displays the start and finish ranges of each task in the Result Gantt view. The 

calculated project and baseline schedules are shown in the same Gantt chart. You can use the task 

bar for current schedule to compare deterministic and probabilistic schedules. 

 

 

 

 

You can display Result Gantt associated only with low (optimistic) and high (pessimistic) results.  

Showing or Hiding Low/High Results 

1. Right-click on the chart and a shortcut menu opens. 

2. From the shortcut menu, choose one of the following viewing options: 

• Show Low/High Results 

• Show Low Results 

• Show High Results 

• Show Current Schedule. 

Task Simulation Results 

RiskyProject allows you to quickly view the cost (profit, if income in any task is defined), 

duration, start time and finish times uncertainties associated with each task.  

Mean Finish Time High Finish Time Low Finish Time 

Mean Start Time High Start Time Low Start Time 

Task bar for deterministic schedule 
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 After you have completed a probabilistic calculation, you can see the probability that the 

particular task will start and finish on particular dates and will have a duration and a cost less than 

a certain value. The six charts available are for: 

• Cost (Profit 

• Duration 

• Start Time 

• Finish Time  

• Variable cost 

• Work 

 

Viewing Task Simulation Results 

1. Right-click on a task ID in any view. A shortcut menu opens. 

2. Choose Task Simulation Results from the shortcut menu. The Monte Carlo Simulation 

Results dialog box opens. 

3. Drag the slider across the charts to view the chance of a certain result. 

4. Double-click on a chart to open up a detailed view of the chart.  

• Click the tabs on the top of the charts to toggle between Frequency, Cumulative 

Probability views, and their combination. 

• Click the Statistics, Data, or Percentiles to view more detailed views of the result data. 

Double-click on a chart 
to see larger chart with 
more information 
including statistics and 
raw data. 

Right-click on a chart to 
copy the chart, statistics 
or data to the clipboard 
or view cumulative 
probability, frequency 
charts, or their 
combination. 
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• If you created at least one baseline with results of analysis, you will see a detailed chart 

with multiple cumulative probability plots. A list of baselines is shown in the left bottom 

corner of the dialog box. You can enable and disable plots, as well as change colors for 

the plots. By using multiple cumulative probability plots, you can compare uncertainties 

in different project scenarios for particular task or for whole project. 

 

 

 

• Right-click on a chart to copy the chart, statistics or data to the clipboard or view cumulative 

probability, frequency charts, or their combination. 

• You may customize this chart either using Risks tab > Format Chart or by right clicking on the 

chart and selecting Options.  

 

• You may use this feature to view task simulation results at each phase of the project. For 

example, if you have a milestone associated with a certain phase of the project, you can 

determine the chance that this phase of the project will be completed on time and budget. 

 

Simulation Chart Options 

You can use the chart options to define how the charts will appear. 

To define chart options: 

1. Select chart you want to format 

2. Right-click on a chart. A shortcut menu opens.  

3. Choose Options. The Chart Options dialog box opens.   

4. Define the default viewing options. 

This table will be shown only when you have at least 
one baselines with results of analysis. 

Baselines can be set using Schedules -> Baseline -> 
Set 

Enabled 
cumulative 
probability curve 
for this baseline 

Double click 
to modify 
plot color 

Curves are associated 
with results of analysis 
for different baselines 

Frequency chart shows 
the current schedule  
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Viewing statistics results of work 

1. On the Task Information dialog box, click the Resources tab.  

2. Right-click on a resource ID and select Simulation Results. 

3. Drag the slider across a chart to view the chance that the work will equal a certain value. 

4. View statistical parameters, percentiles, and raw statistical data for work on the left pane 

5. Switch between frequency chart, cumulative probability chart, and combined chart on the 

right pane of the dialog 

6. Right-click on the chart to view a full menu of analysis and copying options. 

 

• The low and high results of probabilistic calculations (cost, duration, and finish times) are 

associated with P1/P99, P5/P95, P10/P90, or any custom percentiles. These are defined in the 

Options (Calculation tab). 

• You may customize this chart either using Risks tab > Format Chart or by right clicking of the 

chart and selecting Options.  

 

View sensitivity analysis for each task 

Sensitivity analysis is available for each activity. Two types of charts are available: 

You can define three percentiles in 
addition to default low and high 
percentiles on the cumulative 
probability chart 

Selected percentiles can 
be shown on the 
cumulative probability 
and frequency  charts  

Space 
between bars 

Small charts 
are shown on 
Project 
Summary view 
and Task 
Monte Carlo 
Simulations 
Results. Larger 
charts appear 
when you 
double click on 
small chart. 

Deterministic 
line is shown in 
red if it is 
between max. 
and min. 
results. 
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1. Tornado Plot: the chart will show how finish time of task predecessors will affect finish time 

of the selected tasks.  

2. Scatter Plot: the chart will show correlation between task duration or cost and project 

duration or cost. 

To view the sensitivity analysis for a single activity: 

1. Run a Monte Carlo simulation. 

2. Click on the task from which to generate a sensitivity analysis. 

3. Click the Analysis tab. On the Task Simulation Results group, click Tornado Plot or 

Scatter Plot. A tornado chart or scatter plot opens. You can also right-click on a task ID and 

then click Task Sensitivity Analysis or Task Scatter Plot.  
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Sensitivity (Tornado) Chart for selected task 

Only 
predecessors 
of the selected 
task will be 
shown.  

Only task with correlation 
coefficient greater than minimum 
value will be shown. This minimum 
correlation coefficient can be 
defined in Schedule > Options > 
Calculation 

Correlation 
analysis of 
selected task 

Toggle between Task Duration vs. Project 
Duration and Task Cost vs. Project Cost  

Right click 
on task ID 
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Joint Confidence Level Plot 

Joint Confidence Level Plot is also known as a Bull’s Eye, Football, or Cost vs. Duration chart. 

Joint Confidence Level Plot can be shown either of individual task or for complete project. It 

shows a comparison of the Total Project or Task Cost vs. Total Project or Task Duration or Finish 

Time for each iteration of the simulation. 

The plot includes four quadrants: 

1. Left-Top: % of simulations in which project or task meets schedule but is over budget 

2. Left-Bottom: % of simulations in which project or task meets both budget and schedule  

3. Right-Top: % of simulations in which project or task are over budget and schedule 

4. Right-Bottom: % of simulations in which project or task meets budge but is over schedule 

The plot also present frontier lines or lines where Cost and Duration (Finish Time) combination 

meets certain predefined targets. You can define many frontier lines with different targets. 

 

 

 

 

 

 

 

To view the Joint Confidence Level Plot: 

1. Make sure that your schedule has both uncertainties in duration and cost 

Right click on the chart to 
copy data or chart to the 
file or clipboard 

Deterministic 
Value 

Move slider to 
view specific 
percentile 

Results of 
specific 
quadrant 

Change 
settings for 
frontier lines 

Frontier lines: cost and schedule combination 
that will meet a targeted joint confidence level. 
This example green line shows cost and 
duration combination where: 

90% chance that both cost and schedule 
targets are met 
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2. Run a Monte Carlo simulation. 

3. To view the plot: 

• For Project: Click the Analysis tab. On the Project Summary view, click Cost vs. 

Duration Scatter Plot, or Click on JCL button in Task Simulation Results group of 

ribbon’s Analysis tab. 

• For Task: Right click Task ID and select Joint Confidence Level from drop down 

menu, or Click on JCL button in Task Simulation Results group of ribbon’s Analysis 

tab. 

 

4. Select type of the plot you want to view: 

• Project/Task Cost vs. Project/Task Duration, or 

• Project/Task Cost vs. Project/Task Finish Time 

5. Define frontier line settings: chance that both cost and schedule are met and color of each 

frontier line. You can also add a description of each line. To hide one or many frontier lines 

right click on frontier line ID and select Delete. After you updated frontier line settings click 

Refresh Chart. 
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Resource Allocation 

The Resource chart shows the time allocation for a selected resource. 

 

For the resource chart to open, two conditions must be met: 

• You must select the Chart check box for a resource in the resource sheet. 

• The selected resource must be assigned to a task. 

You can select four different types of resource charts: 

• Peak units: The highest level at which a resource is scheduled for all assigned tasks 

during a given period. 

• Work: The total number of hours a resource is scheduled for all assigned tasks during a 

given period.  

• Overallocation: A resource is over allocated when it has more work assigned than can be 

done in the resource’s available time. Overallocation is number of hours a resource is 

scheduled for all assigned tasks over resource’s available time. Overallocation can be 

shown only for work (not material and cost) resources.  

• Percent allocation: The percentage of a resource’s capacity taken up by all of its 

assigned tasks during a given period. Percent allocation is only available for work (not 

material and cost) resources. 

Overallocation 

Select a checkbox to 
indicate the data that 
you want to view in the 
chart. You can view 
baseline or probabilistic 
results 

Select a checkbox to 
indicate which resource 
time allocation will be 
shown on the chart. 
Only one resource can 
be selected at a time. 

Right-click on the chart 
to open a shortcut 
menu. You can select 
Zoom In, Zoom Out, 
and Zoom All 
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Selecting the resource chart type 

1. Select the Chart check box associated with the resource. 

2. Right-click on the Resource chart and choose one of chart types from the shortcut menu. 

 

Overallocation for work resources is calculated based on Maximum Units, defined for the resource in 

the Resource view. For example, if maximum units are 150%, overallocation can be work above 150%.

 

Viewing results for resource assignments 

You may view the statistical distribution of work associated with each resource. Statistical 

distributions are only shown for resources that are designated work rather than material and cost.  

1. Double-click a task ID to open the Task Information dialog box 

2. Click the Resources tab. 

3. Right-click on a resource assignment ID. 

4. Choose Simulation Results… to view the work associated with selected resource 

assignment. 

Analyzing Cost and Profit 

Use the Cost Analysis view to analyze cost and profit on each stage of the project. The Cost 

Analysis view has up to five cost diagrams: 

Cost diagram Description Color When it is shown 

Current schedule 
(budgeted) cost or 
profit 

Cost diagram with current 
project schedule (no risks) 

Red Always when cost or profit for any task is defined 

Result cost (Low) Cost diagram with risk and 
uncertainties (calculation 
results, low estimate) 

Blue – 
dashed 
line 

Shown after calculation if uncertainties are 
defined and Low Result Cost Chart is selected 
from shortcut menu (right click on the chart) 

Result cost (Base) Cost diagram with risk and 
uncertainties (calculation 
results, base estimate) 

Blue Shown after calculation if uncertainties are 
defined and Base Result Cost Chart is selected 
from shortcut menu (right click on the chart) 

Result cost (High) Cost diagram with risk and 
uncertainties (calculation 
results, high estimate) 

Blue 
dashed 
line 

Shown after calculation if uncertainties are 
defined and High Result Cost Chart is selected 
from shortcut menu (right click on the chart) 

Actual cost Cost diagram represents 
actual cost  

Green Shown after calculation if uncertainties are 
defined and actual cost is available (either 
entered directly or percent done for at least one 
task is defined) 

 You may use the slider to determine: 

• Cost Variance (actual vs. budgeted cost)  

• Cost with Risks and uncertainties vs. Current schedule (budgeted) cost. 
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• If income is defined for at least one task, the cost analysis diagram will show the project 

profit calculated based on the formula: Profit = Income – Cost. 

• If Cost exceeds Income in any given period, Profit will be negative. 

• If income is not defined, Cost will be always positive. 

 

Use the shortcut menu to manipulate with chart. In particular, instead of presenting a line chart of 

current schedule, result, and actual cost, you can create an area chart by choosing Fill Chart from the 

shortcut menu. 

 

Result cost or 
profit 

Baseline cost 
or profit 

Actual cost or 
profit 

Use the slider to determine 
cost at each period. 

Cost variance is updated automatically 
when you move the slider 
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Cash Flow results 

The Cash Flow view shows a comparison between Current Schedule, Calculated (with risks and 

uncertainties), and Actual project cost and income.   

 

 

• If you enter income for at least one task, the cash flow diagram will show the project profit 

calculated based on the formula: Profit = Income – Cost. 

• If Cost exceeds Income in any given period, Profit will be negative. 

• If you do not enter any income, Cost will be always positive. 

• If n is the number of months, the formula for NPV is:  

 

Select Periodicity  

Discount rate is used to 
calculate NPV. Default 
NVP is defined in Cost 
Options 

NPV is calculated only for 
current schedule and 
results. IRR is calculated 
only for current schedule. 

If you change discount 
date you should 
recalculate NPV. 
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Sensitivity Analysis 

Sensitivity analysis shows which variables have the potential to have the greatest effect on the 

main project parameters. RiskyProject performs calculations for the sensitivity analysis as part of 

all probabilistic calculations. The results of sensitivity analysis are shown as a sensitivity chart in 

the Sensitivity View. 

Sensitvity Analysis view is accessed using the Worflow bar. The sensitvity Analysis icon will be 

disabled in the workflow bar for qualitative analysis (without schedule). 

The Sensitivity view shows how sensitive or how much potential each project input parameter has 

on the main project parameters. Sensitivity measures how much a change in an input variable will 

affect the selected project parameter. For example, if a risk occurs, how much this will affect the 

project duration. This is measured as the Spearman Rank correlation coefficient. The higher the 

coefficient, the higher potential this input parameter has to affect the selected output parameter. 

 

 

RiskyProject uses six input parameters to calculate sensitivity: 

• Task duration 

• Task Start Time 

• Task Success Rate 

• Task Cost 

• Lags 

• Risks 

You can select these inputs using thee check boxes at the bottom of the chart.  

1. Select input variables 

2. Select a project 
parameter 

Tasks listed based on 
Spearman Rand order 
correlation coefficient 

Spearman Rank order 
correlation coefficient 

Task or resource 
assignment. 

Select sensitivity calculation algorithm:  rank order 
correlation coefficient or contribution to variance 
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RiskyProject has the following output parameters: 

• project duration 

• cost 

• finish time  

• success rate  

• non-schedule risk categories  

You can also select “All Parameters”. You can only measure the effects of risks on “All 

Parameters” and all non-schedule risk categories. If you select “All Parameters”, the sensitivity 

chart shows the ranking across all risk categories, using the risk weighting entered for each risk 

category.  

Examples: 

• Input parameter Task Duration and output parameter project Duration are selected. If 

task A is shown at the top of the sensitivity chart, this indicates that the project duration is 

very sensitive to the uncertainties in the task A’s duration. 

• Input parameter Risks and output parameter All Parameters are selected. If risk A is 

shown at the top of the sensitivity chart, this indicates that the all-risk categories (project 

scope, duration, cost, all-non-schedule categories) are very sensitive to the uncertainties 

caused by risk A. 

• Input parameter Task Duration and output parameter project Cost are selected. If task A 

is shown at the top of the chart, this indicates that the project cost very sensitive to the 

uncertainties in the task A’s duration. It occurs if task A has significant variable cost. 

 

• RiskyProject identifies risks based on their unique name. For example, if the risk Budgetary 

Problems is assigned to different tasks, it will be considered as one risk for the purpose of 

sensitivity analysis. RiskyProject will calculate the overall effect of this risk on the main 

project parameters. If you select only risks that are input variables, you will see critical risks 

or risks that have the greatest effect on the project schedule. In the example above, an 

assessment of Critical Risks begins with difficulties obtaining comprehensive information. 

• If an input parameter (task or risk) is not seen in the list, it means that it does not have a 

significant effect on project parameters.  

• The correlation coefficient for a risk is not the risk impact, it is the measure of relative 

importance of the risk. Correlation coefficients are used to calculate risk impact. To read 

more about this, see “How are risk probabilities, impacts, and scores calculated?” in the 

Frequently Asked Questions section. 

• In Schedule tab -> Options you can define the minimum sensitivity coefficient for the 

Sensitivity view. If a sensitivity coefficient is less than the defined value, it will be shown as 

zero in the Sensitivity view. For example, minimum sensitivity coefficient is 0.16. A sensitivity 

coefficient for a particular task’s duration and project duration equals 0.1.   Sensitivity 

coefficient for this task will be set to zero and this task will not be ranked in the sensitivity 

view. 

• If the number of tasks is greater than 4000, the sensitivity chart includes only summary 

tasks and does not include sensitivity to lags between tasks. 
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Viewing the Tornado Chart 

1. Select a project parameter from the drop-down list at the top of the chart. The name of the list 

changes according to the parameter selected. If you select All Parameters, you will only be 

able to see risk sensitivities. 

2. Select an input parameter check box located at the bottom of the chart. You can select more 

than one output parameter. The resulting correlation coefficient is the calculated as the 

sensitivity of all the selected inputs on the output parameter. 

Calculation Algorithm for Sensitivity Analysis 

There are two algorithms for sensitivity calculation: rank order correlation coefficient and 

contribution to variance:  

• Spearman's rank correlation coefficient is a non-parametric measure of statistical 

dependence between two variables. Perfect positive correlation coefficient equals +1.  

• Contribution to Variance is calculated by squaring the rank correlation coefficients and 

normalizing them to 100%. 

To select the sensitivity calculation method: 

1. Click the Analysis tab on the Workflow bar and then click Sensitivity Analysis. 

2. Click Sensitivity Calculation Algorithm. The Sensitivity Calculation dialog box opens. 

3. Select the calculation method. 

Risk Chart 

The Risk chart shows risks associated with tasks versus task duration or cost. The risk is 

expressed as: 

• task standard deviation of task duration or cost 

• maximum or minimum values 

• ranges: the difference between maximum and minimum values 

• percentiles 

In well-balanced project schedules, different tasks usually have similar level of risks. However, if 

risk associated with a task is higher than for tasks with similar duration or cost, these risks should 

be carefully analyzed and possibly mitigated. Alternatively, if the task does not have significant 

risks and uncertainties compared with other similar tasks, it may represent an opportunity to 

increase the risks and increase benefits. 
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Analyzing the Risk Chart 

1. Select the tasks that you want to display on the chart from the list on the left. 

2. Select the project parameter option (Total Task Cost or Task Duration) option at the top of 

the chart. 

3. Select a risk indicator from the Risk expressed as drop-down list. These are standard 

statistical measures such as standard deviation or percentiles. 

The example below illustrates how the Risk Chart can be analyzed using “risk zones”. If you 

visualize these zones on your risk chart, you can clearly see which tasks are outliers and merit 

further examination. 

Note: These zones are shown here purely for demonstration purposes and do not appear in the 

actual Risk Chart. 

 

3. Select risk indicator 
from this list 

1. Select tasks to 
display on the chart. 
Clear the check box 
to remove tasks from 
chart. If you unselect a 
summary task, all 
subtasks will be also 
unselected. 

2. Choose the task 
value measure: 
duration or cost 

 

This task has high level of 
risks and uncertainties 
compare to other tasks of 
similar duration or cost 

Diameter of the circle 
represents cost for duration 
value measure and duration for 
cost value measure. 
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Crucial Tasks Chart 

In addition to sensitivity charts, the results of sensitivity analysis can be shown on the Crucial 

tasks Gantt chart. 

Each task can belong to one of three categories: 

1 Red bar Tasks that have the most effect on the project duration– crucial tasks. There is 
a strong correlation between the task and project duration. 

2 Yellow bar Tasks which have some effect on project duration, i.e., there is a correlation 
between task and project duration 

3 Green bar Small or no correlation between the task and project duration 

 

To explain crucial tasks, we use the “spring analogy”. Let us assume that each task is a spring in a 

big system of springs. When we start moving springs back and forth, we find that some of them 

significantly affect the movement of the full spring system, while others do not. The amount of 

movement depends on how springs are connected to each other (links between tasks) and how 

flexible they are (the type of risks and uncertainties they have assigned).  

 

Opportunity Zone “Warning” Zone 

Risk Zone 

Balanced Project 
Zone 
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Crucial tasks may not lie on the critical path; however, in many cases, crucial tasks will lie close to the 

critical path because they are defined by the project schedule structure and risk and uncertainties 

associated with each task. Critical path calculations take into account only the project schedule 

structure. 

 

Viewing the Crucial Task chart 

 By default, the Crucial Tasks View is not shown on the Analysis Workflow bar. The Crucial 

Tasks view provides another analysis view to investigate the root causes of project uncertainty. 

1. If the Crucial Tasks View does not appear on the Workflow bar, click the All Views button. 

2. Click on the Crucial Tasks icon to open the view. Crucial tasks are color-coded, red 

indicating tasks that are most crucial. 

3. Double- click on a crucial task in the Gantt chart to view distribution charts and statistics for 

the selected task. 

4. Double- click on a risk (arrow) to view the Risk Properties of a risk assigned to a crucial 

task. 

Success Rate Chart  

The success rate or chance the task will be successfully completed is shown on the Success Rate 

Gantt chart.  

RiskyProject represents the success rate of each task using different colors, which represent a 

range of success rates. 

A task can be canceled in one of three cases: 

• if the outcome Cancel task or Cancel task + all successors occurs, this cancels the tasks 

plus all successors that have occurred; 

• if a task reaches a deadline, and action associated with deadline is set to cancel task; and, 

• if a project has reached a deadline and the task, finish time is beyond the deadline. 
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Viewing task success rates 

The Success Rate view provides another analysis view to investigate the root causes of project 

uncertainties: 

1. If the Success Rate view does not appear on the Workflow bar, click the All Views button. 

2. Click on the Success Rate icon to open the view. The calculated success rates of tasks are 

color-coded. 

• Double- click on a task with a low success rate in the Gantt chart to view distribution 

charts and statistics for the selected task. 

• Double- click on a risk (arrow) to view the Risk Properties of a risk assigned to a crucial 

task. 
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Tracking Performance 

Tracking is an important step in the project risk management workflow. You add tracking 

information in the Tracking tab of the Task Information dialog box. Tracking information is 

shown on the Tracking Gantt and Result Gantt views. 

Tracking information is not included in the current schedule (deterministic) calculation. The 

progress of summary tasks is a function of its subtasks; therefore, you cannot add tracking data to 

summary tasks. RiskyProject will calculate tracking data for summary task and complete project 

automatically. 

Calculating and reassessing tasks using tracking data 

RiskyProject uses tracking information for probabilistic calculations. The purpose of the 

calculation is to reassess the task duration, start, and finish dates based on the actual progress. As 

the deterministic current project schedule remains unchanged, you can compare your original 

estimates with the forecasted schedule. 

If a task has tracking information, new forecasted task duration and finish times are calculated. 

The results of this calculation are instantly plotted on the tracking chart as a green rectangle. The 

task’s start time is actual start time entered in the tracking data. 

The actual start time, forecasted task duration, and finish time are used for probabilistic 

calculations. If the percentage complete is greater than 0%, uncertainties in remaining duration 

are calculated using one of two methods: 

1. If you enter percent completed, but did not enter remaining duration, original low and high 

duration will be used to calculate remaining duration. RiskyProject project will calculate 

deterministic projected duration based on percent completed and status date. Then on each 

iteration, RiskyProject will calculate duration based on original statistical distribution. 

Duration for task in progress on each iteration will be extrapolated based on projected 

deterministic duration. 

Example 

Originally, a task had duration of 10 days (low duration 8 days, high duration 12 days: +- 

20%). After two days, only 10% task is completed. Deterministic projected duration will be 

20 days. As a result of the analysis, the updated duration will now be between 16 and 24 days 

(+- 20% of projected duration). 

2. If you enter the statistical distribution for the remaining duration and percent completed, 

remaining duration will be taken from the statistical distribution and added to the duration of 

the completed portion of the task. Original statistical distribution for duration will be ignored. 

Example 

Originally, a task had duration of 10 days (low duration 8 days, high duration 12 days: +- 

20%). After two days, only 10% task is completed. Duration of the completed portion of the 

task is 2 days. Remaining duration is defined using triangular statistical distribution (min 1 

days, most likely 2 days, and max 3 days). As a result of the analysis, the updated duration 

will now be between 3 and 5 days. 

If the task has risks assigned to it (global or local), the chance of the risk is recalculated based on 

the current time, when the risk occurred, and the task completion percentage.  
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• If the percentage completed equals zero, all risks are used with their original chances of 

occurrence.  

• If the percent completed equals 100, the chance of occurrence for all risks is internally set 

to zero. Although the original chance of risk occurrence is not changed, it is important to 

note that the actual outcome of risks changes.  

Tracking Results  

The probabilistic calculations always encapsulate the tracking information if it has been entered 

for a task. RiskyProject presents results of the tracking calculations in several different ways 

depending upon the view you are using to examine it. 

View How Tracking information is presented 

Project View No tracking information on the baseline schedule 

Results Gantt Tracking data is represented as green, yellow, and red bars. These 
bars represent percent completed. It can be turned on and off when 
you right-click on Gantt chart and select “Show Tracking Bars”.  

Success Rate  Gantt chart is drawn based on current (deterministic) schedule 

Crucial Task s Gantt chart is drawn based on current (deterministic) schedule 

Tracking Gantt  The Tracking Gantt behaves in the same manner as the Results 
Gantt, in addition, the percentage completed will be shown on the 
right of the bar 

Entering tracking data 

1. Select the task to which you want to enter the tracking data. 

2. Open the Task Information dialog box.  

3. Click the Tracking tab. By default, the first row should contain the actual start time with zero 

percent done. 

4. Click the row below the previous entry.  

5. Enter the status date or select it from the calendar. 

6. Enter the percentage of the task completed by the specified date. All dates and percentages 

must be consistent. For example, you cannot have a record with 60% completed before a 

record with 40% completed. In addition, you cannot have historical data with the date Jan 5, 

2004, before the record with Dec 14, 2003.  

7. Optionally enter remaining duration parameters: low, base, and high duration, and statistical 

distribution for remaining duration. If you do not enter this information remaining, duration 

on each iteration will be calculated using extrapolation of original duration.  

8. Define parameters of statistical distribution for remaining duration (see “Defining statistical 

distribution for remaining duration” for more information).  

9. You can define Actual Work for each resource assigned to a task. It can be used to calculate 

tracking information. To enter Actual Work use Resources tab of Task Information dialog 

box. 

10. Type in a comment to record actual details of work completed. You can now view the 

Tracking chart. 
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• To view any tracking information, including the percentage completed for summary tasks and 

the project, you must calculate the project. 

• Remaining duration information is used only for probabilistic analysis. 

 

Defining statistical distribution for remaining duration 

1. Select the task to which you want to enter the tracking data. 

2. Open the Task Information dialog box.  

3. Click the Tracking tab. By default, the first row should contain the actual start time with zero 

percent done. 

4. Enter low, base and high remaining duration for certain status date 

5. Right-click on ID and select Distribution for remaining duration 

6. Select the distribution from the Distribution list.  If you select Undefined, remaining 

duration will not be used for probabilistic analysis (analysis will be done using percent 

completed only) 

7. Define the distribution parameters. The Probability Density chart is automatically updated. 

You can adjust distribution parameters using the sliders. 

8. If you use a custom or discrete distribution, a grid opens. The grid will allow you to define 

points (or intervals for discrete distributions) and associated with each point (interval) 

9. If you select Normal or Lognormal, you must select the Low and High probability range 

(P1 and P99, P5 and P95 or P10 and P90). These are “cut-off” parameters; meaning that 

duration, cost, or start time cannot go beyond these values.  

Method B. Remaining Duration is 
defined. Calculate task duration based 
on uncertainties remaining duration 

Click here to define statistical 
distribution for remaining duration (you 
must define low, base, and high 
remaining duration first) 

Actual duration is 2 days 

Remaining duration from 
2 to 5 days 
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Viewing Tracking Data 

Once you have entered in the tracking information, the tracking chart is automatically updated to 

show the Current Schedule, Low, Base, High, Actual and Forecast tracking data. 

 

• Current Schedule is always visible and represents the start and finish times of the task 

as entered in the task sheet.  

• Results Low, Base, and High are calculated as part of the probabilistic calculations. Low 

is associated with minimum, P1, P5, or P10 results depending on setting defined in 

Options (Calculation tab). Base is associated with the mean. High is associated with the 

maximum, P90, P95, or P99. If the low, base, and high results are the same, only one 

base line is drawn.  

• Actual represents the actual progress of the task. 

• Forecast is generated if you do not have the results of probabilistic calculations and you 

have entered a percentage for task completion but did not recalculate the project. 

 

• To enlarge the chart, right-click and choose Details.  

• To copy the chart to the clipboard or as a  JPEG, TIFF, GIF, PNG, or BMP file, right-click and 

choose a copy command from the shortcut menu. 

 

Viewing tracking data for a task 

1. Select the task to which you want to enter tracking data. 

2. Open the Task Information dialog box.  

3. Click the Tracking tab. By default, the first row should contain the actual start time with zero 

percent done. 

4. Right-click on the chart and select Details: 

5. To copy the chart for use in presentations or reports, right-click and select one of the Copy 

commands. 

Viewing the Tracking Chart 

The Tracking chart view is the only way to see tracking results for the complete project 

1. Click the Tracking tab. In the Tracking Views group, click Tracking Chart. 

2. Select a checkbox beside the task name to see results for the specific task. If no check boxes 

are selected, the results for the entire project are shown. 
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Tracking Gantt Chart 

You can use the Tracking Gantt to view the impact that your tracking information has upon the 

project schedule. It behaves much like the Result Gantt except it shows the percent completed for 

each task. 

Below is an example of tracking information as shown in the Tracking viewing: 

 

 

 

 

RiskyProject uses the following system of colors to represent percent completed in Tracking and 

in Result Gantt. 

 

The tracking bars can be turned on and off in the Gantt chart. 

Showing the Baseline and Tracking bars 

• Right-click on the chart and choose Show Current Schedule and/or tracking Bars from 

the shortcut menu. 

 

In this example, green is 
a completed, yellow is in 
progress. 

Actual start time is later 
than the projected 
baseline start time. 

Tracking information for 
summary tasks is not 
shown. 

Baseline Gantt bars 

Risk can affect a task in 
progress 
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Chapter 7: Reporting Project Results  



RiskyProject Professional User Guide 

 

166 

 

Statistics Report for Quantitative Analysis 

Once you have completed the Monte Carlo simulation, you can quickly generate a statistics report 

for selected tasks in your project schedule. The statistics report can include histograms for Start 

Time, Finish Time, Duration, and Cost as well as a Sensitivity to Finish Timetable with a 

Tornado chart. Statistics reports can be exported to PowerPoint. 

To create a statistics report: 

1. Run a simulation on your project. 

2. Click the Reports tab. In the Report Views group, click Statistics Report. 

3. Select the activities that you want to report on by clicking the check boxes beside the activity 

names.  

 

 

To export a statistics report to PowerPoint 

1. Click the Report tab. Click Statistics to PowerPoint. Alternatively, you may click on Click 

File and then click Export -> Microsoft PowerPoint. 

2. If Microsoft PowerPoint is installed on your computer, PowerPoint will be launched, and the 

report will be generated using settings defined in Customize Report dialog. Only frequency 

and cumulative probability charts and tornado (sensitivity) plots are exported to PowerPoint.  

 

You may use your custom PowerPoint template. The template file can be defined in Customize Report 

dialog 

Click the checkbox to select the 
activity 

Customize the report 

Preview of the report 

Export report to 
PowerPoint 
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Customizing the Statistics Report 

You can modify the statistics report by adding or removing histograms, statistics, or the 

sensitivity chart as well as the general project information that is included. 

To customize the statistics report: 

1. Click the Reports tab. In the Report Views group, click Statistics Report. 

2. Click the Customize Report button. The Format Risk Report dialog box opens. 

3. In the Charts and Data group, add or remove the charts and tables that you want to include 

in the report. 

4. Modify the order in which the report elements are shown in the Order of Data tables 

5. Define bar’s color for Sensitivity to Finish Time table 

6. Define PowerPoint template for export statistics report to Microsoft PowerPoint 

7. Add or modify Header and Footer information. 

 

Modify the order of the report 
elements: in this case report will 
include: 

- Cost chart 
- Duration chart 
- Start Time chart 

Select the charts and data 
to include in the report 

Modify the report footer  

Modify the report header  

Modify bar’s color for Sensitivity to 
Finish Time table 

Define template for export 
statistics report to 
Microsoft PowerPoint 



RiskyProject Professional User Guide 

 

168 

 

The Project Dashboard  

RiskyProject includes the Project Dashboard. This view shows the results of project risk 

analysis. Project Dashboard is similar to Risk Dashboard (see Risk Dashboard) and allows to 

define the same KPIs and charts. It is also fully customizable, though comes with a different 

default configuration.  

 

By default, Project Dashboard includes: 

1. Three main project parameters for the current schedule and with risks and uncertainties (mean 

values) 

• Total Project Cost 

• Project Finish Time 

• Project Duration 

2. Three most crucial tasks 

• Effect on project cost 

• Effect on project duration 

3. Three most critical risks 

• Effect on project cost 

• Effect on project duration 

In addition, default project dashboard includes main project information, project score, number of 

simulations and percent of project completed meters. 

 

 

You can create multiple 
tabs (views) for Project 
Dashboard 

Project KPIs 

Different types of charts 

Annotation 
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Task Sheet, Results, and Profit Reports 

Use the Task Sheet view to enter and view baseline, low, base, and high task durations without a 

Gantt chart. The Results view is similar to Task Sheet View but shows the results of the 

probabilistic analysis. You can use these views for the reporting and analysis of your results. 

Profit Report view shows input data and results associated with cost, income, and profit. Report: 

All tasks  
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Task Reports 

 Use the Task Report View to display information for all tasks. This information includes: 

• General task information (task duration, start and finish time, and costs): see the General 

tab of the Task information dialog or Cost and Income view  

• predecessors: see Predecessor the tab of Task Information dialog box   

• Successors: successors are explicitly shown in Branching tab; successors are defined 

through defining of predecessors in Predecessor tab of Task Information dialog box   

• Advanced task information: task calendars, task type (Fixed Units, Fixed Duration, Fixed 

Work), Milestones, and other information (see Advanced tab of task information dialog)  

• Task notes: see the General tab of the Task information dialog  

• Local risks assigned to tasks: see Assigning local risks to tasks  

• Resources assigned to tasks: see the Resources tab in the Task Information dialog box  

• Tracking information: see the Tracking tab in the Task information dialog box  

• Statistical distributions: see the Distributions tab in the Task Information dialog box  

• Branching information: see  the Branching tab of the Task information dialog  

• Branching notes: see the Branching tab of the Task information dialog - notes for each 

branch  

• Moment of risk information: see Assigning local risks to tasks.  

 

• You may enable/disable certain information using the Customize report button in upper left 

button of the Task Report View.  

• You may export the report to comma separate file. This file can be opened in Microsoft Excel 

or other applications. To export report to comma separate file click on the Export Report 

button in the left upper corner of Task Report View.  
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Report: All Risks 

 Use the All Risks Report View shows information for all risks. This information includes: 

• General risk information (risk or issue, opened or closed risk, etc.): see Risk Register  

• Risk Properties  

• Risk assignments: global and local risk assignment to tasks or resources  

• Moment of risk information: the moment when a risk occurs during a course of the task  

 

• You may enable/disable certain information using Customize report button in upper left 

button of the Risk Report View.  

• You may export the report to comma separate file. This file can be opened in Microsoft Excel 

or other applications. To export report to comma separate file click on Export Report button 

in the left upper corner of Risk Report View.  
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Setting up reports 

You can set up how you want to print from all views with the exception of the Resources.  

1. Click File and then click Page Setup. The Page Setup dialog box opens. 

2. Enter the page margins in the Margins group box. 

3. If you want to include a footer, select the Draw Footer check box. 

4. Select the checkboxes associated with the information you want to include in the header. 

5. If you want to include a header, select the Draw Header checkbox. 

6. Select the checkboxes associated with the information you want to include in the footer. 

7. If you only want to include headers or footers on the first page, select the Draw on first page 

only check boxes. 

8. Click either the Landscape or the Portrait page orientation option. If you want a page 

border, select the Draw page border checkbox. 

9.  Adjust the height of each item (row) in the Height of one item box. 

Modify the number of columns to print from a view 

1. Select the view from the columns for view drop-down list. 

2. Select the number of columns to print from the Print box. RiskyProject will print the number 

of columns in the same order they appear left to right in the selected view. 

3. Click OK. 

Printing reports 

• Click File and then Print. 

Previewing reports 

• Click File and then Print Preview. 

Copying data to the Clipboard 

You can copy project data to the clipboard, for use in other applications; see “Copy column” and 

“Copy cut and paste selected rows” in RiskyProject Data sheets. You can also copy data, 

associated with charts to the clipboard: These charts are: 

• Simulation Results chart  

• Probability Density chart 

• Tracking chart  

• Tracking chart within Tracking Tab of the Task information dialog box 
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Images and Pictures 

You can copy or save images associated with all charts and all views with the exception of the 

Resource and Simulation Results charts. Images can be copied to the clipboard or saved as a 

JPEG, BMP, TIFF, PNG or GIF  file. 

Copying an image from a chart 

• Right-click on the image and choose a copy command. You can also copy the content of 

a view (e.g., Project view) to the file or clipboard 

Copying the content of a view 

• Click the Schedule tab. In the Format group, click Copy Picture . The Copy 

Picture dialog box opens. 
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Exporting Projects 

You can export project data to a variety of 3rd party applications. You may export data to 

Microsoft Project XML format, or MPX format. Most project management scheduling software 

supports Microsoft Project XML format. While Microsoft Project no longer saves data in the 

MPX format, it can still read this format.  

Exporting data to XML or MPX formats 

1. From the File menu, choose Export> XML or Export> MPX and enter the file name.  The 

Export Data dialog box opens. 

2. You can export either the current project schedule or the results of the analysis.  You must 

select the type of the schedule you want to export. 

 

MPX files do not support all RiskyProject data including risks. Therefore, when you export data to 

MPX file and import it back, you can lose information. 

 

Exporting Data to Excel 

You can export data from data tables directly to Excel. A new instance of Excel will be launched 

every time you export the data. To export data to Excel:  

1. Navigate to the table you want to export 

2. From the File menu, choose Export> Microsoft Excel. The Export Data dialog box opens. 

3. Choose if you want to export all table or only selected rows. Also, choose formatting of the 

header and data: fonts, background color, and border. 

4. Click OK. 

Exporting Results of Analysis to Microsoft Excel 

You can export statistical data for a group of selected tasks to the comma-separated (CSV) file for 

use in Microsoft Excel. For the selected tasks, the csv file contains the following simulation 

results: duration, cost, start and finish time, and work for all iterations. 

1. Open any view that contains task information, such as Project View, and select tasks you 

want to export 

2. From the File menu, choose Export> Statistics…  

3. Enter the file name for comma separated (CSV) file and click OK.  You can now open this 

file Microsoft Excel. 

Launching Microsoft Project 

You can launch Microsoft Project directly from RiskyProject. In these cases, a temporary XML 

file will be created and passed as an input to the Microsoft Project. RiskyProject will try to get a 

location of Microsoft Project from the system registry. If RiskyProject cannot find the Microsoft 

Project, you can browse to find it.  
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Chapter 8: Advanced Project Risk 
Management  
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Critical Path  

By default, critical path calculation is disabled to improve calculation performance. If you enable 

critical path calculation, you can view critical tasks on the Gantt chart, as well as critical path 

metrics. 

To enable critical path calculation: 

1. Click the Schedule tab.  

2. Click on Project Options. 

3. In the Calculation tab, select Calculate Critical Path. 

4. Click OK. 

To view critical path and critical path metrics: 

1. Open the Project view or Result Gantt view. 

2. Right-click on Gantt chart and click on Show Critical Path 

3. Right-click on the column header for the list of tasks and insert column with critical path 

metrics: Late Start, Late Finish, Total Slack, Free Slack, or Criticality index. You can also 

select Critical Path – cur. schedule, which is an indicator that this task is on the critical path. 

 

 

• You can change color for the critical path in Schedule -> Format Gantt Chart, under Settings 

and Options. 

• Critical path may slow down Monte Carlo simulation. You may disable Critical Path calculation 

if don’t need to analyze critical path 

Right-click on the Gantt 
chart to enable “Show 
Critical Path” 

Critical path is shown 
using different colors 
(default red) 

Criticality index: how 
many times this task was 
on the critical path 

Total Slack and Free 
Slack 
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Critical Path Metrics 

The following metrics will be calculated if you enable critical path: 

1. Total Slack: amount of time that a task can be delayed without delaying any successor tasks. 

If the task has no successors, free slack is the amount of time that a task can be delayed 

without delaying the entire project's finish date. 

2. Free Slack: amount of time that a task can be delayed without delaying any successor tasks. 

If the task has no successors, free slack is the amount of time that a task can be delayed 

without delaying the entire project's finish date. 

3. Late Start: the latest date that a task can start without delaying the finish of the project. This 

date is based on the task's start date, as well as on the late start and late finish dates of 

predecessor and successor tasks, and other constraints. 

4. Late Finish:  the latest date that a task can finish without delaying the finish of the project. 

This date is based on the task's late start date, as well as on the late start and late finish dates 

of predecessor and successor  tasks, and other constraints.  

5. Criticality Index: how many times this task was on the critical path. Criticality index is 

calculated as a result of Monte Carlo simulation. For example, if total number of simulation 

was 1000 and particular task was 640 times on the critical path, criticality index for this task 

would be 64%. Criticality index is important because task be not on a critical path for 

deterministic analysis but may have risks with high probability and/or impacts assigned to 

them. In such cases, it will have high criticality index. 
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Schedule Diagnostics 

Schedule diagnostics is a detailed analysis of project schedule. Using Schedule diagnostic tool, 

you can: 

1. Find issues with your project schedule, which would affect results of risk analysis as well as 

affect integrity and quality of the schedule. RiskyProject allows you to perform 21 tests and 

identify tasks, which such issues. 

2. Perform a DCMA 14 point Schedule Assessment. DCMA 14-point Schedule Assessment is a 

project management guideline established on 14 metrics that provide the possibility to make a 

qualitative and quantitative evaluation of the schedule. It was developed by the US. Defense 

Contract Management Agency (DCMA) for the purposes of the defense industry but is used 

in other industries as well. DCMA 14 point Schedule Assessment description can be found at: 

https://www.dcma.mil/Portals/31/Documents/Policy/DCMA-PAM-200-1.pdf?ver=2016-12-

28-125801-627. 

3. Review schedule metrics, such as number of tasks, links, summary tasks, resources, etc. 

To perform schedule diagnostics: 

1. Click the Schedule tab.  

2. Click Schedule Diagnostics to run the diagnostics. When completed, the diagnostics results 

will open in the Schedule Diagnostics pane.   

Configuring Schedule Diagnostics 

RiskyProject can perform up to 21 tests on a project schedule. By default, all of them are enabled. 

You can enable or disable tests, define their severity, as well as define other parameters 

associated with tests.  

To configure schedule diagnostics: 

1. Click the Schedule tab.  

2. Select Schedule Diagnostics. 

3. Click on Configure.  

4. Enable or disable tests you want to run. 

5. Select color indicating relative severity level of each test. 

6. Select number of days for 2 tests: “Task duration is greater than …” and “Task has float 

greater than …” 

7. Click OK. 

 

DCMA 14-point Schedule Assessment 

DCMA 14 point Schedule Assessment is performed automatically when you click on Schedule 

Diagnostics. For some tests, additional settings are required: 

1. For DCMA-6, DCMA-7, DCMA-12, you may need to enable critical path calculation: in 

Schedule -> Project Options, go to Calculation tab and select Calculate Critical Path.   

2. For DCMA-9, you may need to define project status date. Schedule -> Project Settings. 

https://www.dcma.mil/Portals/31/Documents/Policy/DCMA-PAM-200-1.pdf?ver=2016-12-28-125801-627
https://www.dcma.mil/Portals/31/Documents/Policy/DCMA-PAM-200-1.pdf?ver=2016-12-28-125801-627
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3. For DCMA-13, right-click on row ID and click on Milestone for DCMA 13-CPLI and then 

select milestone which is required for this test. 

 

• You can double-click on each DCMA test and view detailed information about particular metric 

as part of RiskyProject Help System. To view Help you must be connected to Internet. 

• You can copy test results to clipboard: right-click on row ID and click on Copy 

• You can see issues associated with DCMA tests within list of issues (top listbox) by clicking 

on the particular DCMA test 

 

 

Viewing Tasks with Issues within a Project Schedule 

 You may view tasks associated with particular issue or particular DCMA test: 

1. Open any view that has project schedule, such as Project View or Gantt Result view.  

2. Click the Schedule tab.  

3. Select Schedule Diagnostics. Diagnostic of the schedule is performed.  

4. Click on DCMA test and see issues associated with this test in top list box.  

5. Select any other issues from the top list box. 

6. Click OK. 

7. Task with selected issues will be highlighted. 

You can clear highlighted tasks by clicking on Clear Selection and Close with Diagnostics 

dialog box or by clicking on Schedule -> Zoom and Find -> Clear (eraser icon ) 
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Highlighted tasks identify issues. 

Select one or multiple issues, click OK 
and view tasks associated with issues 
within a project schedule 

Schedule metrics 

Configure tests to be 
executed 

Close dialog and clear selected 
tasks associated with issues 
within a project schedule 

DCMA 14 points 
Schedule Inspection 

Double-click on a test ID 
to view description of the 
test in RiskyProject Help 

These two tests require 
additional settings 
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Analyzing Risk Mitigation Efforts with Multiple 
Baselines  

RiskyProject allows you to create multiple baselines of the same project. Multiple baselines can 

be used during the planning stage, to determine the effects your risk mitigation efforts or response 

plans will have on the project’s overall cost, finish time, and success rates. You can save up to 10 

baseline versions of a project. 

For example, once you have created your project and run a risk analysis on it, you can create a 

baseline. When you create the baseline, you can select a level of certainty (percentile) that you 

have decided to use for management purposes. You can then model the effects of mitigation 

efforts or risk response plans. This modeling may include adding additional activities with 

resources and costs as well as the closing or minimizing of risks. You can then create a baseline 

of the “mitigated” project plan and compare it with the unmitigated baseline. In this way, you can 

decide you risk response plan as defined in PMBOK: avoid, transfer, mitigate, or accept. 

Results of analysis for project and tasks can be presented as cumulative probability plots. If you 

have multiple baselines with results of analysis you can compare uncertainties using multiple 

cumulative probability plots on the same charts. 

Creating a baseline 

Once you have run a simulation on your project, you can save the results as a baseline.  

1. Click the Schedule tab. In the Baselines group, click Set.  

2. Enter a name for the baseline. By default, it is assigned “Baseline #_” 

3. Select the type of results (Low, Base, High, specific percentile, or Current Schedule and 

Results of Analysis) that you want to use for your baseline. 

4. Click OK. 

5. If you are using probabilistic results for the baseline, you are prompted to disable all risks and 

uncertainties from the schedule. Choosing Yes will in effect create a deterministic baseline 

out of the results you selected. Choosing No will mean that all risks and uncertainties will 

remain. If you calculate this baseline again, this may cause a double count of the risks and 

uncertainties.  

 

  

Baseline will include the results of 
analysis. It can be used to view multiple 
cumulative probability plots on the same 
chart 

Save only a deterministic schedule, 
results of analysis are not saved. 
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Setting the current baseline 

The current baseline is the project data that appears in RiskyProject. You can change current 

baselines as part of you planning efforts. 

1. Click the Schedule tab. In the Baselines group, click Manage. 

2. Select the check box beside a baseline to set it as the Current Baseline. 

3. Enter a name for the baseline. By default, it is assigned “Baseline #_” 

 

Right-click on a baseline to copy baseline data to the clipboard or delete it. 

 

Viewing multiple baselines 

Click the Schedule tab. In the Baselines group, click Manage. The Manage Baselines dialog box 

opens. 

 

In this example, we can see the differences between two baselines due to mitigation efforts. 

Particularly cost associated with baseline “Budget Mitigation” is lower than cost of “Baseline 

#1”. 

Using this dialog box, you may set a previously saved baseline as current schedule. The baseline 

will replace currently active schedule. 

Converting a baseline to a current schedule 

1. Click the Schedule tab. In the Baselines group, click Manage. The Manage Baselines dialog 

box opens. 

2. Select a baseline you want to make current using a check box on the left from baseline name. 

3. Click OK. 

Comparing pre and post-mitigation baselines 

1. Open the Risk Register view (Risk tab of the workflow bar) 

2. Click the Configure Pre and Post Mitigation button. 

Different baselines on project and task 
cumulative probability plots will have 
different colors. 

Double-click to update color. 



RiskyProject Professional User Guide 

 

183 

3. Select your baseline Pre and Post Mitigation baselines.  

 

Probabilities, impacts, and scores for multiple baselines 

You can view risk mitigation efforts for any individual risk using the risk matrix. To view risk 

mitigation for an individual risk, you must have multiple baselines with various mitigation efforts 

for this risk. Mitigation efforts for the risk can be: 

• Reducing the chance of occurrence or outcome of the risk 

• Changing the outcome 

• Changing the mutually exclusive alternatives associated with the risk 

• Changing the project schedule, e.g., executing a number of additional activities on the 

specific baseline 

• All the above 

Viewing a risk for different baselines 

1. Open the Risk Register view. 

2. Double- click on Risk ID. The Risk Information dialog box opens.  

3. Click the Risk in Different Baselines tab. 
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Probabilistic and Conditional Branching  

Probabilistic and conditional branching can be used in project planning to model projects in 

which there are two or more possible activities that may succeed an activity, but a decision 

regarding which activity will be taken has not yet been made.  

Probabilistic Branching 

Probabilistic branching allows you to calculate expected values (EV) for the project given that 

you have not yet been able to determine which branch will be executed. This type of branching is 

useful to calculate the expected value for the project cost given the current uncertainty in the 

project plan. Probabilistic branching is defined by the probability (chance) that a certain branch 

will be executed or not executed. 

Conditional Branching 

Conditional branching is useful when you need to determine expected values of the project under 

certain conditions. For example, what would be the cost of the project if certain activities will not 

proceed? What will happen if their predecessors take longer than 100 days to complete? 

Conditions can be related to: 

• Task duration 

• Task Cost 

• Task Start Time 

• Task Finish Time 

 

 

 

 

Creating Probabilistic and Conditional Branching 

1. Open the Task Information dialog box for the task in which you want to create the branch. 

2. Click the Branching tab. 

3. For each successor define the Condition and Value that will cause the successor to be 

cancelled. The type of value you can select is dependent upon the condition you select. 

4. Select the Action that will occur when a successor is cancelled or executed. 

5. Select the This task and all successors are always executed even if cancelled by 

predecessors check box if you want to force this task and all successors to be run in the 

simulation even if its predecessors are canceled. 

A task can have multiple predecessors. These predecessors may belong to different branches 

and can be canceled due to the results of the branching. Select the check box if you want to 

Green lines instead of blue 
are used to current Gantt bar 
if branching is defined 

These tasks will be executed based on 
probabilistic and conditional branching. 
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force this task and all successors to be run in the simulation even if its predecessors are 

canceled. 

 

6. Click OK. 

Example of Conditional and Probabilistic Branching 

 

 In this case, Task 1 has three successors: 

1. Task 2 will be canceled in 40% of the time. Task 2’s success rate will be around 60%. This is 

example of probabilistic branching 

2. Task 3 will be canceled if duration of Task 1 is greater than 5 days. Task 2’s success rate 

depends on the statistical distribution for duration of Task 1. This is example of conditional 

branching. 

3. Task 4 and all its successors will be canceled in 60% of cases. Task 4 success rate will be 

around 40%. This is example of probabilistic branching. 
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Importing Data from Microsoft Excel 

Importing Chances and Outcomes of the Risk from Microsoft Excel 

You can import risk chances and outcomes from Microsoft Excel files. You can use this, to link 

the chances and outcomes of a particular risk to cells in an Excel spreadsheet. If you link chance 

and outcomes to an Excel spreadsheet and then make changes to that spreadsheet, RiskyProject 

will automatically update these values when you open the linked RiskyProject file and click the 

Refresh Data (Tools tab) button. 

To setup integration between RiskyProject and Excel: 

1. Setup a connection to an Excel spreadsheet. To set up a connection to an Excel 

spreadsheet, on the Tools tab, click the Connect/Disconnect button. You can visualize the 

Excel spreadsheet with the Visualize Excel button. 

2. Open any view in which you can perform risk assignment. For example, the Risk tab of 

Task Information dialog box. 

3. Right-click on an outcome or chance field. Select Link to Excel Cell from the shortcut 

menu. 

4. The Excel spreadsheet will open. Select a cell within the spreadsheet. In the dialog box, 

click the button to link the selected cell to an outcome or chance field. 

 

 

Probability and impact of risk is defined as a percent, e.g. for 25% in Excel use  25 not 0.25. 

 

 

Importing Risk Register from Microsoft Excel 

You can import the complete risk register from Microsoft Excel. To do so, you need to map Excel 

fields to RiskyProject fields. 

Use this button to link the cell and go 
back to RiskyProject. 
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To import risk register from Microsoft Excel: 

1. Make sure that your Risk Register has all risk properties defined to present all data in Excel. 

Use the Default Risk Properties dialog to create any custom properties.  

2. Ensure your Risk Register contains all columns to present these properties. Very often Excel 

spreadsheets contain risk probabilities and impacts for specific categories. In this case, you 

need to define the column: for example, Impact: Cost, or Probability: Quality. 

3. Click on File > Import > Import Risks from Excel 

4. Select the import type of risk data that will be imported:  

• Risk Register Excel File: where each row is a risk 

• Risk Mitigation Excel File: where each row is mitigation plan assigned to particular 

risk; such file must have mitigation name and associated risk as a separate columns; 

RiskyProject will associated each mitigation plan with a particular risk based on Risk 

Name or Risk Unique ID; you must import Risk Register Excel file first before 

importing Risk Mitigation Excel File. 

• Risk Status Excel File: historical data about risk probabilities and impacts for 

individual categories and combined for call categories.  Similarly to Risk Mitigation 

Excel File RiskyProject will associated each risk status record with a particular risk 

based on Risk Name or Risk Unique ID; you must import Risk Register Excel file 

first before importing Risk Status Excel File. 

5. Browse and select Excel File; click OK 

6. Map Risk Properties to Excel Fields dialog opens. 

7. If you have done mapping for this file before, verify that mapping is correct for the selected 

Excel file and click OK. If you did have not done this mapping before, you need to enter the 

mapping information.  

8. To enter mapping information: 

• click on the Excel Field for a particular risk property 

• right-click and select “Link Excel cell” from dropdown menu; Excel will be launched 

• in Excel, select the header or first cell with the data of the appropriate column 

• repeat this process for all risk properties 
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• If you define probability and impact of risk as a percent in the project schedule for 25% use  

25 not 0.25. 

• If, in Excel, there is a column from Threat/Opportunity, define how Threats and 

Opportunities are named in Excel; for example, Excel may label a threat as “T” and an 

opportunity as “O”. Use the Threat and Opportunity data type for risk properties in 

RiskyProject to map such properties in Excel. 

• If you are entering mitigation plans, which are defined as list of strings on an Excel 

spreadsheet, use the Mitigation Actions risk property. For example, an Excel spreadsheet has  

a column entitled Mitigation Action Plans. It could be a number of lines for one risk in each 

cell of the Excel spreadsheet, for example Action 1, Action 2, … If you map a risk property 

with data type “Mitigation Actions risk property” to this column, all individual actions will be 

imported as separate mitigation plans. 

Define Excel column associated with 
risk property. 

Click here  save mapping in system 
registry 

Define how Threats and 
Opportunities are called in Excel 
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Schedule Consolidation 

Some project schedules can include very significant number of activities and resources. To 

increase the performance of Monte Carlo simulations, very large schedules can be consolidated or 

condensed. When consolidation is performed, the number of activities will be reduced. 

RiskyProject will apply risks, resources and costs to consolidated activities accordingly. Tasks 

with actuals (tracking information), deadlines, and with different calendars cannot be 

consolidated. As a result, consolidated schedule will be equivalent to the original schedule: the 

same duration, start and finish times, cost, work, etc. RiskyProject will include notes to the 

consolidated activities with information about original activities. Consolidated task name will 

include names of original activities. 

There are two ways to consolidate schedule: 

1. Consolidate sequential activities, if they belong to the same summary task. Consolidated 

activities must have only one successor and predecessor and do not have constraints.  

 

 

 

 

 

2. Consolidated summary tasks and subtasks, if all of them have the same start and finish times.  

 

 

 

 

 

Before Consolidation 

After Consolidation 

Before Consolidation 

After Consolidation 
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To perform consolidation: 

Click on Tools -> Schedule Consolidation. You will be presented with number of tasks before 

and after consolidation. 

 

• In XER import RiskyProject will offer consolidation if number of activities greater than 

20,000. 

• It is recommended to have original schedule before consolitation. If you perform 

consolidation but want to restore original schedule, click on Ctrl + Z. 
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Additional Information 
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Frequently Asked Questions 

What is the difference between qualitative and quantitative risk analysis in RiskyProject? 

If you do not have a schedule for your project, RiskyProject will only perform qualitative risk 

analysis. However, if you add a schedule by either adding activities or importing a schedule, 

RiskyProject automatically switches to quantitative analysis. You may switch between qualitative 

and quantitative analysis by adding or removing a project schedule. 

How do I assign risks to tasks? 

You can assign risks to task using four methods in RiskyProject.  

1. Risk Drag & Drop View: this is the preferred method for project risk assignment. You 

simply select one or many risks on the left page and drop them on the task. 

2. Risk Register: if you are using the Risk Register, you can assign a risk and mutually 

exclusive risk alternatives to tasks by double-clicking on the risk in the risk register and 

assigning tasks to the risk in the Assign to tasks or resources tab. 

3. Risk Assignment View: double-click on a risk ID in Risk Assignment view and use the Risk 

Assignment Information dialog to re-assign risks to task or resources or make them global.  

4. Risk Tabs on Task Information and Resource Information dialog boxes: you can create 

and assign local risks to a task using this method. This is the preferred method if you want to 

assign a few different risks to separate tasks or resources. 

How should I use the risk register? 

You should use the risk register as the central place to define your project’s risk breakdown 

structure. Once you have added the risks, from the risk register you can: 

1. Add risk properties (date created, recorder, owner, etc.) 

2. Assign risks to tasks and resources 

3. Sort and filter risks 

4. View risk status, including results of mitigation efforts. Risks can be opened and closed, risk 

and issues, or threats and opportunities. 

When should I correlate risks and how do I do it? 

Risk correlations are useful when the two risks are likely to occur together. For example, the risk 

“bad weather” is correlated with the risk “late delivery of materials”. You can create risk 

correlations in the Correlations tab of the Risk Assignment Information dialog box in the Risk 

Assignment view, as well as risk tabs for tasks and resources.  

RiskyProject uses only strong correlation between risks. If Risk 1 has chance of occurrence is 

10% and Risk 2 chance of occurrence is 20% and both risks are correlated, Risk 1 will always 

occur when Risk 2 occurs, but Risk 2 may occur when Risk 1 does not occur.  

How are risk probabilities, impacts, and scores calculated for quantitative analysis? 

Risk probabilities, impacts, and scores are calculated the following way: 

1. RiskyProject tracks the impact of each risk on each project parameter at each iteration of the 

Monte Carlo simulation. It is performed using absolute units. For example, in the first 

iteration Risk A caused a delay of 2 days. 
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2. RiskyProject also calculates duration, cost, success rate, finish time, and work on each 

iteration. 

3. RiskyProject calculates the Spearman Rank Order correlation coefficient between duration 

impact for each risk and project duration. This coefficient is presented in the Sensitivity view. 

4. Correlation coefficients are not yet a risk impact. They only show how the risk affects the 

project. If a correlation coefficient is low, and the risk is not correlated with duration, it 

means than some other factors affect duration other than this risk. To become an impact, the 

correlation coefficient must be normalized. For example, you have a schedule, which has 

only one risk with an outcome of an increase in duration of 2 days. The correlation coefficient 

will be 100% because the schedule does not have any other uncertainties. Now change the 

risk outcome to 100 days. The correlation coefficient again will be 100%. Risk impact takes 

into account absolute value of duration increase, cost increase, etc. If the duration increases 2 

times when compared with the original project schedule, the normalization coefficient is 1. 

Otherwise, the normalization coefficient will be greater or less than 1. Impact equals 

correlation coefficient multiplied with the normalization coefficient. 

5. Risk probability is calculated based on the chance of risk for each assignment. If a risk has 

only one assignment, calculated probability equals input chance. If the risk has multiple 

assignments which are not mutually exclusive alternatives, the probability is calculated by 

combining risk results of each iteration as shown in the example: 

 

Risk 
Assignment  

Iteration 1 Iteration 2  Iteration 3 Iteration 4 Iteration 5 

Assignment 
to Task 1  

occurred   occurred  

Assignment 
to Task 2 

 occurred  occurred occurred 

 

Combined probability will equal 80% 

6. Risk score equals probability multiplied by impact.  

7. For risks affecting All Parameters (combination of duration, cost, safety, quality, etc.) 

calculated impact is calculated using impact for each risk category, multiplied on relative 

importance of risks for this category. For schedule related risk categories risk impact on 

finish time and success rate will not be used to calculate risk impact. For schedule related risk 

categories, the risk impact on finish time and success rate will not be used to calculate risk 

impact. This relative importance can be seen on the Categories and Outcomes dialog (Risk 

tab). 

How can I update a project schedule from Microsoft Project and keep my assigned risks?  

You may use the RiskyProject toolbar or ribbon in Microsoft Project to transfer a schedule from 

Microsoft Project to RiskyProject. When you use the RiskyProject toolbar or ribbon, your 

schedule in Microsoft Project will be associated with risks and uncertainties defined in 

RiskyProject. Please read “RiskyProject for Microsoft Project” for more information. 

When you import (click Import on the File menu) an updated schedule from Microsoft Project, 

RiskyProject gives you the option of completely overwriting the existing schedule or updating the 
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existing schedule with new data in Microsoft Project, while retaining global and local risk 

assignments. This is useful if you originally exported the schedule and assigned risks to the 

project. RiskyProject keeps unique task IDs from Microsoft Project.  

How do I rank schedule related and non-schedule risks together? 

RiskyProject calculates the relative impact of both schedule-related and non-schedule risks in 

such a manner as to provide a valid comparison of both types of risks in regard to potential 

impact on the project. The basis of this comparison is the relative weight (importance) that you 

assign to each risk category. You can view the impact (threat or opportunity) of each risk in the 

Risk Matrix view and Risk Register view. In the Risk Tabs of Task Information dialog box and 

Resource Information dialog box you will find an impact of the risk on all parameters under “All” 

(Calculated impact on all project parameters) column. 

How do I plan a risk response? 

Risk response planning is done in the Mitigation or Response view in the Risk workflow. Risk 

responses are the duration and cost effects of activities that will occur if a risk occurs. These 

activities can be modeled in a similar manner as a risk with an outcome and result. Risk 

Mitigation and Response view can be useful, if you have many risks causing the same response.  

You assign the risk response to a risk as a risk outcome “Execute Response Plan” and the 

response plan as the result. 

For example, you have two risks “Problem with supplier” and “Problem with the component” that 

will initiate the same response “Replace Component”. If you define “Replace Component” and 

assign it to both risks using the risk outcome “Execute Response Plan”, the response plan will be 

executed only once even if both risks occur together. 

How can I compare mitigation efforts using different baselines? 

There are two methods to view the results of your mitigation planning against the original 

schedule. To compare the results, first create a baseline using the results from the original 

schedule. Model the planned mitigation efforts in your current schedule taking into account any 

additional activities and costs that the mitigation efforts will entail (these may also introduce 

additional risks)  

In the risk register, use the Configure Pre and Post Mitigation button to select the original 

baseline as the pre-mitigation and the current schedule as the post-mitigation. The risk register 

will display the risk impact and score of each risk for the pre and post mitigation schedules. 

In the Manage Baselines dialog box, you can compare major project parameters of the two 

schedules: Duration, Finish Time, Cost, and Success Rate. 

How many iterations are required in a simulation? 

The number of iterations required depends upon the risks you have assigned to the project. 

Normally, the minimum number of iterations is 200 and can be adequate on small, non-strategic 

projects. However, if you have risks that have a very low chance of occurring, but have a 

potentially large impact, the results will not account for this risk unless you run sufficient 

simulations. For example, your project has a 0.5% chance of being cancelled due to political 

instability. You must run at least 200 iterations, just to ensure just to ensure that the simulation 

runs a single occurrence of this risk. To adequately model these types of risks, we recommend a 

minimum of 600 simulations. 
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When should I use a risk event instead of a statistical distribution? 

RiskyProject supports both methods of risk analysis. Statistical distribution or uncertainty 

modeling is recommended in projects where there is strong and analogous historical data that is 

supported by expert opinion. 

If this data does not exist, risk event modeling will normally result in a more accurate assessment 

of your project risk and uncertainty. In addition, risk events make it much easier to identify 

critical risks through sensitivity analysis as most if not all uncertainty in a project is caused by 

risk events. Without risk event modeling, you will need to do a root cause analysis to identify 

which risks are causing the uncertainty in your project. 

What are mutually exclusive alternatives for risks and how does RiskyProject calculate 
them? 

Mutually exclusive alternatives are used to calculate alternate outcomes for the same risk event 

that cannot occur at the same time. An alternative risk is similar to using a Boolean “OR” 

statement. Only one risk alternative can occur at the same time. For example, if you have a fire 

risk, the fire could be minor or major each with different outcomes. They are the same risk, but 

unlike other risk events, these alternatives cannot occur at the same time. 

In this example, the risk Fire has two alternatives: 

Chance  Outcome  Result 

10% Fixed delay 2 days 

2%  Relative delay  45% 

When the simulations are run, there is a 12% chance that the risk Fire will occur. 10% of the time 

the outcome of the minor fire will be calculated, while 2% of the time the outcome of a major fire 

is calculated, but they are never calculated during the same simulation.  

What are risk templates and how do they differ from the risk register? 

A risk template is a flat list of risks that have been assigned a chance, outcome, result, and 

distribution. The risk templates can be imported into risk views where you can quickly assign 

them as global, task, or resource risks. In this way, risk templates provide a quick way of loading 

risks into your project. 

A risk register is a risk management tool that allows you to create, assign, and track risks with 

greater detail than any of the other risk views. The register allows you to add risk properties, 

assign ownership, convert risks to issues, and view pre and post mitigation risk scores.  

You may share a risk register between different computers in your organization by saving it to the 

corporate server. Using RiskyProject, you may establish simple an easy-to-use corporate risk 

management system: 

1. Create a risk register and save it on the corporate server (*.alr). 

2. Load the risk register file into a new project. 

3. RiskyProject will ensure that different users do not overwrite the corporate copy of the risk 

register through the built-in locking mechanism. 

How do I use the probabilistic cash flow as part of my product lifecycle management? 

Probabilistic cash flow view is used to show the original, actual, and simulation results of cash 

allocation during monthly, bi-monthly, quarterly and yearly periods. In RiskyProject, you can 

apply risks and uncertainties to cost and income. As a result, the probabilistic cash flow view can 
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have both a negative (cost) and positive (income) cash flow.  This is a useful analysis for project 

lifecycle management, where you are trying to determine both the cost associated with product 

development and the income associated with sales of the product. 

When should I use probabilistic calendars? 

Probabilistic calendars are useful for modeling uncertain scheduling conditions such as weather. 

If you know from experience that during the project there is a 30% chance that you will be 

operating under poor weather conditions that will restrict working time, you can create a calendar 

that reflects this. Using the probabilistic calendars, you can then run this calendar 30% of the time 

to realistically model weather risks. 

How do I customize risk outcomes? 

You can add or customize non-schedule risk categories and outcomes (cost and schedule 

outcomes are hard coded and cannot be edited). RiskyProject provides several default risk 

categories and outcomes (Legal, Safety, Quality, etc.). Click the Risks tab, and in the Settings 

group click Risk Categories and then the Outcomes tab. You may use the Risk to add or modify 

non-schedule risk categories and outcomes. You may also enable or disable certain outcomes, so 

they are not shown in the dropdown list when you do risk assignments. 

We recommend that you modify the default risk outcomes so that they can be used across your 

organization. These outcomes are saved in the system registry and can be used for all projects. 

I imported a schedule from Microsoft Project to RiskyProject. Are there any potential 
differences? 

In most cases, if you import your project schedule from Project, the projects in both applications 

will be identical. However, there are specific cases that may cause slight differences: 

1. RiskyProject currently does not support split tasks. However, RiskyProject will import work 

calculated using split tasks. RiskyProject does not have task usage or resource usage views. 

The note for the task will be generated, then the task imported to RiskyProject as a split task. 

2. RiskyProject calculates task duration differently than Microsoft Project in cases where 

resources that have different calendars are attached to the same task. However, even in these 

cases, start and finish times of the tasks will be identical. 

3. RiskyProject does not support overtime rates. 

4. RiskyProject does not import resource groups. Each resource is imported individually. 

5. RiskyProject does not support the earned value method “Percent work completed”. Instead, it 

uses “Percent completed”. 

How can I define opportunities versus threats? 

When you create a risk assignment, define a negative outcome result that translates to an 

opportunity. For example, fixed delay –2 days indicates that if the event occurs, the task will 

require 2 fewer days to complete and is an opportunity.  

How can I import low, base, and high duration from Microsoft Project? 

Use the following fields in Microsoft Project to represent Low, Base, and High durations: 

1. Duration1 for Low Duration 

2. Duration2 for Base Duration 

3. Duration3 for High Duration 
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Please remember that Duration1 < Duration2 < Duration3 

Why is the high result for duration or cost for the current schedule different from the high 
results? 

Low and high estimates for inputs, which you define for each task, are different from low and 

high results because their actual meanings are different.  

1. You define the definition for low and high estimates for duration, cost, income input in the 

Distributions tab of Task Information dialog box. This can be interpreted differently 

depending upon what distributions you select. By default, low distribution inputs are P10 and 

high is P90. 

2. You define the definition of low and high results for duration, cost, and income in the 

Calculation tab of the Options dialog box as a percentile of statistical distribution obtained 

as a result of your analysis. By default, low distribution results are P10 and high are P90. 
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Glossary 

Actual Cost Cost that is accrued during a course of task or project. RiskyProject 

calculates actual cost automatically based on tracking data. Alternatively, 

you can enter this cost manually if you uncheck a flag in Options (cost 

tab). 

Actual Start Date:  The start date of a task based on tracking data. Actual start dates can be 

input using the Tracking tab in Task Information dialog box. The 

Result Giant chart takes into account the actual start date. In addition, the 

Gantt chart shows actual start dates. 

Assignment (for 

Resources) 

Resources are assigned to particular tasks. Each assignment is defined by 

a resource name and the number of units allocated for the task. 

Assignments are defined in the Task Information dialog box. 

Assignment (for 

Risks) 

See Risk Assignment 

Assignment Units The percentage of a work resource’s time assigned to a task. 

Base Calendar A calendar that can be used as a project and task calendar that specifies 

default working and nonworking time for a set of resources. Differs from 

a resource calendar, which specifies working and nonworking time for an 

individual resource. 

Baseline Project 

Schedule 

(Baseline) 

The baseline project schedule is a snapshot of the project schedule. 

Baselines are saved without taking into account risks, uncertainties, and 

tracking information. RiskyProject uses an unlimited number of project 

baselines. Current baseline project schedules are shown in the Project 

view. The current baseline name is shown in the status bar. You may 

create baseline, restore baseline, or delete baseline. Baselines are very 

useful for analysis of mitigation efforts. 

Budgeted cost Cost associated with current project schedule. 

Calendar Calendar is a set of working and non-working times and days. Calendars 

are defined in Working Time dialog box. RiskyProject uses project, 

task, and resource calendars. Any number of calendars can be created. 

Chance of Risk 

Occurrence 

Chance that the selected risk, assigned to the task or resource or 

particular risk alternative, would occur. In this document, the chance of 

risk occurrence usually refers to the input chance for a risk assignment. 

Risk probability refers to the calculated probabilities for this risk, which 

can be different. 

Closed Risk or 

Issue 

Risks or issues that previously affected the project, but were analyzed, 

addressed, mitigated, and no longer affect the project. You may switch 

between opened and closed risks in the Risk Information dialog of Risk 

Register. 
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Constraint A restriction that is set on the start or finish date of a task. If you enter a 

new task by specifying parameters (task name, duration, etc.) rather than 

start and finish dates, RiskyProject does set a constraint and the task will 

start and finish as soon as possible. If you specify a start date, a 

constraint is set to Start No Later Than. If you specify a finish date, a 

constraint is set to Must Finish On. You can change or remove 

constraints in the General tab of the Task Information dialog box. 

Constraints for start or finish dates are indicated using an orange 

background in all views.  

Convergence In the process of Monte Carlo simulations, RiskyProject monitors mean 

and standard deviation of project duration. RiskyProject then calculates 

relative difference between standard deviations of project duration in two 

consecutive simulations. If convergence monitoring is turned on, the 

simulation will stop, when this relative difference is less than the 

predefined value within a predefined number of simulations. The same is 

done for mean. Convergence parameters are set in the Options dialog 

box, Calculation tab. Convergence allows you to minimize the number 

of simulations and reduce calculation time, if a sufficient amount of 

information is collected. 

Cost Per Use  Per-use costs are one-time fees for the use of a resource, such as 

equipment. Per-use costs never depend on the amount of work done. 

Instead, they are one-time costs that are incurred every time that the 

resource is used. Although a per-use cost for a work resource depends on 

the number of assignment units used, a per-use cost for a material 

resource is applied only one time. Cost per use is defined in Resource 

View. 

Criticality Index How many times this task was on the critical path. Criticality index is 

calculated as a result of a Monte Carlo simulation. For example, if total 

number of simulation was 1000 and particular task was 640 times on the 

critical path, criticality index for this task will be 64%. 

Crucial Task  A task that has the most potential to affect project duration. Crucial tasks 

are shown as red in the Crucial Task View. RiskyProject calculates the 

Spearman Rank Order correlation coefficient and it as an indicator of 

how task duration affects project duration. 

Cumulative 

Probability Plot  

This chart plots cumulative probability versus the value of a variable. A 

cumulative probability chart allows you to analyze the risk associated 

with a variable. All cumulative probability charts in RiskyProject are 

interactive. By moving the slider, you can determine what is the chance 

that the project will be completed within a given period; or what is the 

chance that the cost of the project will be within budget? Cumulative 

probability charts can be combined with frequency charts using the same 

variable. 
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Current Schedule  The deterministic project schedule that is currently active and used for 

probabilistic calculations. In most cases, it is the original project 

schedule you created or imported from other project management 

software. You may also set a baseline, which you previously created. See 

“Baseline Project Schedule (Baseline)” for more information. 

Duration  The total span of working time required to complete task or the whole 

project. Task duration can be input in months, weeks, days, hours, and 

minutes, as it is specified in Options dialog box (Duration tab). 

Normally, duration is calculated in hours. Duration is calculated using 

your current calendar. 

Earliest Project 

Deadline 

See Project Deadline 

Effort Driven 

Scheduling 

The duration of a task shortens or lengthens as resources are added or 

removed from a task, while the amount of effort necessary to complete a 

task remains unchanged 

Event Chain 

Methodology  

A method of defining and analyzing uncertainties in time related 

business and technological processes. According to this methodology, 

most uncertainties are driven by stochastic events or risks. Single events 

can precipitate other events and create event chains. RiskyProject 

implements this methodology for project management problems. 

Finish date  The date the task is scheduled to be completed. The start date is 

calculated based on successors, predecessors, constraints, and task 

durations using the current calendar. 

Fixed Duration 

Task 

A task in which the duration is fixed. Any changes to the work or the 

assigned units [that is, resources] will not affect the task’s duration. This 

is calculated as follows: Duration x Units = Work. 

Frequency Chart  This chart plots the number of samples or probability versus the value of 

the variable. Frequency charts allow you to analyze the risk associated 

with a variable. All frequency charts in RiskyProject are interactive. By 

moving the slider, you can check the chance that the project will be 

completed within a given period, or what is the chance that the cost of 

the project will be within budget. Frequency charts can be combined with 

cumulative probability chart for the same variable. 

Free Slack Amount of time that a task can be delayed without delaying any 

successor tasks. If the task has no successors, free slack is the amount of 

time that a task can be delayed without delaying the entire project's finish 

date. 

Frontier Lines The Joint Confidence Level plot presents frontier lines or lines where 

Cost and Duration (Finish Time) combination meets certain predefined 

targets. You can define many frontier lines with different targets. 
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Gantt Bar  A graphical element of the Gantt chart that represents start, finish times, 

and duration of the task. 

Global Risk 

Assignment  
A stochastic event, which affects all tasks or resources in the project. 

Global risks are presented in the Risk Assignment View. You may also 

use Risk Register to assign global risks. 

Income Net processed from sales or net profit (without cost). RiskyProject 

analyzes cost and income separately, because they may have different 

risk and uncertainties. Specifically, RiskyProject has the risks Fixed 

Income Increase and Relative Income Increase. You can assign a special 

statistical distribution for Income. 

Income Actual Income that is accrued during the course of a task or project. 

RiskyProject calculates actual cost automatically based on tracking data. 

Alternatively, you can enter this income manually if you uncheck a flag 

in Options (cost tab). 

IRR (Internal Rate 

of Return) 

The rate of return that would make the present value of future cash flow 

(income) equal current market price of investment (cost). RiskyProject 

calculates IRR in Cash flow view. 

Issue  Event that has already occurred. Issues could be viewed in Risk Register. 

Risks can be converted to issues using the Risk Information dialog from 

Risk Register. When risks become an issue, the chance of risk occurrence 

would become 100% for all risk assignments. You have to manually set 

the chance of risk occurrence to 100% for all mutually exclusive 

alternatives.  

Joint Confidence 

Level Plot 

Scatter Plot also known as Cost vs. Duration or a Bull’s Eye plot shows a 

comparison of the Total Project Cost vs. Total Project Duration or Finish 

Time for each iteration of the simulation and is part of the Project 

Summary. Joint Confidence Level Plot may include frontier lines, which 

show Cost and Duration (Finish Time) combination that meet certain 

predefined targets. 

Kurtosis  Kurtosis is one of statistical parameters used by RiskyProject. Kurtosis is 

a measure of the flatness or peaked nature of a distribution relative to a 

normal distribution. RiskyProject presents kurtosis as part of results of 

Monte Carlo simulations for project and for the tasks. 

 

where  is mean,  is standard deviation and n is number of samples 

(number of Monte Carlo simulations). 

Lag  The delay between the finish of the predecessor and the start of the 

successor task. Lags can be probabilistic. They are defined by statistical 

distribution. 
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Late Start and Late 

Finish 

The latest date that a task can start (for late start) or finish (for late finish) 

without delaying the finish of the project. This date is based on the task's 

start or finish dates, as well as on the late start and late finish dates of 

predecessor and successor tasks, and other constraints. 

Latest Project 

Deadline  

See Project Deadline 

Legend  The Legend appears by default at the bottom of each view. It contains 

practical information for each view. By default, legends are turned off. 

They can be toggled on and off from the View menu or the Options 

dialog box (View tab). In addition, legends can be turned off by clicking 

the X in the title bar of legend. 

Lognormal 

Distribution  

A distribution where the logarithm of the variable follows the normal 

distribution. The lognormal distribution is often used to model data, 

which is positively skewed. 

Material Label Material resource property: name of material units (e.g., ton).  

Maximum Project 

Duration 

See Project Deadline 

Material Resources  The supplies or other consumable items used to complete tasks in a 

project. RiskyProject treats both work and material resources differently 

during calculation. 

Maximum Units Parameters associated with work resources. These are used in analysis of 

resource allocation: a resource will be over-allocated if the maximum 

units are exceeded. 

Maximum Value  The maximum result of a Monte Carlo simulation. It can be the 

maximum value of duration, cost, and start and finish times for all 

simulations. RiskyProject presents minimum and maximum values as 

part of results for Monte Carlo simulations for projects and tasks. 

Mean  Mean is one of the statistical parameters. Mean is calculated as the sum 

of variable values on each simulation divided by the number of 

simulations. 

Milestone  A reference point indicating a major event in the project. Milestones are 

used to monitor the project progress. Milestones in RiskyProject may or 

may not have zero duration. If the task has zero duration, it is 

automatically displayed as a milestone. 

Minimum Value  Minimum result of Monte Carlo simulations. It can be a minimum value 

of duration, cost, start, and finish times for all simulations. RiskyProject 

presents minimum and maximum values as part of the results of Monte 

Carlo simulations for the project and for tasks. 
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Monte Carlo  The mathematical method used on risk analysis. Monte Carlo simulations 

are used to approximate the distribution of potential results based on 

probabilistic inputs. Each simulation is generated by randomly pulling a 

sample value for each input variable from its defined probability 

distribution. These input sample values are then used to calculate the 

results (in RiskyProject, it is project schedule parameters: project 

duration, start and finish times, success date, and cost). This procedure is 

then repeated until the probability distributions are sufficiently well 

represented to achieve the desired level of accuracy. The probability 

distribution to be used for these inputs is dependent on the types of 

numbers you want to generate.  

NPV (Net Present 

Value)  

NPV is the present value of investment’s future cash flow minus initial 

investment. RiskyProject calculates NPV and presents it in Cash flow 

view. You may change discount rate for NPV calculation. 

Non-schedule Risk 

Outcomes 

Risk outcomes, which do not affect project schedule directly. Examples 

are safety related risk outcomes (reduce safety, accident, etc.), quality 

related outcomes (reduce quality), etc. See risk outcomes for more 

information 

Normal 

Distribution  

A distribution that describes situations where values are distributed 

symmetrically around the mean. 68% of all values under the curve lie 

within the standard deviation of mean and 95% lie within two standard 

deviations. 

Opened Risk or 

Issue 

Risk or issue that is currently active and may affect your project 

schedule. You may switch between opened and closed risks in the Risk 

Information dialog of Risk Register. 

Opportunity Risk event, which positively affects the project. In RiskyProject, 

opportunity is determined based on the results of risk outcomes. If a 

result is negative, (for example fixed delay is -2 days) it is an 

opportunity. Otherwise, it is a threat. 

Overallocation An over-allocated resource has more work assigned than can be done in 

the resource’s available time. Overallocation is the number of hours a 

resource is scheduled for all assigned tasks over the resource’s available 

time. Overallocation is shown within the Resource view. Use the 

shortcut menu (right-mouse click) to switch between the different types 

of charts available in the Resource view. 

P1/P99 (P5/P95, 

P10/P90) range  

The difference between P1 and P99 percentiles (P5 and P95, P10 and 

P90). RiskyProject presents such ranges as part of results for Monte 

Carlo simulations for project and for tasks. 

Peak Units  The highest level at which a resource is scheduled for all assigned tasks 

during a given period. Peak units are shown in the Resource view. Use 

the shortcut menu (right-mouse click) to switch between the different 

types of charts available in the Resource view. 
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Percent Allocation  The percentage of a resource’s capacity for all assigned tasks during a 

given period. Percent allocation is shown within resources view. Use the 

shortcut menu (right-mouse click) to switch between the different types 

of charts available in the Resource view. 

Percentile A measure used in statistics indicating the value below which a given 

percentage of observations in a group of observations fall. A value in the 

95th percentile is a value equal to or better than 95 percent of other 

values. RiskyProject presents percentiles as part of results of Monte 

Carlo simulations for project and for the tasks. Notation P95 indicate 95th 

percentile. 

Predecessor A task that must start of finish before another task starts of finishes. 

Project Calendar The base calendar used by the project. Project calendar is used for 

scheduling tasks if tasks or resource calendars are not defined. 

Project Deadline  Calculated using the earliest project deadline, the latest project deadline, 

and the maximum project duration. These parameters are entered in the 

Main Project Settings dialog box (see Project menu). The project is 

cancelled when the deadline is reached. The deadline can also affect the 

project success rate as any tasks that exceed the project deadline are 

canceled. 

Projected Duration  The task duration, which is recalculated, based on current schedule task 

duration and tracking data. 

Range  The difference between maximum and minimum values. RiskyProject 

presents range as part of results for Monte Carlo simulations for projects 

and tasks. 

Resource Calendar A calendar that specifies working and non-working time for a specific 

resource. A resource calendar differs from a project calendar, which 

specifies working and non-working time for more than one resource. 

Resource 

Information dialog 

box  

This dialog box contains General and Risks information about particular 

resources. The Resource Information can be viewed by double clicking 

on any not editable field associated with the resource in the resource 

view, for example on resource ID. The Resource Information dialog box 

can also be opened using shortcut menu in resource view. 

Resources  People, materials, and costs used to complete tasks. 

Profit Profit = Income – Cost. Profit is calculated only if income is defined for 

at least one task. 

Risk  A stochastic event that can be applied to tasks or resources and affects 

project schedules. Risks are defined by name. When risks are assigned to 

tasks or resources, you need to define their chance of occurrence, 

outcome, and time of occurrence.  
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Risk Assignment Risk can be assigned to all tasks or resources (global) or particular task 

or resource (local). When you perform risk assignment, you need to 

define chance of risk occurrence, risk outcome, result, and moment of 

risk. If risk is not assigned to any tasks and resources, it will remain in 

the Risk Register but will not be used for risk ranking and will not affect 

your project schedule. 

Risk Category Group of risk outcomes. RiskyProject calculates risk impacts and scores 

for each category. For example, one of the default risk categories is 

safety. It has a number of outcomes: reduce safety, injury accidents, etc. 

Risks within these outcomes will be ranked together.  

Risk Chart Chart, which represents task risk, expressed as standard deviation, range, 

P10. P90, etc. versus task cost or task duration. 

Risk Impact RiskyProject calculates risk impact for duration, cost, and combined for 

all parameters as a result of sensitivity analysis, normalizes it, and 

presents it within different views, including Risk Register, and Risk 

Matrix. Red for threat-type risk impact means there is a strong 

correlation between the risk and project duration/cost. Yellow means that 

there is a medium correlation between the risk and the project 

duration/cost. Green means there is a weak or no correlation between the 

risk and project duration/cost. Colors for opportunity type risk impacts 

are the opposite. If a risk has threats and opportunities, its color is not 

defined. 

Risk Matrix The view presenting risk probability versus risk impact within matrix. 

Risk matrix uses different colors (red, green, and yellow) to represent 

severity of the risk. In RiskyProject, risk matrix can be viewed separately 

for risks and opportunities.  

Risk Outcome 

Type 

A result if a risk occurs. In quantitative analysis risk outcome types can 

be schedule-related and non-schedule. Multiple risk outcome types can 

be combined in risk category. You can customize non-schedule risk 

outcome types, as well as enable/disable schedule risk outcome types 

using the Categories and Outcomes dialog. If a risk is assigned to a 

task, the outcome type can be Increase cost, Delay Restart End task, 

Cancel task Cancel task + all successors, Cancel Project, and others. If a 

risk is assigned to a resource, the outcome type can be Increase cost, 

Delay, Restart, End task, and others. If an outcome is set to No impact, 

the risk is ignored.  

Risk Probability Calculated chance that event would occur. Risk Probability is shown in 

Risk Matrix, Risk Register, and other views and dialog boxes, where 

risks information can be viewed. In this document, chance of risk 

occurrence usually refers to input chance for risk assignment. Risk 

probability refers to the calculated probabilities for this risk, which can 

be different. 
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Risk Properties Attributes, associated with the risks. Examples of these risk properties 

include when risk is created or modified, name of record, name of 

contact, and other information. Default sets of risk properties are defined 

in Default Risk Properties dialog. Actual values of these risk properties 

are entered in the Risk Information dialog of Risk Register. 

Risk Register The set of all risks. Includes input parameters: opened or closed, risk or 

issue, and properties. Also, includes calculated parameters: threat or 

opportunity, pre- and post-mitigation probability, impact, and score. 

Risks from Risk Register should be assigned to tasks or resources. 

RiskyProject is shown in Risk Register view.  

Risk Severity Range of risk probabilities and impacts defined by different colors and 

presented on Risk Matrix or Risk Trend chart. For example, risk with 

high probability and impacts placed on red area on risk matrix are called 

High severity risks. 

Risk Score Calculated risk impact multiplied by risk probability. Risk score can be 

viewed in Risk Register view and Risk Matrix view. You may sort all 

risks based on risk score in Risk Register. 

Seed (in Monte 

Carlo Simulations)  

Seed is a number, which is used as a starting point for Monte Carlo 

simulations. RiskyProject automatically generates and saves the seed for 

all uncertain parameters: duration, start and finish times, work, cost, etc. 

Schedule  The timing and sequence of tasks within a project. A schedule contains 

tasks with dependencies, as well as other project information. 

Schedule Related 

Risk Outcome 

types 

In quantitative risk analysis, Risk outcome types that directly affect 

project schedule. Examples are restart task, fixed delay, and fixed cost 

increase. Schedule related risk outcome types are hard coded, but you 

can enable or disable them. See Risk Outcome Types for more 

information 

Semi Standard 

Deviation 

Semi standard deviation is calculated the same way as standard 

deviation, except only samples below mean are used in the calculation. 

RiskyProject presents semi standard deviation as part of results of Monte 

Carlo simulations for project and for the tasks.  

Skewness Skewness is a measure of the degree of asymmetry of a distribution 

around its mean. If the distribution is skewed to the left, it will have a 

positive skewness. If it is skewed to the right, it will have a negative 

skewness. RiskyProject presents skewness as part of results of Monte 

Carlo simulations for project and for the tasks. 

 

where  is mean,  is standard deviation and n is number of samples 

(number of Monte Carlo simulations).  
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Spearman Rank 

Order correlation 

coefficient  

A nonparametric (distribution-free) rank statistic proposed by Spearman 

in 1904 as a measure of the strength of the associations between two 

variables. It is used in RiskyProject to estimate which task duration, risk, 

task start date, task cost, risk, etc. affects project duration, finish time, 

cost, and  success rate are the most critical. Complete results of 

calculation in form of chart are shown in Sensitivity View. See 

Lehmann, E.L. and D’Abrera, H.J.M. Nonparametrics: Statistical 

Methods Based on Ranks, rev. ed. Englewood Cliffs, NJ: Prentice-Hall, 

pp.292, 300, and 323, 1998.  

Standard deviation  The standard deviation is a measure of how widely dispersed the values 

are in a distribution. Equals the square root of the variance. RiskyProject 

presents standard deviation as part of results of Monte Carlo simulations 

for project and for the tasks. Standard deviation can also be shown for 

input distributions for cost, duration, and start time (see Task 

Information dialog box, Distributions Tab). 

 

where  is mean and n is number of samples. 

Start date  The date when task is scheduled to begin. The start date is calculated 

based on successors, predecessors, constraints, task durations using 

current calendar. 

Statistical 

Distribution  

An arrangement of values or variables showing their observed or 

theoretical frequency of occurrence. 

Subtask  A subtask is a task that is part of a summary task. The subtask 

information such as cost, and duration is consolidated into the summary 

task. Summary task and subtasks can be outlined using the Indent and 

Outdent buttons located on the Formatting toolbar, as well as the 

Indent and Outdent menu items. 

Success Rate The chance that a task or project will be completed. A task success rate 

of 56% means that there is a 56% chance that this task will be completed 

and 44% percent chance that it will be canceled. A task can be canceled 

when either it reaches a task or project deadline, or if a risk with a 

Cancel task, Cancel Task + all successors or Cancel Project outcome 

type occurs. A project can be canceled either when it reaches the project 

deadline or if a task, risk with a Cancel Project outcome occurs. The 

task success rate is shown on the Success Rate view, but it can be 

requested within any view. The Project success rate is shown in the 

Project Information view. 

Successor  A task that cannot start or finish until another task starts or finishes. 

Summary Task  A task that encompasses and summarizes the duration and costs of all 

tasks in a group. Summary task and subtasks can be outlined using the 

Indent and Outdent buttons located on the Formatting toolbar, as well 

as the Indent and Outdent menu items. 

http://www.amazon.com/exec/obidos/ASIN/013997735X/weisstein-20
http://www.amazon.com/exec/obidos/ASIN/013997735X/weisstein-20
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Task Deadline  A target date for the completion of a task. Task deadlines are defined in 

the Deadlines tab of Task Information dialog box. You can assign 

different actions for when a deadline occurs: the deadline can be ignored 

in the scheduling process and the task can be canceled with or without 

affecting the success rate. Deadlines are displayed as a red arrow in Gantt 

charts. Deadline arrows can be turned off and on in the Project Options 

(Calendar tab). 

Task Dependencies 
The type of link between different tasks. There are four types of task 

dependencies: 

3. Finish-To-Start: Task 2 (successor) cannot start until task 1 

(predecessor) finishes 

4. Start-To-Start: Task 2 (successor) cannot start until task 1 

(predecessor) starts 

5. Finish-To-Finish: Task 2 (successor) cannot finish until task 1 

(predecessor) finishes 

6. Start-To-Finish: Task 2 (successor) cannot finish until task 1 

(predecessor) starts 

Task dependencies can be defined in the Task Information dialog box 

(predecessor tab). They can also be defined using the toolbar buttons.  

Task Information 

dialog box  

Information regarding a specific task is organized using a series of tabs 

(General, Predecessors, Resources, Deadline, Risks, Distributions, 

Tracking, and others). The dialog box can be opened by double-clicking 

on any non-editable field associated with a task in the task view. A task 

ID is an example of a non-editable field. You can also open the Task 

Information dialog box using the shortcut menu in the task view or 

choosing Project> Task Information from the menu. 

Task An activity or job that has a start date and time, an end date and time, 

duration, and other properties. A Project is comprised of tasks.  

Task Calendar The base calendar that you can apply to individual tasks to control their 

scheduling, usually independent of the project calendar or any assigned 

resources’ calendars. By default, all tasks use the project calendar. 

Threat Risk events that negatively affect the project. In RiskyProject, a threat is 

determined based on the result of a risk outcome. If the result is positive 

(for example, fixed delay is 2 days) it is threat. Otherwise, it is an 

opportunity. 

Time scale The time period indicator that appears at the top of the various Gantt 

charts, the Resource charts, frequency and cumulative probability plots 

and tracking plot. Time scale always has two tiers. Information in 

timescales is automatically adjusted based on the resolution of the 

particular chart. 

javascript:AppendPopup(this,'pjdefTaskCalendar_4_4')
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Total Slack Amount of time that a task can be delayed without delaying any 

successor tasks. If the task has no successors, free slack is the amount of 

time that a task can be delayed without delaying the entire project's finish 

date. 

Variance  The variance is a measure of how widely dispersed the values are in a 

distribution, and thus is an indication of the risk of the distribution. It is 

calculated as the average of the squared deviations about the mean. The 

variance gives disproportionate weight to outlying values that are far 

from the mean. The variance is the square of the standard deviation. 

RiskyProject presents range as part of results for Monte Carlo 

simulations for project and for tasks. 

 

where  is mean,  is standard deviation and n is number of samples 

(number of Monte Carlo simulations).  

View A graphic user interface component, which may combine charts and 

worksheets. RiskyProject has 12 views. You can navigate between views 

using the ribbon or the Workflow bar. The order of the views in the 

workflow bar reflects the recommended project risk management 

workflow. 

Work For tasks, the total labor required to complete a task. For assignments, 

the amount of work to which a resource is assigned. For resources, the 

total amount of work to which a resource is assigned for all tasks. Work 

is different from task duration. 

Work in Resource 

Chart 

Total number of hours a resource is scheduled for all assigned tasks 

during a given period. Work is shown within Resource view. Use the 

shortcut menu (right-mouse click) to switch between the different types 

of charts available in the Resource view. 

Workflow bar Located on the left of the RiskyProject workspace, the Workflow bar 

allows you to quickly select and open Views. The order of the views in 

the workflow bar reflects the recommended project risk management 

workflow. The Workflow bar can be turned on and off from within the 

Options dialog box (view tab) or the View menu. In addition, the 

Workflow bar can be turned off by clicking the X in the title bar (top of 

workflow bar). 
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24 hours calendar, 86, 88 

3 

3-point estimates 

adding, 128 
adding cost and income, 127, 128 
adding for duration and cost, 127 
adding lags, 128 
managing uncertainties, 127 
most likely values, 127 

A 

actual 

cost, 84, 148, 200 
define statiscal distribution, 162 
income, 84 
start date, 200 
tracking, 160 

Addin 

adding estimates to Microsoft Project, 73, 75 
setting up, 72 

adding 

3-point estimates, 128 
constraints, 100 
deadlines, 101 
estimates to Microsoft Project, 73, 75 
fixed costs to tasks, 108 
fixed income to tasks, 108 
parallel risks, 120 
predecessors, 98 
resources, 105 
risk categories, 58 
risks, 24 

advanced task management, 103 
afternoon off calendar, 88 
AHP, 59 
analytical hierarchy proces, 59 
analyzing 

cash flow, 150 
costs and profit, 148 
risk chart, 154 

Assign Mitigation view, 46 
assigning 

calendars to resources, 106 
estimates to found tasks, 134 
global risks, 112 
local risks, 112 
mitigation plans, 44 
resources to tasks, 105 
Risk Assignment View, 118 
risk response plans, 44 
risks in risk register, 117 
risks in the task information dialog box, 119 

task to mitigation or response plan, 34 
uncertainity to costs and income, 109 

B 

baselines, 181 

calculations, 136 
managing, 182 
project schedule, 200 

BMP, 51, 130, 163, 173 
branching 

conditional, 185 
example, 186 
probabilistic, 185 

budgeted cost, 200 

C 

calculations 

cost, income, and profit, 107 
defaults, 83 
deterministic, 136 
probabilistic, 136 

calendars, 200 

assigning to resources, 106 
base, 86 
creating calendars, 88 
defining probabilistic, 89 
project calendars, 86 
renaming, 88, 89 
resource calendars, 87 
setting calendar defaults, 82 
setting up, 86 
standard calendar, 88 
task calendars, 87, 103 

cash flow 

results, 150 
viewing, 150 

chance, 27, 29 

risk occurrence, 200 
charts 

Cash Flow, 150 
Cost, 148 
Crucial Tasks, 155 
Frequency, 137, 138, 139, 140, 201, 202 
Resource, 147 
Result Gantt, 139 
Risk, 153, 154 
Risk Matrix, 49 
Risk Trend, 49, 66 
Sensitivity, 151 
showing or hiding risks, 122 
Tornado, 151, 153 
Tracking, 160 
Tracking Gantt, 164 

clipboard, 20, 51, 172 
columns, 18, 24, 43, 59, 61, 96, 98, 108, 113, 172, 196 
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comparing 

mitigation baselines, 182 
consolidation, 190 
constraints, 96, 201 

adding, 100 
affect on probabilistic and deterministic calculations, 

100 
convergence, 83, 132, 136, 201 
converting 

baselines, 182 
qualtitative to quantitative risk analysis, 113 

copying 

pictures, 173 
project data, 172 
rows, 20 

correlation coefficient, 151, 152, 153, 195, 201 
cost of risk, 41 
cost rate tables, 106 
costs, 81, 96, 114, 129 

analyzing, 148 
calculations, 107 
fixed, 108 
per use, 105, 108, 201 
setting up fixed cost defaults, 84 
setting up variable cost defaults, 84 
variable, 108 

creating 

base calendars.  
baselines, 181 
branches, 185 
calendars, 88 
milestones, 100 
mitigation and response plans, 33 
projects, 91 
risk templates, 125 
summary tasks, 97 
tasks, 96 

critical risks, 152, 168, 197 

criticality index, 83, 177, 201 
crucial tasks, 155, 156, 157, 168, 201 
cumulative probability, 140, 201, 210 
currency, 84 
Current baseline 

setting, 182 
current schedule, 136, 139, 150, 163, 164, 202 
customize 

risk outcome types, 27 
risk properties, 43 

cutting 

rows, 20 

D 

Dashboard 

project, 168 
risk, 54 

data sheets, 18, 23 
DCMA 14 point Schedule Assessment, 178 
deadline 

adding, 101 
task, 101 

defaults 

duration, 82 
editing default risk properties, 60 
selecting a default risk template, 125 
setting calendar defaults, 82 
setting project defaults, 81 
setting up calculation defaults, 83 
setting up risk defaults, 84 

defining 

distributions for duration, cost, income, and start time, 
128 

maximum simulations, 83, 136 
probabilistic calendars, 89 
task distributions, 38, 129, 142 
work, 106 
working time, 88 

deleting 

calendars, 89 
items, 20 
risks, 24 

dependencies 

linking tasks, 97 
distributions 

defining for duration, cost, income and start time, 128 
defining tasks distributions, 38, 129, 142 
fitting, 130 
types, 128 

Drag’N’Drop Risk view, 116 
due date, 43 
duration, 81, 96, 129, 152, 202 

fixed, 104 
setting defaults, 82 

E 

earliest project deadline, 93, 202 
effort driven scheduling, 103, 202 
empirical data, 130 
event chain methodology, 10, 202 
Excel 

export, 26 
integration, 174, 187 

exporting 

projects, 174 

F 

filtering 

risk register, 25 
finding 

text or data, 133 
fixed 

duration, 104 
units, 103 
work, 103 

fixed costs, 108 

adding to tasks, 108 
setting up defaults, 84 

fixed duration task, 104, 202 
fixed income, 108, 114, 203 
formatting 

Gantt Bars, 104 
Risk Matrix, 60 
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formula to calculate combined impact, 66, 67 
free slack, 83, 177, 202 
frequency chart, 138, 202 

G 

Gantt bars, 203 

formatting, 104 
GIF, 51, 130, 163, 173 
global options, 81 
Global risks, 112, 113, 116, 119, 125, 203 

I 

images 

copying and saving, 173 
importing 

existing schedules, 91 
keep assigned risks, 195 
xml, 91 

income, 203 

actual, 203 
calculations, 107 

indent, 33, 60, 97, 105, 209 
inserting 

items, 20 
integration 

Excel, 187 
interface, 12, 211 
IRR (Internal Rate of Return), 150, 203 
issues, 32, 35, 122, 194, 197, 200, 203 

J 

JPEG, 51, 130, 163, 173 

K 

kurtosis, 203 

L 

lags, 98, 203 

sensitivity, 151 
uncertainties, 128 

late finish, 83, 177, 204 
late start, 83, 177, 204 
latest project deadline, 93, 204 
legends, 81, 204 
linking 

tasks, 97 
loading 

risk register, 68 
risk templates, 125 

Local risks, 112, 119 
lognormal distribution, 82, 128, 204 

M 

mapping 

Excel fields, 187 
Microsoft Project fields, 72, 75 
XER file fields, 80 

material label, 105, 204 
material resources, 105, 204 
maximum 

number of iterations, 72, 83 
number of periods, 66 
number of rows, 20 
project duration, 94 
property value, 60 

mean, 128, 132, 136, 163, 204 
Microsoft Project, 70, 91, 92, 174, 195, 198 

using actuals, 160 
Milestones, 100, 204 

creating, 100 
mitigation, 23, 33, 115, 182, 183 

assigning mitigation plans, 44 
assigning task to plan, 34 
subplans, 33 
summary plans, 33 

moment of risk, 85, 115, 117 

reporting, 171 
Monte Carlo 

enabling simulations, 124, 136 
simulations, 136, 204, 205 

morning off calendar, 88 
most likely cost, 130 
most likely duration, 130 
multiple baselines, 181, 183 

viewing, 182 
mutually exclusive alternatives, 28 

N 

night shift calendar, 88, 89 
non-schedule 

risk outcomes, 205 
risks, 85, 196 

normal distribution, 82, 128, 205 
NPV (Net Present Value), 84, 150, 205 

O 

opportunities, 29, 49, 50, 205 
outcome, 29 
outcome types, 27, 29, 57 
overallocation, 147, 205 

P 

parallel risks, 120 
peak units, 147, 205 
percent allocation, 147, 206 
percentile, 140, 153, 206 
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